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	p 本製品に関するソフトウェア情報
1.	�本製品には、GNU General Public License（GPL）ならびにGNU Lesser General Public License
（LGPL）に基づきライセンスされるソフトウェアが含まれており、お客様は、これらのソフトウェアのソ
ースコードの入手・改変・再配布の権利があることをお知らせいたします。

	 ソースコードの入手については、下記のWebサイトをご覧ください。
	 https://connect.panasonic.com/jp-ja/products-services_proav
	 なお、お客様が入手されたソースコードの内容等についてのお問い合わせは、ご遠慮ください。
2.	�本製品には、MIT-Licenseに基づきライセンスされるソフトウェアが含まれています。
3.	�本製品には、FreeType Project (www.freetype.org)に基づきライセンスされるソフトウェアが含まれ
ています。

これらの内容については、下記のWebサイトを参照してください。
https://pro-av.panasonic.net/manual/jp/index.html
原文（英文）で記載しております。

商標および登録商標について

	p HDMI、High-Definition Multimedia Interface、およ
びHDMI ロゴは、米国およびその他の国におけるHDMI 
Licensing Administrator, Inc. の商標または、登録商標
です。
	p NDI®は 映像伝送・制御技術であり、Vizrt NDI AB の米
国およびその他の国における登録商標です。
	pその他、本文中の社名や商品名は、各社の登録商標または
商標です。

著作権について

本機に含まれるソフトウェアの譲渡、コピー、逆アセンブル、
逆コンパイル、リバースエンジニアリング、並びに輸出法令
に違反した輸出行為は禁じられています。

略称について

本書では、以下の略称を使用しています。
	pパーソナルコンピューターを「コンピューター」、「PC」と
記載しています。
	p NDI®を「NDI」と記載しています。
	p NDI® HX1、NDI® HX2、NDI® HX3を「NDI HX」と総
称して記載しています。
	p NDI® High Bandwidthを「NDI」と記載しています。

本書内のイラストや画面表示について

	pイラストや画面表示は、実際と異なる場合があります。
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人への危害、財産の損害を防止するため、必ずお守りいただくことを説明しています。

■	� 誤った使い方をしたときに生じる危害や損害の程度を区分して、説明しています。

警告 「死亡や重傷を負うおそれがある内容」です。

注意 「軽傷を負うことや、財産の損害が発生するおそれがある内容」です。

■	� お守りいただく内容を次の図記号で説明しています。

してはいけない内容です。

実行しなければならない内容です。

 警告

設置業者様向け
■	�電源を入れたまま設置や接続工事、配線をしない

（火災や感電の原因となります。）

 警告

■	�本機の設置や接続工事は販売店に依頼する
（設置や接続工事には技術と経験が必要です。火災、感電、けが、器物損壊の原因となります。）
⇒	�必ず販売店に依頼してください。

異常、故障時には直ちに使用を中止する

電源プラグ
を抜く

■	�異常があったときは、AC アダプターの電源プラグを抜く 
［内部に金属や水などの液体、異物が入ったとき、落下などで外装ケースが破損したとき、煙や異
臭、異音などが出たとき］
（そのまま使用すると、火災や感電の原因になります。）
⇒	�ACアダプターを電源コンセントの近くに設置し、電源プラグに簡単に手が届くようにしてください。
⇒	�本機を電源から完全に遮断するには、電源プラグを抜く必要があります。
⇒	�お買い上げの販売店にご相談ください。

■	�電源プラグは、根元まで確実に差し込む
（差し込みが不完全ですと、感電や発熱による火災の原因になります。）
⇒	�傷んだプラグやゆるんだコンセントのまま使用しないでください。

■	�電源プラグのほこりなどは、定期的にとる
（プラグにほこりなどがたまると、湿気などで絶縁不良となり、火災や感電の原因になります。）
⇒	�半年に一度はプラグを抜いて、乾いた布で拭いてください。

■	�付属品・オプションは、指定の製品を使用する
（本体に誤って指定外の製品を使用すると、火災や事故を起こす原因になります。）

安全上のご注意 必ずお守りください



7

 警告（つづき）

■	�電源コード・プラグが破損するようなことはしない 
［傷つける、加工する、高温部や熱機器具に近づける、無理に曲げる、ねじる、引っ張る、重いも
のを載せる、束ねるなど］
（傷んだまま使用すると、火災・感電・ショートの原因になります。）
⇒	�電源コードやプラグの修理は、お買い上げの販売店にご相談ください。

■	�コンセントや配線機器の定格を超える使い方や、交流 100 V － 240 V 以外での使用はしない
（たこ足配線等で、定格を超えると、発熱による火災の原因になります。）

	⇒付属の電源コードは最大定格：AC125 V です。日本国内では 100 V でご使用ください。

■	�内部に金属物を入れたり、水などの液体をかけたりぬらしたりしない
（ショートや発熱により、火災・感電・故障の原因になります。）
⇒	�機器の上や近くに液体の入った花びんなどの容器や金属物を置かないでください。

■	�不安定な場所に置かない
（落ちたり、倒れたりして、けがの原因になります。）

分解禁止

■	�分解や改造をしない
（内部には電圧の高い部分があり、感電や火災の原因になります。また、使用機器を損傷することがあります。）
⇒	�内部の点検や修理などは、お買い上げの販売店にご相談ください。

接触禁止

■	�雷が鳴り出したら、本機やAC アダプターなどの電源プラグには触れない
（感電の原因になります。）

水場使用
禁止

■	�水場で使用しない
（火災や感電の原因になります。）

ぬれ手 
禁止

■	�ぬれた手で電源プラグやコネクターに触れない
（感電の原因になります。）

■	�振動や強い衝撃を与えない
（火災や感電の原因となります。）

■	�開口部（冷却ファン通気口など）に手を入れない
（けがや感電の原因となります。）

■	�グランド端子ねじやケーブルクランプは乳幼児の手の届くところに置かない
（誤って飲み込むと、身体に悪影響を及ぼします。）
⇒	�万一、飲み込んだと思われるときは、すぐに医師にご相談ください。

安全上のご注意 必ずお守りください
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 注意

■	�本機の放熱を妨げない 
［�通風孔やファンは、ふさがない、横倒し、逆さまにしない］
（内部に熱がこもり、火災の原因になります。）

■	�油煙や湯気の当たるところ、湿気やほこりの多いところに置かない
（電気が油や水分、ほこりを伝わり、火災・感電の原因になることがあります。たばこの煙なども製品の故障
の原因になることがあります。）

■	�ろうそく等の炎を機器の近くに置かない
（火災の原因になります。）

■	�直射日光の当たる場所や異常に温度が高くなる場所に置かない
（特に真夏の車内、車のトランクの中は、想像以上に高温（約 60 ℃以上）になりますので、外装ケースや内
部部品が劣化するほか、火災の原因になります。）
⇒	�本機を絶対に放置しないでください。

■	�電源プラグやコネクターを抜くときは、コードを引っ張らない
（コードが傷つき、火災や感電の原因になります。）
⇒	�必ずプラグやコネクターを持って抜いてください。

■	�本機の上に重いものを置いたり、乗ったりしない
（落下したり倒れたりして壊れ、けがの原因になります。また、重さで外装ケースが変形し、内部部品が破損
すると、火災・故障の原因になります。）

電源プラグ 
を抜く

■	�長期間使用しないときや、点検・整備・修理の前には、AC アダプターの電源プラグをコンセン
トから抜く
（火災の原因になります。また、感電の危険があります。）

■	�コードを接続した状態で移動しない
（コードが傷つき、火災や感電の原因になります。また、コードが引っかかって、けがの原因になります。）

■	�1 年に 1 度程度は、販売店に内部の掃除の相談をする
（本機の内部にほこりがたまったまま使用すると、火災や故障の原因になります。）

■	�落としたり、破損させたりしない
（本機を落としたり、破損させたりしたまま使用すると、火災や感電の原因となります。）
⇒	�直ちに電源プラグを抜いて、販売店に連絡してください。

本製品（付属品を含む）に表示の記号は以下を示しています。

		 AC（交流）
		 DC（直流）

電源プラグの接地に関するご注意
◦	�本機に付属されているACコードは、接地端子を備えた3ピンのコンセントに接続してください。

海外で使用する場合は、その国に合った接地端子付ACコードを準備してください。

安全上のご注意 必ずお守りください
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	■概要

本機は、3G/HDマルチフォーマットに対応した1MEデジタルビデオスイッチャーです。
コンパクトサイズながら、SDI入力4系統、HDMI入力2系統、SDI出力2系統、HDMI出力1系統、IP入力4系統、IP
出力2系統、アナログオーディオ2ch入出力を装備しています。
3G-SDIに加え、NDI、SRT、RTMP/RTMPSといったIP入出力に対応したコンパクトライブスイッチャーAV-HSW10は、
ミドルレンジ中型スイッチャーに迫る基本機能を備え、HD映像制作が可能となります。
可搬性に優れた本体一体型ボディにより、音楽やスポーツ、エンターテインメントショーなど、数々のライブイベントに持
ち出して使用可能です。
また、3G/HDマルチフォーマット対応に加え、多種のIP入出力や、UVCにも対応し、カメラ*1台数の多いイベントでの
スムーズな運用だけでなく、リモート環境での多彩な映像表現、直接配信が可能となります。
多彩な番組演出を可能にするキーヤーは、PinP 2ch、クロマキー1chを含む2キーヤーを装備しています。
さらに、アップ/ダウンコンバート機能、HDMIスケーラー機能を搭載し、異なるフォーマットが混在するシーンでも目的
に合わせた柔軟な映像出力を選択できます。
放送局はもちろん特設会場や中継車での持ち出し用途に、また大学や企業の講演イベントなどに、さまざまな用途での使い
やすさを追求したコンパクトライブスイッチャーが、その現場の生きた映像制作に高いパフォーマンスを発揮します。

*1	��当社製4K/HDインテグレーテッドカメラおよびメモリーカード・カメラレコーダーAG-CX350。
	 NDI、NDI HX対応の4K/HDインテグレーテッドカメラは、下記のパナソニックWEBサイトをご確認ください。
	 https://connect.panasonic.com/jp-ja/products-services_proav

	■定格表示について

本機の名称、品番、電気定格は、側面に表示されています。

	■免責について

当社はいかなる場合も以下に関して一切の責任を負わないものとします。
①	 �本機に関連して直接または間接に発生した、偶発的、特殊、または結果的損害・被害
②	 �お客様の誤使用や不注意による障害または本機の破損など
③	 �お客様による本機の分解、修理または改造が行われた場合
④	 �本機の故障・不具合を含む何らかの理由または原因により、映像が表示できないことによる不便・損害・被害
⑤	 �第三者の機器などと組み合わせたシステムによる不具合、あるいはその結果被る不便・損害・被害
⑥	 �取付方法の不備など、本商品の不良によるもの以外の事故に対する不便・損害・被害
⑦	 �登録した情報内容が何らかの原因により、消失してしまうこと
⑧	 �本体やUSBメモリーまたはコンピューターに保存された画像データ、設定データの消失あるいは漏えいなどによる
いかなる損害、クレームなど

はじめに
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	■ネットワークに関するお願い

本機はネットワークへ接続して使用する機能もあります。
ネットワークへ接続して使用するときには、以下のような被害を受けることが考えられます。
①	本機を経由した情報の漏えいや流出
②	悪意を持った第三者による本機の不正操作
③	悪意を持った第三者による本機の妨害や停止

このような被害を防ぐため、お客様の責任の下、下記のような対策も含め、ネットワークセキュリティ対策を十分に行って
ください。
	pファイアウォールなどを使用し、安全性の確保されたネットワーク上で本機を使用する。
	pコンピューターが接続されているシステムで本機を使用する場合、コンピューターウイルスや不正プログラムの感染に対
するチェックや駆除が定期的に行われていることを確認する。

また、以下の点にもご注意ください。
	p本機と接続する機器は、同一セグメントでの運用を推奨します。
セグメントが異なる機器との接続を行う場合は、ネットワーク機器固有の設定などに依存した事象が発生する可能性があ
りますので、運用開始前に本機と接続対象機器との接続確認を十分に行ってください。
	p本機やケーブルなどが容易に破壊されるような場所には設置しないでください。
	pご使用のネットワークの環境によってはNDI 通信が不安定になる場合があります。
NDI の通信量概算から使用予定のNDI のトラフィックを確認し、回線速度に対して十分余裕のある状態にしてください。
単一のNDI ソースに対して複数の参照を行う場合、送信側のNDI 通信量は参照数に比例して増大します。
システム設計上必要な場合は、マルチキャストの使用を検討してください。

はじめに
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●�取り扱いはていねいに
落としたり、強い衝撃や振動を与えないでください。また、
フェーダーレバーを持って持ち運びや移動はしないでく
ださい。故障や事故の原因になります。

●�使用温度範囲は、0 ℃～ 40 ℃でお使いください。
0 ℃を下回る寒いところや、40 ℃を超える暑いところ
では内部の部品に悪影響を与えるおそれがあります。

●�ケーブルの抜き差しは電源を切って
ケーブルの抜き差しは、必ず機器の電源を切ってから行
ってください。

●�湿気、ほこりの少ないところで
湿気、ほこりの多いところは、内部の部品が傷みやすく
なりますので避けてください。

●�お手入れは
電源を切って乾いた布で拭いてください。汚れが取れに
くいときは、うすめた台所用洗剤（中性）を布にしみ込
ませ、よく絞り、軽く拭いたあと、水拭きしてから、乾
いた布で拭いてください。

・	�ベンジンやシンナーなど揮発性のものは使用しない
でください。
・	�化学ぞうきんを使用するときは、その注意事項をよ
くお読みください。

お願い

●�制作時のご注意
本機の映像切り替え機能や映像効果機能を用いると、細
かく点滅する映像や急激に変化する映像を制作すること
が可能です。
このような映像は、視聴者の身体へ影響を与える可能性
がありますので、制作時には、特にご留意ください。

●�廃棄のときは
本機のご使用を終え、廃棄されるときは環境保全のため、
専門の業者に廃棄を依頼してください。

●�消耗品について
冷却ファン：
冷却ファンは消耗品です。
約5年（1日に15時間使用時）を目安に交換してくだ
さい。

ACアダプター：
ACアダプターは消耗品です。
約5年（1日に15時間使用時）を目安に交換してくだ
さい。

消耗品の交換時期は、使用条件により異なります。
消耗品を交換する場合は、必ず、販売店に依頼してくだ
さい。

使用上のお願い
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	●「安全上のご注意」に記載されている内容とともに、以下の事項をお守りください。

本機を設置するときや接続工事を行うときは、必ず、販売店に依頼してください。

電源の接続について
	p AC100 V ～ 120 Vで使用してください。
	p付属のACコードとACアダプターを必ず使用してくださ
い。
	p背面のグランド端子（SIGNAL GND）は、システムのグ
ランドに接続してください。
	p ACアダプターは、確実に奥まで差し込んでください。
	p長時間使用しないときは、節電のため電源スイッチを切
り、電源プラグをコンセントから抜いてください。

取り扱いはていねいに
	p落としたり、強い衝撃や振動を与えると、故障や事故の
原因になります。

内部に異物を入れないでください。
	p水や金属、飲食物などの異物が内部に入ると、火災や感
電の原因になります。

設置場所について
	p本機は、屋内専用の機器です。
	p十分な強度があり、安定した水平な場所に置いて使用し
てください。
	p本機の通気孔周辺は、通風の妨げにならないように
100 mm以上の空間を確保してください。
	 �特にパネルやテーブルに埋め込んで使用する場合は、通
気と配線の空間を十分に確保してください。
	p本機、ケーブルなどが容易に破壊されるような場所には
設置しないでください。
	p 0 ℃以下の寒いところや、40 ℃以上の暑いところに設
置しないでください。
	p直射日光の当たるところや温風の吹き出し口付近への設
置は避けてください。
	p湿気やほこり、振動の多い場所に設置すると、故障の原
因となります。

吸気口

排気口吸気口

設置上のご注意
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コンパクト設計、豊富な入出力
	pコンパクトながら、SDI 入力 4系統、HDMI 入力 2系統、
SDI 出力 2系統、HDMI 出力 1系統を装備しています。	
さらに、IP入出力、リファレンス入力、スルー出力、
2chのアナログオーディオ入出力、UVC出力を備え、多
様なライブスイッチングに幅広く対応することができま
す。
	pカット、ミックス、ワイプによるバックグラウンドトラ
ンジションに加え、キーヤーはクロマキー1ch、PinP 
2ch を含む2キーヤーを装備しています。
	pマルチビューディスプレイ機能により、最大16系統の
映像を1台のモニターに分割して表示できます。
	p入出力は3G/HD-SDI に対応し、すべての入力にフレー
ムシンクロナイザー (FS) を内蔵しています。
	p NDI、NDI HX、RTMP/RTMPSと、多くの IP入出力
に対応しています。
	p 2ch のアナログオーディオ入力端子を備え、任意の出力
バスにエンベデッド可能です。	
また、入力レベル、オーディオのディレイも調整可能です。

マルチフォーマット対応
	p下記の信号フォーマットに対応しています。

2Kフォーマット：
1080× 59.94p、1080× 50p、1080× 29.97p、
1080× 25p、1080× 24p、1080× 23.98p、
1080× 59.94i、1080× 50i

HDフォーマット：
720× 59.94p、720× 50p

	p 2K/HDマルチフォーマットに対応しています。
	p 3G-SDI/1.5G-SDI/HDMI/IP の多彩なインターフェー
スに対応しています。
	p入力数は最大でSDI 4 系統、HDMI 2 系統、IP 4 系統
です。
	p出力数は最大でSDI 2 系統、HDMI 1 系統、IP 2 系統
です。
	p 2つのキーヤーを装備し、豊富な映像効果を実現します。
	pアップ /ダウンコンバート機能を搭載しています。
	p AUX BUSを 2系統装備。MIXトランジション機能を装
備しています。
	p最大9台の当社製4K/HDインテグレーテッドカメラの
タリー制御するリモートカメラコントローラー機能を搭
載しています。
	pクロマキーが可能です。
	pビデオメモリー（静止画2系統）をキー信号付きで記録
や読み出しが可能です。
	pショットメモリー機能を搭載しています。
	p USBメモリーに対応しています。

特長
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付属品
付属品をご確認ください。
	p電源コードキャップ（付属している場合）および包装材料は、商品を取り出したあと、適切に処理してください。
	p本機にはACアダプターが抜けてしまうことを防ぐためのケーブルクランプが付属しています。

ACアダプター.................................................................  1

ケーブルクランプ............................................................  1

ACコード........................................................................  1

ケーブルクランプの取り付けかた

DC IN 16V

ケーブルクランプの取り外しかた

1	①をつまんで②方向に引っ張る

DC IN 16V







ACアダプターの固定方法

1	ケーブルクランプのロックを解除する

DC IN 16V

2	ACアダプターを挿入する

DC IN 16V

3	ケーブルクランプでACアダプターのケーブルを.
ロックする

DC IN 16V
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制御パネル部

POWER

AMB:F
GRN:S

PGM

PST

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4

1 7 2 8 3 9 4 10 5 11 6 12

USER 2 5 USER 3 SHOT MEM EXIT

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

MENU6

PGM PVW

SHIFT

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

3

1

2

4 5C6 7 ? 8 9

:

;

<

=

A

B

D

E

@ >

1	POWERランプ [POWER]
DC IN 端子 (U) に電源が供給されているときに、背面の
[POWER] スイッチ (F) を ONにすると点灯します。

2	ALARMランプ [ALARM]
冷却ファン (T) が停止しているとき、または電源に異常
（電圧低下）があるときや本機の内部が高温になったとき
に点灯します。
このとき、外部モニターにOSDメニューを表示してい
る場合 (OSD ON状態 ) は、OSDメニューにアラーム
メッセージが表示されます。
アラーム情報は、本機のTALLY/GPI 端子 (N) から外部
機器に出力することもできます。
 「アラームメッセージ」参照
アラームが発生した場合は、すぐに使用を中止し、必ず
販売店へご連絡ください。
そのまま使用すると、本機が故障する原因となることが
あります。

3	STREAMボタン [STREAM]
本機からSRT、RTMP/RTMPSによる直接配信の開始、
停止、スタンバイを行います。各配信状態での LEDの
点灯色が変わります。（OFF：消灯 (*1)、スタンバイ：緑
点灯、配信中：赤点灯）
本機は、配信系統を2系統 (CH1、CH2) 備えており、
CH2に対する操作は [SHIFT] ボタン (6) を押しながら
操作します。

ボタン操作

配信系統：LED
押下 長押し

OFF：消灯(*1) 配信中：赤点灯 スタンバイ：緑点灯
スタンバイ：緑点灯 配信中：赤点灯 OFF：消灯(*1)
配信中：赤点灯 スタンバイ：緑点灯 OFF：消灯(*1)

*1  �[12] Config > Button Illumination > Color 
Group Other > STREAMで設定したColor 
Group の色で点灯します。

4	USERボタン [USER 1、USER 2、USER 3]
メニュー項目の中から任意に選択した6つの機能を、
[USER 1] ボタン、[USER 2] ボタン、[USER 3] ボタ
ンにアサインして使用することができます。
[USER 1] ボタンには [USER 1] と [USER 4] に、
[USER 2] ボタンには [USER 2] と [USER 5] に、
[USER 3] ボタンには [USER 3] と [USER 6] に登録
した機能がアサインされます。
[SHIFT] ボタン (6) を押している間は、[USER 4]、
[USER 5]、[USER 6] に登録した機能が選択できます。

点灯 [USER]ボタンにアサインした機能が有効
消灯 [USER]ボタンにアサインした機能が無効

5	ショットメモリーボタン [SHOT MEM]
ショットメモリーの登録、呼び出し、削除をすることが
できます。
 「ショットメモリー」参照

各部の名前とはたらき
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6	SHIFT ボタン [SHIFT]
[USER 1] ボタン、[USER 2] ボタン、[USER 3]
ボタンにアサインされた [USER 4]、[USER 5]、
[USER 6] の機能を呼び出すときや、クロスポイントボ
タン [1] ～ [6] にアサインされたXPT7～ XPT12の素
材を呼び出すとき、あるいはShot Memory 操作時に押
します。

点灯 [SHIFT]ボタンが有効
消灯 [SHIFT]ボタンが無効

（[SHIFT] ボタンは、押している間のみ有効です）

7	OSD/TIMEダイヤル
OSD/TIMEダイヤルで以下の操作を行います。

	pメインメニューが表示されているとき
OSD/TIMEダイヤルを回してサブメニューを選択し、
ダイヤルを押して決定します。
	pサブメニューが表示されているとき
OSD/TIMEダイヤルを回してサブメニューを選択し、
ダイヤルを押して決定します。
設定値を入力する場合は、ダイヤルを押してからダイ
ヤルを回すと設定値が変化し、再びダイヤルを押すと
設定値が決定します。
設定値を初期値に戻すには、ダイヤルを長押しします。
	p [KEY1 ON]、[KEY2 ON]、[FTB ON]、[AUTO] の
いずれかのボタンを長押ししたあと、押した状態のま
までダイヤルを回すとそれぞれのトランジションタイ
ムを変更することができます。

8	EXIT ボタン [EXIT]
OSDメニュー操作時に、一つ上のサブメニュー階層に
戻ることができます。

9	MENUボタン [MENU]
OSDメニューの表示と非表示を切り替えます。
[MENU] ボタンを長押しするごとに、表示と非表示が切
り替わります。

橙点灯 OSDメニュ ー表示
消灯 OSDメニュー非表示

OSDメニューが表示されている状態で [MENU] ボタン
を押すと、メインメニューとステータス表示が切り替わ
ります。
ステータス表示画面では、以下の情報を確認できます。
	pワイプパターンの設定
	pトランジションタイムの設定
	p [USER] ボタンの設定
	pクロスポイントアサインの設定

:	FTB ONボタン [FTB ON]
設定されたトランジションタイムで、プログラム映像が
黒画面へフェードアウトします。
再度押すと、黒画面からプログラム映像へフェードイン
します。

押す
点滅

フェードアウト実行中

フェードイン実行中
点灯

消灯
プログラム	
映像

点灯
フェード	
アウト完了

押す

フェードアウトする画面は、黒画面以外の映像を設定す
ることもできます。
 「FTB（Fade to Black）」参照
ボタンを長押ししたあと、押した状態のままでOSD/
TIME ダイヤル（7）を回すと、トランジションタイム
を変更することができます。

;	KEY 1 ON、KEY 2 ONボタン
	 [KEY 1 ON、KEY 2 ON]
設定されたトランジションタイムで、キー素材の合成を
行います。

押す
点滅

合成中

合成解除中
点灯

消灯
合成無し

点灯
合成完了

押す

ボタンを長押ししたあと、押した状態のままでOSD/
TIMEダイヤル（7）を回すと、トランジションタイム
を変更することができます。

<	CUTボタン [BKGD CUT]
現在選択されている操作のトランジションを瞬時に行い
ます。

点灯 トランジション実行中
消灯 トランジション終了

=	AUTOボタン [BKGD AUTO]
設定されたトランジションタイムで、トランジションを
自動で行います（オートトランジション）。

点灯 オートトランジション実行中
消灯 オートトランジション終了

オートトランジションを行っているときに [AUTO] ボタ
ンを押すと、オートトランジションの動作を中断します。
中断中に再度押すと、残りのトランジションを行います。
フェーダーレバー（>）が途中の状態で [AUTO] ボタン
を押すと、途中からの残り時間でトランジションを行い
ます。
ボタンを長押ししたあと、押した状態のままでOSD/
TIME ダイヤル（7）を回すと、トランジションタイム
を変更することができます。

各部の名前とはたらき
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>	フェーダーレバー
手動（マニュアル）でトランジションを行うときに使用
します。
フェーダーレバーを末端まで動かすと、トランジション
が完了します。
オートトランジションを行っているときにフェーダーレ
バーを動かすと、フェーダーレバーの位置が実行中のト
ランジション量を追い越した時点でマニュアル動作に切
り替わります。
トランジションを行う素材は、バックグラウンド、キー
のいずれかをメニューで選択できます。

?	MIX/WIPE切り替えボタン [MIX、WIPE]
トランジションの方法を選択します。
このボタンを押すたびにMIXとWIPEが切り替わりま
す。
MIX AバスとBバスの映像（もしくは、PGMバスとPST

バスの映像）をオーバーラップさせながら、トランジ
ションを行います（MIXトランジション）。
トランジションを行っているときは、AバスとBバス
（もしくは、PGMバスとPSTバス）の出力の合計が
100 %に保たれます。
MIX選択状態のときは、左の[MIX]ランプが橙点灯し
ます。

WIPE 選択されているワイプパターンにより、トランジショ
ンを行います。
WIPE選択状態のときは、左の[WIPE]ランプが橙点
灯します。

@	バスタリーランプ [A、B]
プログラム（PGM）出力されているバス側のランプが点
灯します。

A	AUXバス選択ボタン [AUX BUS DELEGATION]
AUXバスクロスポイントボタン (B) で操作するバスを
選択します。
選択されているボタンが点灯します。

[KEY 1]、[KEY 2]：
AUXバスクロスポイントボタン (B) をキーフィルバス、
またはキーソースバスのソース選択ボタンに切り替えま
す。
ボタンを押すごとにキーフィルバスとキーソースバスが
切り替わります。

橙点灯 キーフィルバス
緑点灯 キーソースバス

[AUX 1]、[AUX 2]：
AUXバスクロスポイントボタン (B) を AUXバスの	
ソース選択ボタンに切り替えます。

B	AUXバスクロスポイントボタン
AUXバス選択ボタン (A) で切り替えたバスのソースを
選択します。
[SHIFT] ボタン (6) を使って、1～12までを選択する
ことができます。クロスポイントボタン (B、D、E) を
長押ししたときは、入力素材の名称やクロスポイントボ
タンの番号がOSD に表示されます。

C	AUXバス専用クロスポイントボタン
	 [AUX SOURCE]
AUXバス選択ボタン (A) の [AUX 1]、[AUX 2] ボタ
ンが点灯している間は、AUXバスのソースを選択します。
押されたボタンは、アンバー色に点灯します。

[MV]：
AUXバスにマルチビューディスプレイ信号を選択しま
す。

[PGM/PVW]：
AUXバスにPGM信号もしくはPVW信号を選択します。
PGM信号 /PVW信号は、[SHIFT] ボタン (6) で切り
替えられます。

D	PGMバスクロスポイントボタン [1～ 6]
PGM/Aバスの映像信号を選択します。[SHIFT] ボタン
(6) を使って、1～12までを選択することができます。
Bus Mode は Config メニューで“A/B”、“PGM-A/
PST-B”、“PGM-B/PST-A”を選択できます。
 「バックグラウンドトランジション」参照
クロスポイントボタン (B、D、E) を長押ししたときは、
入力素材の名称やクロスポイントボタンの番号がOSD
に表示されます。

E	PSTバスクロスポイントボタン [1～ 6]
PST/Bバスの映像信号を選択します。[SHIFT] ボタン
(6) を使って、1～12までを選択することができます。
Bus Mode は Config メニューで“A/B”、“PGM-A/
PST-B”、“PGM-B/PST-A”を選択できます。
 「バックグラウンドトランジション」参照
クロスポイントボタン (B、D、E) を長押ししたときは、
入力素材の名称やクロスポイントボタンの番号がOSD
に表示されます。

各部の名前とはたらき
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F	POWERスイッチ [POWER]
[POWER] スイッチをONにすると [POWER] ランプ
(1) が点灯し、本機を操作することができます。

G	SDI IN 端子 [SDI IN 1 ～ 4]
HD SDI 信号の入力端子です。
	p SDI IN 1 と HDMI IN 1 は排他です。Input メニュー
からどちらかを選択します。
	p SDI IN 3、4にはアップコンバーター /ダウンコン	
バーターの詳細な設定ができます。

H	SDI OUT端子 [SDI OUT 1、2]
HD SDI 信号の出力端子です。メニュー操作により以下
の信号をアサインすることができます。

PGM、PVW、CLN、AUX1、AUX2、MV、
Key Out

SDI OUT 1 端子には、OSDメニューは表示されません。

I	HDMI IN 端子 [HDMI IN 1、2]
HDMI 信号の入力端子です。HDMI 1.4b に対応してい
ます。本機はHDCP非対応です。
メニュー操作により以下の解像度の信号を入力できます。

解像度（垂直周波数：60Hz)：
WSXGA+ (1600×1050)、
SXGA (1280×1024)、WXGA (1280×768)、
XGA(1024×768)
解像度：
1920×1080/59.94p、1920×1080/50p、
1920×1080/29.97p、
1920×1080/25p、1920×1080/24p、
1920×1080/23.98p、1920×1080/59.94i、
1920×1080/50i、1280×720/59.94p、
1280×720/50p

	p HDMI IN 端子は、スケーラー機能に対応しています。

J	HDMI OUT端子 [HDMI OUT]
HDMI 信号の出力端子です。メニュー操作により以下の
信号をアサインすることができます。

PGM、PVW、CLN、AUX1、AUX2、MV、
Key Out

本機のシステムフォーマットと同一の解像度で出力する
ことが可能です。

メニュー操作により以下の解像度の信号を出力できます。
出力解像度を1080/720に固定することも可能です。

解像度（垂直周波数：60Hz)：
WSXGA+ (1600×1050)、
SXGA (1280×1024)、WXGA (1280×768)、
XGA(1024×768)
解像度：
1920×1080/59.94p、1920×1080/50p、
1920×1080/29.97p、
1920×1080/25p、1920×1080/24p、
1920×1080/23.98p、1920×1080/59.94i、
1920×1080/50i、1280×720/59.94p、
1280×720/50p

K	リファレンス入力端子 [REF]
外部同期モード時は、ループスルー出力をします。
ループ出力を使用しない場合は、75Ωで終端してくだ
さい。

L	音声入力端子 [AUDIO IN]
外部音声 (マイク、ライン )の入力用端子です。
L/Rの 2チャンネルに対応しています。

各部の名前とはたらき

背面部

SIGNAL GND
L/1 R/2 ON2 1 4 3 2 1

AUDIO IN

BOOT

NM SV
STREAM

OUT

LAN TALLY/GPI USB

2 1

HDMI OUT HDMI IN

REF SDI OUT SDI IN POWER

Q F

R P O N M J

L K H G

I
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S	USB端子 (*3) (Type-A コネクター ) [USB]
本機とUSBメモリーを接続し、プロジェクトファイル
のロード、セーブができます。
また、Still データのロード、セーブ、ログファイルの	
セーブ、ファームウェアのロードが可能です。

*3  USB2.0 DEVICE、USBバスパワー機能あり

T	冷却ファン
冷却ファンの通風孔をふさぐと故障の原因となります。
通風孔周囲には、十分な空間を確保してください。

M	USB端子 (*1) (Type-C コネクター )
	 [USB STREAM OUT]
本機とコンピューターをUSB Video Class で接続する
ことにより、本機の映像 /音声出力を取り込むことがで
きます。
メニュー操作により以下の信号をアサインすることがで
きます。

PGM、PVW、CLN、AUX1、AUX2、MV、
Key Out

*1  �USB 3.2 Gen1 DEVICE、USBバスパワー機能な
し

N	TALLY/GPI 端子 [TALLY/GPI]
	 (D-sub 15ピン、メス、インチねじ )
外部機器から本機の制御を行う接点入力ポートを5個、
本機からタリー情報やアラーム情報を出力するオープン
コレクター出力ポートを8個装備しています。

O	LAN端子 [LAN] (RJ-45) (1000Base-T)
外部機器から本機を IP制御する際に接続する LAN端子
(RJ-45) です。
また、IP信号の送受信もこの端子で行います。
接続には、LANケーブル (*2) を使用してください。

*2  �カテゴリー5e以上、STP (Shielded Twisted 
Pair)、最大100 m

P	SERVICEスイッチ [BOOT SV/NM]
メンテナンス用のスイッチです。通常は、[NM] の位置
で使用してください。

Q	グランド端子 [SIGNAL GND]
システムのグランドに接続してください。

R	セキュリティスロット
ケンジントン製のセキュリティ用ケーブルを接続するこ
とができます。
接続については、ケーブルに付属の説明書をご覧くださ
い。
セキュリティスロットおよびセキュリティケーブルは盗
難を予防するもので、万一発生した盗難事故による被害
については責任を負いかねます。

右側面部

USB

S T

各部の名前とはたらき
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左側面部

DC IN 16V

V U

U	DC IN 端子 [DC IN 16 V ]
	 (DC 16 V、3.0 A)
付属のACアダプターを接続します。

V	ケーブルクランプ取付孔
付属のケーブルクランプを取り付け、ACアダプターの
ケーブルを固定します。（14ページ）

W	ヘッドホン端子 [ ]
	 ( Φ 3.5 mm、ステレオミニジャック )
本機とヘッドホンを接続し、音声出力をモニターするこ
とができます。
本機の設定メニューによって、PGM、PVW、AUX1、
AUX2、CLNから選択できます。

X	モニター音量調整つまみ [LEVEL]
ヘッドホンのモニター音量が調整できます。

前面部

LEVEL

W X

各部の名前とはたらき
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電源の入れかたと切りかた

電源の入れかた

1	 [POWER]スイッチをONにする
本機に電源が供給されると、[POWER]ランプが緑色に
点灯します。

本機の起動中は、PGMバスクロスポイントボタン、
PSTバスクロスポイントボタンが順に青色で点灯して
いきます。ボタンがすべて消灯したら本機の起動が完
了します。

電源の切りかた

1	 [POWER]スイッチをOFFにする
本機の電源が切れて、[POWER]ランプが消灯します。

映像出力の確認
ここでは、本機のOSDメニューを外部モニターに表示し、本機の映像出力を確認するための操作を説明します。

HDMIモニターに表示する

1	本機のHDMI OUT端子にHDMIモニターを接続す
る

2	HDMIモニターの電源を入れる

3	本機の電源を入れる

4	 [MENU]ボタンを長押しする
[MENU]ボタンが点灯し、HDMIモニターにOSDメ	
ニューが表示されます。
OSDメニューが表示されない場合は、「OSDメニュー
の強制表示方法」を参照してください。

本操作を行っても、HDMIモニターにOSDメニューが表
示されないときは、HDMIモニターが本機のHDMI出力
フォーマットに対応していない可能性があります。
HDMIモニターの入力仕様を確認してください。

NOTE

SDIモニターに表示する

1	本機のSDI OUT 2端子にSDIモニターを接続する

2	 SDIモニターの電源を入れる

3	本機の電源を入れる

4	 [MENU]ボタンを長押しする
[MENU]ボタンが点灯し、SDIモニターにOSDメ	
ニューが表示されます。
OSDメニューが表示されない場合は、「OSDメニュー
の強制表示方法」を参照してください。

	p SDI OUT 1 端子からOSDメニューは出力されませ
ん。
	p本操作を行っても、SDI モニターにOSDメニューが
表示されないときは、本機に設定されたビデオフォー
マットが正しくない可能性があります。	
次に記載している操作で、本機のビデオフォーマット
を変更してください。	
 「ビデオフォーマットの変更」参照

NOTE

準備
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ビデオフォーマットの変更

電源が入っていない状態から、ビデオフォーマットを指定してシステムを起動することができます。
本機にSDI モニターを接続しても、OSDメニューが表示できない場合は、ビデオフォーマットの変更が必要です。
以下の手順でビデオフォーマットの変更を行ってください。
HDMI モニターでOSDメニューを表示できるときは、「システムフォーマットの設定」で、ビデオフォーマットを変更し
てください。

1	本機の電源を切る

2	 SDIモニターが対応しているビデオフォーマットに応じたボタンを押した状態で電源を入れる

同時に押すボタン ビデオフォーマット
[MENU] + A バスクロスポイント [1] 1080/59.94p
[MENU] + A バスクロスポイント [2] 1080/50p
[MENU] + A バスクロスポイント [3] 1080/59.94i
[MENU] + A バスクロスポイント [4] 1080/50i
[MENU] + A バスクロスポイント [5] 1080/29.97p
[MENU] + A バスクロスポイント [6] 1080/25p
[MENU] + B バスクロスポイント [1] 1080/24p
[MENU] + B バスクロスポイント [2] 1080/23.98p
[MENU] + B バスクロスポイント [3] 720/59.94p
[MENU] + B バスクロスポイント [4] 720/50p

	p 本機の起動完了までボタンは押し続けてください。

3	 [MENU]ボタンを長押しする
[MENU]ボタンが点灯し、SDIモニターにOSDメニューが表示されます。

本操作を行っても、SDIモニターにOSDメニューが表示されないときは、SDIモニターが本機のSDI出力フォーマットに
対応していない可能性があります。
SDIモニターの入力仕様を確認してください。

NOTE

準備
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OSD（オンスクリーンディスプレイ）メニューの操作
本機の設定は、外部モニターに表示されたOSD メニューで行います。
ここでは、OSD メニューの操作のしかたを説明します。

OSDメニューの表示／消去

基本操作

[MENU] ボタンを長押しすると、[MENU] ボタンが点灯し、外部モニターにOSDメニューが表示されます。
また、OSDメニューが表示されている状態で、[MENU] ボタンを長押しすると、[MENU] ボタンが消灯してOSDメニュー	
の表示が消えます。

OSDメニューを出力する端子の変更

[12] Config の Operate > Menu Out 項目の設定で、OSDメニューの出力端子が変更できます。

SDI OUT2 SDI OUT 2 端子から出力
HDMI OUT HDMI OUT端子から出力
SDI2+HDMI SDI OUT 2 端子とHDMI OUT端子の両方から出力

また、[11] Output の OUT6 (UVC OUT) > Menu Out 項目の設定で、USB端子（USB STREAM OUT、Type-C コ
ネクター )からのOSDメニュー出力設定が変更できます。

On USB端子 (Type-C コネクター )からOSDメニューを出力します。
Off USB端子 (Type-C コネクター )からOSDメニューを出力しません。

SDI OUT 1端子からは、OSDメニューが出力されません。
NOTE

OSDメニューの強制表示方法

本機の動作時に [MENU] ボタンと [SHIFT] ボタンを同時に押すと、以下が自動的に設定されます。
	p OSDメニュー出力先がSDI OUT 2 端子とHDMI OUT端子に設定されます。また、USB端子 (Type-C コネクター )
の出力も有効になります。
	p HDMI OUT端子から出力される画面サイズが “Auto” に設定されます。

準備
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メニュー構成と移動

本機のメニュー構成

本機のOSDメニューは、「メインメニュー」と複数階層の「サブメニュー」から構成されています。

メインメニュー：
サブメニュー項目を表示します。

サブメニュー：
さらに下層のサブメニュー項目を表示します。
設定項目、および設定値を表示します。
この画面で設定値の変更を行います。

メインメニュー、サブメニュー間の移動

メインメニューからサブメニュー /下位階層サブメニューへの移動

サブメニュー項目の選択：
OSD/TIMEダイヤルを回して選択します。

サブメニュー項目の決定：
OSD/TIMEダイヤルを押して決定します。

サブメニューから上位階層サブメニュー /メインメニューへの移動
[EXIT] ボタンを押すと上位階層サブメニュー /メインメニューに戻ります。

	fOSD/TIMEダイヤルを回してサブメニュー
項目を選択する
	fOSD/TIMEダイヤルを押して決定する

	f [EXIT] ボタンを押す

メインメニュー

サブメニュー

サブメニューがある項目は右端に「>」が
表示されます。

さらにサブメニューがある項目は右端に「>」が
表示されます。

設定値
設定値が変更できる項目は、右端に「▼」が表
示されます。

サブメニュー項目

複数ページに渡るメニューの表示

設定項目が多い場合、複数ページに渡ってメニュー項目が表示されます。
本書では、複数ページに渡るメニュー画面についても、1つの画面に記載しています。

準備
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サブメニューでの操作

1	設定行を選択する
OSD/TIMEダイヤルを回すと、ハイライトされたカーソルが上下に移動します。
変更したい設定項目の行にカーソルを合わせたあと、OSD/TIMEダイヤルを押すと設定値が変更できる状態になりま
す。
また、さらに下層にサブメニューがある場合は、項目右端に「>」が表示されています。
OSD/TIMEダイヤルを押すと、さらに下層のサブメニューが表示されます。

OSD/TIMEダイヤルを回して項目
を選択する

OSD/TIMEダイヤルを
押して決定する

設定値が変更できる状態になる

2	設定値を変更する
設定値の変更の方法は以下の２種類です。

	pプルダウン
変更したい設定項目の行でOSD/TIMEダイヤルを押すと、設定できる値がプルダウンで表示されます。
OSD/TIMEダイヤルを回して設定値にカーソルを合わせたあと、OSD/TIMEダイヤルを押すことで値が反映されま
す。

	p数値の変更
変更したい設定項目の行でOSD/TIMEダイヤルを押すと、設定状態に遷移します。
OSD/TIMEダイヤルを回すと設定が変更されます。
ダイヤルを素早く回すと、値の変化が早くなります。

OSD/TIMEダイヤルを回して
点滅している設定値を変更する

[ 設定値を初期値に戻す ]
ここでOSD/TIMEダイヤルを長押しすると、値が初期値に戻ります。

通常の設定項目は、変更した値がそのまま反映されますが、一部の設定項目（Formatなど）では、変更したあとにOSD/
TIMEダイヤルを押さないと設定値が反映されない項目があります。
これらの項目は、カーソルが点滅します。

NOTE

準備
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準備

文字列を入力する

本機には、文字列を入力する設定項目があります。

変更したい設定項目の行でOSD/TIMEダイヤルを押すと、文字列入力状態に遷移します。
キーボードのような文字列選択画面になっており、黄枠が選択されていることを示しています。
OSD/TIMEダイヤルを回して文字を選択し、OSD/TIMEダイヤルを押すと文字が決定できます。
文字種類は、以下を選択することで変更できます。

[A-a] 大文字と小文字の切り替え
[BS] 一文字削除
[123#+=] 数字、記号への切り替え
[!?~] 記号への切り替え
[   ] スペース
[ ] カーソル左移動
[ ] カーソル右移動
[Enter] 文字列を確定して設定行に戻る
[Load TEXT] USBメモリーから文字列を読み込むための画面を開く

[Load TEXT] について

[Load TEXT] を選択すると、本機でフォーマットしたUSBメモリーの "HS\HSW10\TEXT" に保存したテキストファイ
ル (.txt) を読み込み、内容を文字列に設定することができます。
USBメモリーを接続していない場合は、[Load TEXT] は選択できません。

USBメモリーを接続すると、[Load TEXT] が選択可能になります。
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[Load TEXT] を選択後に表示されるダイアログから、読み込みたいテキストファイルを選択します。

テキストファイルには以下の制約があります。
	p日本語などマルチバイト文字を含むテキストは読み込みエラーとなります。
	p入力可能な文字列長までしか読み込みません。
	p改行文字は自動的に削除します。

取扱説明書での表記

本機の取扱説明書では、設定項目を下記のように記載します。
例：[1] WIPE > BKGD Transition > Direction 項目の操作をするとき

[1] WIPE >	
	 BKGD Transition > Direction	

サブメニュー
設定項目

準備
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メニューデリゲーション機能

下記のボタンを２回押すと、特定されたメニューに切り替わります。
（メニューデリゲーション機能）
このとき、各ボタンを押したときの動作も実行されます。

＜メニューデリゲーション機能一覧＞
ボタン 切り替わるメニュー

AUTO

[5] Time
FTB
KEY 1 ON
KEY 2 ON
MIX/WIPE [1] WIPE
KEY 1 F/S • PinP が「On」のとき

[3] Key > PinP
• PinP が「Off」かつキーのタイプ (Key Type) で「Chroma」を選択しているとき
[4] ChromaKey
• PinP が「Off」かつキーのタイプ (Key Type) で「Chroma」以外を選択しているとき
[3] Key

KEY 2 F/S • PinP が「On」のとき
[3] Key > PinP
• PinP が「Off」のとき
[3] Key

USER 1

[12] Config > User Button

USER 2
USER 3
USER 4 (SHIFT + USER 1)
USER 5 (SHIFT + USER 2)
USER 6 (SHIFT + USER 3)

バスステータス表示

OSD メニューが表示されている状態からもう一度 [MENU] ボタンを押すと、ステータス画面が表示されます。
また、A バス、B バス、またはAUX バスのクロスポイントボタンを長押しすると、OSD メニューにステータス画面を表
示します。

AMB:F
GRN:S

PGM

PST

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

1 7 2 8 3 9 4 10 5 11 6 12

PGM PVW

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

準備
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基本操作

バックグラウンドトランジション

バスの選択

クロスポイントボタンを押して、バックグラウンドトラン
ジションを行う素材を選択します。
押したボタンは、動作状態により2種類の色で点灯します。

赤色点灯 選択された入力がPGMに出力されている場合
（ただし、FTB動作中はアンバー色に点灯しま
す。）

緑色点灯 選択された入力がPGMに出力されていない場
合

PGM

PST

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

1 7 2 8 3 9 4 10 5 11 6 12

PGM PVW

	 	  赤色で点灯
	 	  緑色で点灯

	pクロスポイントボタンを長押しすると、押している間は、
ボタンの番号とクロスポイントボタンに割り当てられて
いる入力素材の名称が一覧でOSDメニューに表示されま
す。

SHIFT機能によるバスの選択

SHIFT 機能とは、1つのボタンに表素材と裏素材の2つの
素材を割り当て、[SHIFT] ボタンで切り替えて使う機能で
す。
PGM/Aバスクロスポイントボタン、PST/Bバスクロスポ
イントボタン、AUXバスクロスポイントボタンの各6個
のボタンに、表素材 (1 ～ 6) と裏素材 (7 ～ 12) の 12の
素材をアサインすることができます。

PGM/Aバスクロスポイントボタン、PST/Bバスクロスポ
イントボタン、AUXバスクロスポイントボタンの素材を、
一括で表素材と裏素材を切り替えます。

[SHIFT] ボタンを押している間だけが裏素材になります。

	p裏素材 (7～ 12) を選択しているときは、[SHIFT] LED 
がアンバー色に点灯します。

バスモードの選択

設定メニューから、A/Bバス方式、フリップフロップ方式
（PGM/PST方式）を選択します。

以下のメニュー操作でバスモードを選択します。

[12] Config >
	 Operate > Bus Mode

A/B フェーダーレバーがA側のときは、Aバスで選
択された信号がPGMバスの素材になります。
フェーダーレバーがB側のときは、Bバスで選
択された信号がPGMバスの素材になります。

PGM-A/
PST-B

フリップフロップ方式で、Aバスで選択された
信号が常にPGMバスの素材になり、Bバスで
選択された信号が常にPSTバスの素材になり
ます。

PGM-B/
PST-A

フリップフロップ方式で、Bバスで選択された
信号が常にPGMバスの素材になり、Aバスで
選択された信号が常にPSTバスの素材になり
ます。

トランジションモードの選択

トランジョンモードをミックス（MIX）とワイプ（WIPE）
から選択します。

[MIX/WIPE] 切り替えボタンでバックグラウンドトランジ
ションモードを切り替えます。
選択されているモードの LEDが点灯します。
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マニュアルトランジション

フェーダーレバーを操作してマニュアルでトランジション
を実行します。
オートトランジション実行中にフェーダーレバーを動かし
た場合、フェーダーの位置が実行中のトランジション量を
追い越した時点でマニュアル動作に切り替わります。
フェーダーレバー左のバスタリー LEDは、プログラムバス
の出力状態を表示します。

Aの LEDのみ点灯 PGM/Aバスを出力
Aと Bの LED点灯 トランジション中
Bの LEDのみ点灯 PST/Bバスを出力

以下のメニュー操作でトランジション対象を選択します。

[12] Config >
	 Operate > Fader

フェーダーレバーを操作してトランジションを行う対象を、
次の中から設定することができます。

BKGD バックグラウンドトランジション
KEY1 キートランジション
BKGD+KEY1 バックグラウンドトランジションとキートラ

ンジションを同時に行う
No Assign フェーダーレバーを操作してもトランジショ

ンを行わない

オートトランジション

	p [AUTO] ボタンを押すと、設定されたトランジションタ
イムでトランジションを自動実行します。
	pフェーダーレバーの操作途中で [AUTO] ボタンを押すと、
残り時間でトランジションを実行します。

オートトランジションタイムの設定は、以下のメニューを
操作します。

[5] Time >
	 BKGD

表示単位は以下のメニューを操作します。

[12] Config >
	 Operate > Time Unit

Sec 秒単位で表示します。
Frame フレーム単位で表示します。

設定できる時間は0～ 999f です。システムフォーマット
により、秒表示のときの設定可能時間が異なります。

59.94i 最大33s09f 29.97p 最大33s09f
50i 最大39s24f 25p 最大39s24f
59.94p 最大16s39f 24p 最大41s15f
50p 最大19s49f 23.98p 最大41s15f

	pフェーダーレバーの機能設定が“KEY1”、
“BKGD+KEY1”、“No Assign”に設定されていても、	
オートトランジションを行う対象は常にバックグラウ
ンドになります。

カットトランジション

[CUT] ボタンを押すと、瞬時にトランジションを実行しま
す。

	pフェーダーレバーの機能設定が“KEY1”、
“BKGD+KEY1”、“No Assign”に設定されていても、
カットトランジションを行う対象は常にバックグラウン
ドになります。

基本操作
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ワイプ

ワイプパターンの選択

以下のメニュー操作でワイプパターンを選択します。

[1] WIPE >
	 BKGD Pattern

＜ワイプパターン一覧＞
ワイプパターンと番号

1 2 3 4 5

6 7 8 9 10

11 12 13 14 15

16

ワイプ方向の選択

以下のメニュー操作でバックグラウンドトランジションの
ワイプの方向を選択します。

[1] WIPE >
	 BKGD Transition > Direction

（キートランジションは、メニューで設定します。ここで設
定した方向は反映されません。）
 「キートランジション」参照

A

N

B

B

A

B

A

B

A

B

R

A

A B

A

N/R

B

A B

[Normal] 選択時：
	 ノーマル方向にワイプを行います。
[Reverse] 選択時：
	 リバース方向にワイプを行います。
[N/R] 選択時：
	 �トランジション完了時にノーマル方向とリバース方向を
入れ替えます。

ワイプの装飾（ボーダー、ソフト）

バックグラウンドトランジションのワイプに、ボーダー効
果やソフト効果を付加します。

ボーダー、ソフトを設定する

1	以下のメニュー操作でボーダーのOn/Off を選択します。

[1] WIPE >
	 BKGD Transition > Border > Border

2	以下のメニュー操作でボーダーの幅を設定します。

[1] WIPE >
	 BKGD Transition > Border > Width

3	以下のメニュー操作でソフト効果の量を設定します。

[1] WIPE >
	 BKGD Transition > Border > Soft

Border 項目を“On”にすると、ソフト効果の量は、ボー
ダーの幅に対するソフト効果の割合を示します。
ソフト効果のみをワイプに付加する場合は、Border 項目を
“Off”にしてください。

ボーダーの色を設定する

以下のメニュー操作でボーダーカラーのHue、Sat、Lum
を調整します。

[1] WIPE >
	 BKGD Transition > Border Color> Hue

[1] WIPE >
	 BKGD Transition > Border Color > Sat

[1] WIPE >
	 BKGD Transition > Border Color > Lum

基本操作
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■ プリセットカラーを呼び出す場合
以下のメニュー操作でプリセットカラーを選択し、OSD/
TIMEダイヤルを押します。

[1] WIPE >
	 BKGD Transition > Border Color > Load

	p OSD/TIMEダイヤルを押すと、それまで設定していた値
が取り消されてプリセットカラーの値に変更されます。
	pプリセットカラーを呼び出す前に設定していた値を保存
する場合は、「ショットメモリー」を参照してください。

ワイプの開始位置設定

ワイプの開始位置を任意に設定することができます。

対象パターン：
9、10、11、12、13

1	以下のメニュー操作でワイプの開始位置を設定します。

[1] WIPE > 
	 BKGD Transition > Position > X-Position

[1] WIPE > 
	 BKGD Transition > Position > Y-Position

[1] WIPE > 
	 Key1 Transition > Position > X-Position

[1] WIPE > 
	 Key1 Transition > Position > Y-Position

バックグラウンド、またはキーパターンで対象パターン
を選択している場合にのみ、設定が可能です。

2	フェーダーレバーを操作するか、[AUTO] ボタンを押し
て、ワイプの動作を確認します。
（例えば、X-Position：－ 50、Y-Position：－ 50を
設定した場合は、次の画面（またはキー）が左下から現
れて、画面中心に移動しながらワイプを行います。）

<X-Position、Y-Position の設定範囲>

 画面範囲内
 画面範囲外

X-Position

Y-Position

基本操作
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Key（キー）
バックグラウンド映像に別の映像を合成します。
また、キーの抜け具合の調整や、合成した映像にエッジを
付加することができます。

バックグラウンド映像に合成する素材として、Key1、
Key2があります。
プライオリティ（映像の配置）の初期設定は、下図のよう
になります。

<プライオリティの初期設定>

Key1

Key2

バックグラウンド映像

Key1、Key2内のプライオリティは、変更することができ
ます。
 「プライオリティの設定」参照

また、キー合成のしくみは下図のようになります。

<キー合成のしくみ>

HSW10

HSW10

バックグラウンド

キーソース

キーフィル

出力画像
Invert

キータイプの選択
1	以下のメニュー操作で対象のキー (Key1/Key2) を選択
します。

[3] Key >
	 Key Select

2	以下のメニュー操作でキータイプを選択します。

[3] Key >
	 Key Type

Lum(ChromaOff)
（ルミナンスキー・
クロマオフ /
セルフキー）

キーフィル信号の輝度成分からキー信号を
作成します。

Lum(ChromaOn)
（ルミナンスキー・
クロマオン /
セルフキー）

キーフィル信号の輝度成分とクロマ成分か
らキー信号を作成します。

Linear
（リニアキー /
EXTキー）

キーソース信号の輝度成分からキー信号を
作成します。
キーソース信号とキーフィル信号が異なる
場合に使用します。

Chroma
（クロマキー /.
セルフキー）

キーフィル信号の特定の色相を基準にして
キー信号を作成します。

Full
（フルキー /.
セルフキー）

全画面の映像をキーソース信号としてキー
信号を作成します。

ルミナンスキーとクロマキーは、セルフキーとして運用
されるためキーフィル信号をキーソース信号として使用
します。フルキーは、全画面の映像をキーソース信号と
して使用します。
キーのタイプとしてルミナンスキーやクロマキー、フル
キーを選択しているときは、キーソース信号を切り替え
てもキー信号は変化しません。

リニアキーを使用する場合、キーソース信号は、背景が
黒色でキー合成したい文字や形が白色の素材を使用して
ください。白黒以外の色の素材は、きれいに合成されな
い場合があります。
また、背景が白色で黒の文字などの素材は、キーインバー	
ト機能で反転させて使用することができます。

基本操作
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3	ルミナンスキーを選択した場合、セルフキー用途を考慮
して、キー信号の生成にクロマ成分を含めることができ
ます。（リニアキーには適用されません。）
キータイプに Lum(Chroma On) または Lum(Chroma 
Off) を選択します。

Chroma On 輝度成分に加えて、クロマ成分も考慮してキー
信号を生成します。
キー信号に、輝度成分の低い色を用いた場合（例
えば、青色の文字を抜きたい場合など）に設定
します。

Chroma Off 輝度成分のみからキー信号を生成します。

4	以下のメニュー操作でフィルのタイプを選択します。

[3] Key >
	 Fill

Bus キーフィル信号にバスの信号を使用します。
Matte キーフィル信号に内蔵のフィルマットを使用し

ます。

キー素材の選択

キーフィル、キーソース信号を選択する

AUXバス選択部の [KEY] ボタンを押して、キーフィル信
号（アンバー色に点灯）とキーソース信号（緑色に点灯）
の選択を切り替えます。

<キーフィル信号の選択>
[KEY] ボタンがアンバー色に点灯している状態で、AUXバ
スクロスポイントボタン1～6を押してキーフィル信号を
選択します。
選択されたAUXバスクロスポイントボタンはアンバー色
に点灯します。（選択された信号がPGM端子から出力され
ている場合は、赤色に点灯します。）

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

	 	  アンバー色で点灯

<キーソース信号の選択>
[KEY] ボタンが緑色に点灯している状態で、AUXバスクロ
スポイントボタン1～6を押してキーソース信号を選択し
ます。
選択されたAUXバスクロスポイントボタンは緑色に点灯
します。（選択された信号がPGM端子から出力されている
場合は、赤色に点灯します。）
ルミナンスキーとクロマキーは、セルフキーとして運用さ
れるためキーフィル信号をキーソース信号として使用しま
す。キーのタイプとしてルミナンスキーやクロマキーを選
択しているときは、キーソース信号を切り替えてもキー信
号は変化しません。

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

	 	  緑色で点灯

基本操作
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キーフィル信号とキーソース信号の選択を連動させる

1	以下のメニュー操作で対象のキー (Key1/Key2) を選択
します。

[3] Key >
	 Key Select

2	以下のメニュー操作でKey Signal Coupling を設定し
ます。

[3] Key >
	 Key Signal Coupling

3	以下のメニュー操作で Fill/Source を設定します。

[12] Config >
	 Key Source Signal Coupling > Fill/Source

	p Fill/Source が Fill to Source の場合、選択した Fill 
に対してSource を何にするかを選択できます。
	pまた、 Source to Fill の場合は、選択した Source に
対して Fill を何にするかを選択できます。

<Key Signal Coupling>
[KEY] ボタンがアンバー色に点灯しているときにキーフィ
ル信号が選択でき、緑色に点灯しているときにキーソース
信号が選択できます。

Key Signal Coupling

Independent Fill to Source の場合、Fill に連動する
Source を他のKEYとは別に単独で設定でき
ます。
Source to Fill の場合、Source に連動する
Fill を他のKEYとは別に単独で設定できます。

Coupling Key Source Signal Coupling 内の Fill/
Source 以外の項目の設定に従います。

<Fill To Source>
キーフィル信号を選択したときにキーソース信号も自動的
に切り替わります。

<Source To Fill>
キーソース信号を選択したときにキーフィル信号が自動的
に切り替わります。

フィルマットの色を設定する

以下のメニュー操作でフィルマットのHue、Sat、Lumを
調整します。

[3] Key >
	 Fill Matte > Hue

[3] Key >
	 Fill Matte > Sat

[3] Key >
	 Fill Matte > Lum

■ プリセットカラーを呼び出す場合
以下のメニュー操作でプリセットカラーを選択し、OSD/
TIMEダイヤルを押します。

[3] Key >
	 Fill Matte > Load

	p OSD/TIMEダイヤルを押すと、それまで設定していた値
が取り消されてプリセットカラーの値に変更されます。
	pプリセットカラーを呼び出す前に設定していた値を保存
する場合は、「ショットメモリー」を参照してください。

基本操作
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キートランジション
1	以下のメニュー操作でトランジションモードを選択しま
す。

[12] Config >
	 Operate > Fader

フェーダーレバーを操作してトランジションを行う対象
を、次の中から設定することができます。

BKGD バックグラウンドトランジション

KEY1 キートランジション
BKGD+KEY1 バックグラウンドトランジションとキートラ

ンジションを同時に行う
No Assign フェーダーレバーを操作してもトランジショ

ンを行わない

2	以下のメニュー操作でトランジションタイプ (MIX/
WIPE) を選択します。

[3] WIPE > 
	 Key1 Transition > Type

WIPE を選択した場合は、以下のメニュー操作でワイプ
パターンを選択します。

[1] WIPE >
	 Key1 Pattern

＜ワイプパターン一覧＞
ワイプパターンと番号

1 2 3 4 5

6 7 8 9 10

11 12 13 14 15

16

3	以下のメニュー操作でトランジションの時間を設定しま
す。

[5] Time >
	 Key1

[5] Time >
	 Key2

バックグラウンドトランジションと同様に、トランジシ
ョンタイムを設定します。

4	以下のメニュー操作でワイプ方向を設定します。

[3] WIPE >
	 Key1 Transition > Keyout Pattern

Normal
（ノーマル）

キーアウトのパターンをキーインのパターンと
同じ方向にします。

Reverse
（リバース）

キーアウトのパターンをキーインのパターンと
逆方向（対角方向）にします。

<パターン例>

パターン例1
パターン例2
ワイプパターン
9～16

キーイン

キーアウト
（ノーマル）

キーアウト
（リバース）

：キー合成されている領域を示します。

	pワイプパターン9～16は、パターン例2の動作を行い
ます。

5	トランジションを実行します。
フェーダーレバーを操作して手動でトランジションを実
行します。

キーオートトランジション

トランジション部の [KEY ON] ボタンを押すと、設定され
たトランジションタイムでトランジションを自動で実行し
ます。
キーイン中は、[KEY ON] ボタンが赤色に点滅し、トラン
ジションが完了すると赤色に点灯します。
完全にキーインした状態で [KEY ON] ボタンを押すと、
KEY映像がトランジション（キーアウト）します。
キーアウト中は、[KEY ON] ボタンが赤色に点灯し、トラ
ンジションが終了すると消灯します。
トランジションの途中で [KEY ON] ボタンを押すと、トラ
ンジションの方向が反転します。

基本操作
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キープレビュー

プレビュー出力にキーのプレビュー映像を出力して、キー
の調整および確認をすることができます。

以下のメニュー操作でプレビューを設定します。

[3] Key >
	 PVW

メニューの連動

PVWの映像
PVWがOFFの場合：
PGMの状態をPVWに表示します。
ただし、トランジション状態は反映されません。

PVWがONの場合：
PVWを“On”に設定すると、PVWに次のPGMの映
像を表示します。

PVWの背景
PVWのBKGD映像は、設定にかかわらずPST映像です。

On/Off を割り当てたユーザーボタンを押すと、On（ボタ
ン点灯）とOff（ボタン消灯）が交互に切り替わります。
（該当するユーザーボタンの項目は、KEY1_PVW/KEY2_
PVWです。）

メニュー ユーザーボタン ユーザーボタンを押す
On 点灯 Off：消灯
Off 消灯 On：点灯

ルミナンスキー／リニアキーの調整

ルミナンスキーとリニアキーの抜け具合を調整します。

1	以下のメニュー操作でキーの抜け具合を調整します。

[3] Key >
	 Key Adjust > Clip

[3] Key >
	 Key Adjust > Gain

[3] Key >
	 Key Adjust > Density

2	以下のメニュー操作でキーインバートの設定をします。

[3] Key >
	 Key Adjust > Invert

Onの場合は、内部で生成するキー信号を反転させます。

パラメーター 設定内容 設定範囲
Clip キー信号作成の基準レベル 0.0 ～ 108.0
Gain キーの増幅度 0.0 ～ 200.0
Density キーの濃さ 0.0 ～ 100.0
Invert キー信号の反転 On、Off
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クロマキーの調整

クロマキーの抜け具合を調整することができます。

あらかじめ、下記のメニューでキーのタイプに“Chroma”
を選択してから調整を行ってください。

[3] Key >
	 Key Type

クロマキーは、特定の色相を基準にしてキー信号を作成し
ます。
例えば、特定の背景色の前に立っている人物の映像から、
背景色を検出してキー信号を作成し、別の背景を合成しま
す。

本機では、長方形の枠で指定するエリア方式を採用してお
り、エリア内の画素のカラーを平均化したものをクロマキー	
の基準色（キーリファレンス）とし、平均値からの最大偏
差値をクロマキー楕円の半径（ラジウス）とします。

クロマ空間のサンプル標本（図中の部分）に対して忠実
なクロマキーの生成が可能です。



Y

Hue
Sat Radius

Chroma

Hue Radius

楕円型クロマキー

オートサンプルの実行

バックグラウンドを挿入したい領域を指定し、クロマ成分
をサンプリングします。

■ Marker

[4] ChromaKey >
	 Marker

サンプルマーカーをONにし、PVW映像にマーカーを表示
します。

■ Marker Pos

[4] ChromaKey >
	 Marker Position

サンプルマーカーのX座標、Y座標、サイズを調整します。

■ Sample

[4] ChromaKey >
	 Sample

OSD/TIMEダイヤルを押して、サンプルマーカーで選択さ
れているエリアの色相成分をサンプリングします。

	pサンプリングが終了すると、PVW映像にクロマキーを合
成した映像を出力します。（キーのPVW機能をONにし
てください。）
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その他のクロマキーの設定

■ Marker Aspect

[4] ChromaKey >
	 Marker Aspect

サンプルマーカーのアスペクト比を変更します。

■ Ref Adjust

[4] ChromaKey >
	 Ref Adjust

サンプルした色からクロマキーの基準にする色を変更する
ことができます。

Hue（Hue） 基準にする色相
Sat（Saturation） �基準にする色の濃さ
Lum（Luminance） �基準にする明るさ

	pオートサンプルを行ったあとは、サンプリングされた
値が表示されます。

■ Y-Influence

[4] ChromaKey >
	 Y-Influence

Y成分（Luminance）の影響度を設定します。
値が大きいほど影響度が大きくなり、0でY成分が影響し
なくなります。

■ Radius

[4] ChromaKey >
	 Radius

抜く色の範囲を設定します。

Hue（Hue-Radius） 抜く色相の範囲の大きさ
Sat（Saturation-Radius）抜く彩度の範囲の大きさ

	pオートサンプルを行ったあとは、サンプリングされた
値が表示されます。

■ Soft

[4] ChromaKey >
	 Soft

抜く色の境界のソフト効果の量を調整します。

■ Cancel

[4] ChromaKey >
	 Cancel

色消し量を調整します。
フィル映像に背景色がかぶっている場合に調整します。

クロマキー調整のコツ
下記の手順で行うと、クロマキー調整を容易に行うこと
ができます。

1	�オートサンプルを行って抜く色を決める。
2	�「Radius」項目で、背景色が完全に抜けるように調
整する。

3	�「Soft」項目でキー信号の境界を微調整する。

NOTE
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キーの装飾

キーに、ボーダーやシャドウなどのエッジを付加します。

キーのエッジを設定する

1	以下のメニュー操作でエッジのタイプを選択します。

[3] Key >
	 Edge > Type

Off エッジを付加しません。
Border 全縁にボーダーを付加します。
Drop 斜め方向のボーダーを付加します。
Shadow シャドウを付加します。
Outline アウトライン（フィルなしのボーダーのみ）を

付加します。

Border Drop

OutlineShadow

2	以下のメニュー操作でエッジの幅を選択します。

[3] Key >
	 Edge > Width

3	以下のメニュー操作で “Drop”、“Shadow”を付加する
方向 (45°単位 )を選択します。

[3] Key >
	 Edge > Direction

（上）

（下）

（右）（左）

225180 270

135 315

4590 0

4	以下のメニュー操作でエッジの濃さ (Density) を選択し
ます。

[3] Key >
	 Edge > Density

エッジフィルを設定する

エッジとして挿入する素材を設定します。

以下のメニュー操作でエッジの素材を選択します。

[3] Key >
	 Edge > Fill

Color Edge Color で設定した色を使用します。
CBGD1

カラーバックグラウンドを使用します。
CBGD2
Still1 静止画ビデオメモリー（Still1）を使用します。
Still2 静止画ビデオメモリー（Still2）を使用します。

エッジの色を設定する

以下のメニュー操作でエッジカラーのHue、Sat、Lumを
調整します。

[3] Key >
	 Edge > Color > Hue

[3] Key >
	 Edge > Color > Sat

[3] Key >
	 Edge > Color > Lum

■ プリセットカラーを呼び出す場合
以下のメニュー操作でプリセットカラーを選択し、OSD/
TIMEダイヤルを押します。

[3] Key >
	 Edge > Color > Load

	p OSD/TIMEダイヤルを押すと、それまで設定していた値
が取り消されてプリセットカラーの値に変更されます。
	pプリセットカラーを呼び出す前に設定していた値を保存
する場合は、「ショットメモリー」を参照してください。
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キーのマスク

BOXパターンのマスク信号で、キー信号をマスクします。

1	以下のメニュー操作でマスク方法を設定します。

[3] Key >
	 Mask > Size

Off キー信号をマスクしません。
Manual Position サブメニューで設定する領域をマスク

します。
4:3 4:3 のアスペクト比にマスクします。

2	以下のメニュー操作でマスク信号を反転させるかどうか
を設定します。

[3] Key >
	 Mask > Invert

On マスク信号を反転させます。
Off マスク信号を反転させません。

3	以下のメニュー操作でマスク領域を設定します。

[3] Key >
	 Mask > Position > Left

[3] Key >
	 Mask > Position > Top

[3] Key >
	 Mask > Position > Bottom

[3] Key >
	 Mask > Position > Right

パラメーター 設定内容
設定範囲 /
初期値

Left キー左側の位置
–50.00～ 50.00/
–25.00

Top キー上部の位置
–50.00～ 50.00/
25.00

Bottom キー下部の位置
–50.00～ 50.00/
–25.00

Right キー右側の位置
–50.00～ 50.00/
25.00

Left と Right、Top と Bottomは、お互いの設定範囲
を超えることはできません。

<キーマスクの設定>（図はデフォルト値の場合）

0 

50 

-50 
500-50

TOP (25) 

BOTTOM (-25)

(25)
RIGHT

(-25)
LEFT  

マスク領域

キー信号の有効領域

映像信号領域

プライオリティの設定

Key1、Key2の映像が重なったときの位置関係を設定しま
す。

以下のメニュー操作で2nd項目、1st 項目でそれぞれの位
置関係を設定します。

[3] Key >
	 Key Priority > Key*

*	 �[3] Key > Key Select で選択したメニューのみ表示し
ます。

1st 上位の対象を設定します。
2nd 下位の対象を設定します。

2nd:
 Key1

1st:
 Key2
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PinP（ピクチャーインピクチャー）
バックグラウンド映像に別の映像を合成します。
本機は、Key1 と Key2 の 2チャンネルのPinP に対応し
ています。

以下のメニュー操作でPinP の有効 (On)/ 無効 (Off) を設
定します。

[3] Key >
	 PinP > PinP

PinPチャンネルと素材の選択

AUXバス選択ボタンの [Key1] または [Key2] ボタンを押
します。

押したボタンが点灯します。
このとき、AUXバスクロスポイントボタンは、PinP の素
材が選択されている状態になります。

選択されたAUXバスクロスポイントボタンは、アンバー
色に点灯します。（選択された信号がPGM出力されている
場合は、赤色に点灯します。）

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

Shapeの選択

PinP の映像を合成するときの形には、四角形（Square）、
円形（Circle）、ハート（Heart）、花（Flower）、星（Star）
を選択することができます。
	pこの設定は、[Full Key] が [ON] のときのみ有効です。

1	以下のメニュー操作で映像を合成するときの形を選択し
ます。

[3] Key >
	 PinP > Shape

2	以下のメニュー操作で映像を合成するときの透過率 (濃
さ ) を選択します。

[3] Key >
	 PinP > Density

Full Key の On/Off

以下のメニュー操作で Full Key の有効 (On)/ 無効 (Off) を
設定します。

[3] Key >
	 PinP > Full Key

On [3] Key > Key Typeで設定した値に関わらず、
Full Key で PinP 映像が合成されます。

Off [3] Key > Key Type で設定した値に基づいて
PinP映像が合成されます。

PinPの調整

位置とサイズを調整する

以下のメニュー操作でX、Y座標と大きさを設定します。

[3] Key >
	 PinP > Position > X-Position

[3] Key >
	 PinP > Position > Y-Position

[3] Key >
	 PinP > Position > Size
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Key1 PinPとKey2 PinPの連動

座標を設定した軸に対して、Key1 PinP と Key2 PinP の
映像が対称な動作をします。
基準になる映像は、操作しているメニューのPinP 映像に
なります。

Key1 PinP と Key2 PinP を連動させる

以下のメニュー操作で基準にする位置を選択します。

[3] Key >
	 PinP > Sync > Symmetry

基準になる映像は、操作しているメニューのPinP 映像に
なります。

Symmetry：Xの場合
座標がX軸に対して対称

Symmetry：Yの場合
座標がY軸に対して対称

Symmetry：Center の場合
座標が中心に対して対称

Symmetry：Sameの場合
座標が同じ

設定値をコピーする

以下のメニューで設定値をコピーできます。

[3] Key >
	 PinP > Sync > Copy to Key

Key1 PinP の設定値を Key2 PinP へコピー、同様に
Key2 PinP の設定値をKey1 PinP へコピーすることがで
きます。
	p [3] Key > Key Select で選択していない素材名が表示
されます。

以下のメニュー操作で OSD/TIME ダイヤルを押すと、
Key1 PinP( または Key2 PinP) の設定値がコピーされ、
Key2 PinP( またはKey1 PinP) の値に設定されます。

下記の設定値は、コピーされません。
	p [3] Key > PinP > PinP
	p [3] Key > PinP > Shape
	p [3] Key > PinP > Density
	p [3] Key > PinP > Full Key
	p [3] Key > PinP > Trim > Trim
	p [3] Key > PinP > Trim > Pair
	p [3] Key > PinP > Trim > Preset

NOTE
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PinPの装飾

PinP にボーダーやソフト効果を付加します。

1	以下のメニュー操作でボーダーのOn/Off を設定します。

[3] Key >
	 PinP > Border > Border

2	以下のメニュー操作でボーダーの幅を設定します。

[3] Key >
	 PinP > Border > Width

3	以下のメニュー操作でソフト効果の量を設定します。	
0.0 はソフト効果OFFとなります。

[3] Key >
	 PinP > Border > Soft

Border 項目を “On” に設定したとき、ソフト効果の量は、
ボーダーの幅に対するソフト効果の割合を示します。
ソフト効果のみをPinPに付加する場合は、Border 項目
を “Off” に設定してください。

4	以下のメニュー操作でボーダー幅の変化を設定します。

[3] Key >
	 PinP > Border > Mode

Fix ボーダー幅を一定に保ちます。
Variable PinPのサイズに合わせてボーダー幅が変化しま

す。

ボーダーの色を設定する

以下のメニュー操作でボーダーカラーのHue、Sat、Lum
を調整します。

[3] Key >
	 PinP > Border > Color > Hue

[3] Key >
	 PinP > Border > Color > Sat

[3] Key >
	 PinP > Border > Color > Lum

■ プリセットカラーを呼び出す場合
以下のメニュー操作でプリセットカラーを選択し、OSD/
TIMEダイヤルを押します。

[3] Key >
	 PinP > Border > Color > Load

	p OSD/TIMEダイヤルを押すと、それまで設定していた値
が取り消されてプリセットカラーの値に変更されます。
	pプリセットカラーを呼び出す前に設定していた値を保存
する場合は、「ショットメモリー」を参照してください。

トリミングの設定
1	以下のメニュー操作でトリミングのOn/Off を設定しま
す。

[3] Key >
	 PinP > Trim > Trim

On トリミングをします。
Off トリミングをしません。

2	以下のメニュー操作でトリミングの種類を選択します。

[3] Key >
	 PinP > Trim > Preset

16:9 アスペクト比が16:9 になるように自動的にト
リミングします。

12:9 アスペクト比が12:9 になるように自動的にト
リミングします。

9:9 アスペクト比が9:9 になるように自動的にトリ
ミングします。

7:9 アスペクト比が7:9 になるように自動的にトリ
ミングします。

6:9 アスペクト比が6:9 になるように自動的にトリ
ミングします。

Manual Trimサブメニューで設定されている値でトリミ
ングします。

3	以下のメニュー操作でPair の On/Off を設定します。

[3] Key >
	 PinP > Trim > Pair

On Left と Right、Top と Bottomのトリミング
量が同じになるように変化します。
（上下、左右対称になります）

Off Pair の設定をしません。
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4	以下のメニュー操作でトリミングの値を設定します。

[3] Key >
	 PinP > Trim > Adjust > Left

[3] Key >
	 PinP > Trim > Adjust > Top

[3] Key >
	 PinP > Trim > Adjust > Bottom

[3] Key >
	 PinP > Trim > Adjust > Right

パラメーター 設定内容
設定範囲 /
初期値

Left 左側のトリミング値
–50.00～ 50.00/
–50.00

Top 上部のトリミング値
–50.00～ 50.00/
50.00

Bottom 下部のトリミング値
–50.00～ 50.00/
–50.00

Right 右側のトリミング値
–50.00～ 50.00/
50.00

<トリミングの設定>（図はデフォルト値の場合）

0

60

-60
600-60

TOP (50)

BOTTOM (-50)

(-50)
LEFT

(50)
RIGHT

トリミング領域

PinPの有効領域

PinPの元のサイズ

Key Link
Key1と Key2を連動させることができます。

[KEY1 ON] ボタンと [KEY2 ON] ボタンのOn/Off（ボ
タン点灯 / ボタン消灯）を連動させることができます。

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

以下のメニュー操作で各ボタンのリンクの有無をOn/Off
で設定します。

[3] Config >
	 Key1/2 Link

	p“Off” を選択した場合は、リンクしません。
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FTB（Fade to Black）
プログラム映像から黒画面 /白画面 /Still/ カラーバックグ
ラウンド画面へのフェードアウト、または黒画面 /白画面 /
Still/ カラーバックグラウンド画面からプログラム映像への
フェードインを実行します。

1	トランジションの時間を設定します。	
以下のメニュー操作で各バックグラウンドトランジショ
ンと同様に、トランジションタイムを設定します。

[5] Time >
	 FTB > Trans Time

 「オートトランジション」参照

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

2	トランジション部の [FTB ON] ボタンを押すと、設定さ
れたトランジションタイムで設定画面にフェードアウト
します。
フェードアウト中は、[FTB ON] ボタンが赤色に点滅し、
トランジション（フェードアウト）が完了して黒画面に
なると、赤色に点灯します。*
黒画面の状態から、[FTB ON] ボタンを押すと、プログ
ラム映像にフェードインします。
フェードイン中は、[FTB ON] ボタンが赤色に点灯し、
トランジション（フェードイン）が終了すると消灯します。
トランジションの途中で [FTB ON] ボタンを押すと、ト
ランジションの方向が反転します。

*：�FTB 状態では、通常赤色に点灯するクロスポイント
ボタンは、アンバー色に点灯します。

映像の選択

フェードアウトするときの映像を選択することができます。

以下のメニュー操作でフェードアウトするときの映像を選
択します。

[5] Time >
	 FTB > Source

Still1 静止画ビデオメモリー（Still1）を使用します。
Still2 静止画ビデオメモリー（Still2）を使用します。
CBGD1

カラーバックグラウンドを使用します。
CBGD2
White 白背景
Black 黒背景

音声のミュート

映像がフェードアウトするときに音声のフェードアウトも
同期させるかを選択することができます。

以下のメニュー操作で音声のフェードアウトの有無を選択
します。

[5] Time >
	 FTB > Mute

Off 映像フェードアウト時に音声はフェードアウト
しません。

On 映像フェードアウト時に音声もフェードアウト

します。
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内蔵カラー信号
本機は2系統の内蔵カラー信号に対応しています。

カラーバックグラウンドの設定

バスで使用するカラーバックグラウンドの色を設定します。
Hue（色相）、Sat（色の濃さ）、Lum（明るさ）を設定
して使用する方法と、プリセットカラーの 8色（White、
Yellow、Cyan、Green、Magenta、Red、Blue、
Black）を呼び出して使用する方法があります。
呼び出した色のHue、Sat、Lumを調整することもできま
す。

色を調整する

1	以下のメニュー操作で対象のカラーバックグラウンド
(CBGD1/CBGD2) を選択します。

[2] CBGD >
	 CBGD Select

2	以下のメニュー操作で色の調整 (Hue、Sat、Lum) を行
います。

[2] CBGD >
	 CBGD Main > Hue

[2] CBGD >
	 CBGD Main > Sat

[2] CBGD >
	 CBGD Main > Lum

■ プリセットカラーを呼び出す場合
以下のメニュー操作でプリセットカラーを選択し、OSD/
TIMEダイヤルを押します。

[2] CBGD >
	 CBGD Main > Load

	p OSD/TIMEダイヤルを押すと、それまで設定していた値
が取り消されてプリセットカラーの値に変更されます。
	pプリセットカラーを呼び出す前に設定していた値を保存
する場合は、「ショットメモリー」を参照してください。

Washの設定

カラーバックグラウンドのグラデーション効果を設定しま
す。

Washの選択と色の設定

1	以下のメニュー操作でWash( グラデーション )効果の
設定をします。

[2] CBGD >
	 CBGD Wash > Wash

On グラデーション効果を付加します。
Off グラデーション効果を付加しません。

2	以下のメニュー操作でWash( グラデーション )効果の
色を設定します。

[2] CBGD >
	 CBGD Wash > Color

Dual 2色のグラデーション効果を付加します。
（CBGD1 Main と CBGD1 Sub の 2色のグラ
デーションになります）

Rainbow 虹色のグラデーション効果を付加します。

3	“Dual”を選択した場合、以下のメニュー操作でサブカ	
ラーの色の調整 (Hue、Sat、Lum) を行います。

[2] CBGD >
	 CBGD Sub > Hue

[2] CBGD >
	 CBGD Sub > Sat

[2] CBGD >
	 CBGD Sub > Lum

基本操作
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Washの波形の調整

1	以下のメニュー操作でグラデーションの波形を選択しま
す。

[2] CBGD >
	 CBGD Wave > Pattern

Sine サイン波を選択します。
Saw のこぎり波を選択します。

2	以下のメニュー操作でグラデーションの周期を選択しま
す。

[2] CBGD >
	 CBGD Wave > Cycle

3	以下のメニュー操作でグラデーションの位相を選択しま
す。

[2] CBGD >
	 CBGD Wave > Phase

4	以下のメニュー操作でグラデーションの角度を選択しま
す。

[2] CBGD >
	 CBGD Wave > Angle

Wash の動きの設定

1	以下のメニュー操作でグラデーションの動きを設定しま
す。

[2] CBGD >
	 CBGD Move > Move

Off 動きを設定しません。
Roll グラデーションをスクロールさせます。
Rotation グラデーションを回転させます。

2	以下のメニュー操作で動きの速さを設定します。

[2] CBGD >
	 CBGD Move > Speed

基本操作
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カラーバー信号の選択

以下のメニュー設定で内蔵カラーバーの種類をType1～ 3
に設定することができます。

[12]Config >
	 CBAR > Type

Type1

Type2

Type3

	pカラーバーは色位相調整用であり、バーの幅や位置が
他機種と異なる場合があります。

カラーバー信号の動き設定

カラーバー信号の動くスピードを2段階で設定することが
できます。
	pカラーバー信号を動かすことができるのはType2、3で
す。

以下のメニュー操作で動くスピードを設定します。

[12] Config >
	 CBAR > Move

Normal カラーバー信号を速く動かします。
Low カラーバー信号をゆっくり動かします。
Off カラーバー信号を動かしません。

テストトーンの設定

カラーバー信号の時に出力するテストトーン信号（1 kHz）
に関する設定を行います。

以下のメニュー操作でテストトーン機能を設定します。

[12] Config >
	 CBAR > Test Tone

Normal テストトーンを通常の音量（–12 dB）で出力
します。

Low テストトーンを小さめの音量（–20 dB）で出
力します。

Off テストトーンを出力しません。

内蔵カラーバー信号
本機は1系統の内蔵カラーバー信号に対応しています。

基本操作
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内蔵テストパターン信号
本機はテストパターン信号を送出することができます。
出力先の機器でのアスペクトなどを確認することができま
す。
本機で設定されたシステムフォーマットに対応した画角の
テストパターン信号が選択されます。
ビデオメモリーのStill1 またはStill2 にロードされ、内部
素材として使用することができます。

<システムフォーマットが1080のときのテストパターン>

<システムフォーマットが720のときのテストパターン>

1	以下のメニュー操作でテストパターン信号を出力する対
象を選択します。

[6] Still >
	 Still Select

2	以下のメニューでOSD/TIMEダイヤル (Execute) を押
すと、選択したビデオメモリーにロードされます。

[6] Still >
	 Test Pattern > Load

基本操作
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AUX出力の切り替え

AUX出力素材の選択

AUXバス（AUX1、AUX2）の出力信号を選択します。

1	AUXバス選択ボタンの [AUX1]、[AUX2] ボタンのい
ずれかを押します。	
選択したボタンがアンバー色に点灯します。

2	AUXバスクロスポイントボタンを押します。	
[AUX1]、[AUX2] ボタンに対して、選択した信号が出
力されます。

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

AUX1で選択された信号がアンバー色に点灯

<AUXバスで選択できる信号>
信号名 信号

IN1 SDI/HDMI 入力信号1
IN2 SDI 入力信号2
IN3 SDI 入力信号3
IN4 SDI 入力信号4
IN5 HDMI 入力信号2
IN6 IP 入力信号1
IN7 IP 入力信号2
IN8 IP 入力信号3
IN9 IP 入力信号4
PGM プログラム映像信号
PVW プレビュー映像信号
CLN クリーン信号
MV マルチビューディスプレイ出力信号
KeyOut キー出力信号
Black 黒信号

CBGD1、
CBGD2

カラーバックグラウンド1、2

CBAR カラーバー
Still1、Still2 ビデオメモリー（静止画）1、2

	pMVを選択しているAUXバスをマルチビューディスプレ
イの子画面に表示すると、2枚の鏡を向かい合わせにし
たときのように映像がループします。

AUX1/2のトランジション

AUX1/2に設定した出力信号を切り替えたときに、MIXト
ランジションを行います。

1	AUXバス選択ボタンの [AUX1] または [AUX2] ボタン
を押します。	
選択したボタンとそのボタンに対応しているAUXバス
クロスポイントボタンがアンバー色に点灯します。

2	切り替える出力信号のAUXバスクロスポイントボタン
を押します。	
このとき、Timeメニューで設定されているトランジシ
ョンタイムでMIXトランジションを行います。	
トランジション中は、トランジション元のAUXボタン
が緑色に点灯し、トランジション先のAUXボタンがア
ンバー色で点滅します。	
トランジションが完了した時点でトランジション元の
AUXボタンが消灯し、トランジション先のAUXボタン
がアンバー色で点灯します。	
また、トランジション中に別の信号に切り替えた場合、
トランジションは、その途中から継続して処理が行われ
ます。

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

アンバー色で点滅（トランジション中）
緑色で点灯

	p Shot Memory リコール時のAUXバストランジション
は、Shot Memory のディゾルブタイムに連動します。

基本操作
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AUX1/2のトランジション有効／無効設定

AUX1/2 のトランジションタイムとトランジションの有
効／無効を設定します。

1	以下のメニュー操作でトランジションタイムを設定しま
す。

[5] Time >
	 AUX1 Bus Trans > Trans Time

[5] Time >
	 AUX2 Bus Trans > Trans Time

設定できる時間は0～999f です。システムフォーマッ
トにより、秒表示のときの設定可能時間が異なります。

59.94i 最大33s09f 29.97p 最大33s09f
50i 最大39s24f 25p 最大39s24f
59.94p 最大16s39f 24p 最大41s15f
50p 最大19s49f 23.98p 最大41s15f

2	以下のメニュー操作でトランジションの有効 /無効を設
定します。

[5] Time >
	 AUX1 Bus Trans > Transition

[5] Time >
	 AUX2 Bus Trans > Transition

On 有効
Off 無効

トランジションを無効にしたときは、AUX1/2 に設定
した出力信号を切り替えたときに、トランジションを行
わずに出力信号が切り替わります。

基本操作
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ショットメモリー
バックグラウンドのトランジションパターンや PinP のサイズ、ボーダーの幅など映像効果をメモリーに登録し、呼び出す
ことができます。これをショットメモリーと呼びます。
エフェクトディゾルブを設定することにより、現在の映像からショットメモリーに登録されている映像や動作への切り替え
を、スムーズに変化させることができます。

メモリーの登録、呼び出し項目

対象 素材選択 トランジション パターン メニュー
BKGD  PGM/Aバス

 PST/Bバス
 フェーダー量
 ワイプの方向

 �BKGDパターン	
(MIX、ワイプ )

 [1] WIPE

Key1  Key1 Fill バス
 Key1 Source バス

 Key1 の On/Off
 フェーダー量
 ワイプの方向

 �KEYパターン	
(MIX、ワイプ )

 [1] WIPE
 [3] Key
 [4] ChromaKey

Key2  Key2 Fill バス
 Key2 Source バス

 Key2 の On/Off  [3] Key

AUX1  AUX1バス
AUX2  AUX2バス
CBGD  [2] CBGD

メモリーの登録（Store）

登録しておきたい映像や動作の設定を行い、メモリーに登
録します。

POWER

AMB:F
GRN:S

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4 USER 2 5 USER 3 SHOT MEM6

PGM PVW

SHIFT

SHIFT

MIX

WIPE

1	登録しておきたい映像や動作を本機で設定します。

2	メモリーに登録する対象を以下のメニューから設定します。

[7] Shot Memory >
	 Target Select > BKGD

[7] Shot Memory >
	 Target Select > Key1

[7] Shot Memory >
	 Target Select > Key2

[7] Shot Memory >
	 Target Select > AUX1

[7] Shot Memory >
	 Target Select > AUX2

[7] Shot Memory >
	 Target Select > CBGD

 「登録対象と再生対象の選択」参照

3	[SHOT MEM] ボタンを押します。
[SHOT MEM] ボタンがアンバー色に点灯します。

4	登録するメモリー番号のAUX BUS選択ボタン (1～
12) を長押しします。（約1秒間）
登録が完了すると、メモリー番号のAUX BUS選択ボタ
ンが緑色に点灯します。
	p AUX BUS選択ボタン1～6は [SHIFT] ボタンを押
している間7～12として動作します。
	p緑色またはアンバー色に点灯しているAUX BUS選択
ボタンには、すでにメモリーが登録されています。

5	上記の操作を繰り返し行い、何種類かの設定をメモリー
に登録します。

基本操作
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メモリー動作の呼び出し（Recall）

POWER

AMB:F
GRN:S

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4 USER 2 5 USER 3 SHOT MEM6

PGM PVW

SHIFT

SHIFT

MIX

WIPE

1	メモリーから呼び出す対象を以下のメニューから選択し
ます。

[7] Shot Memory >
	 Target Select > BKGD

[7] Shot Memory >
	 Target Select >  Key1

[7] Shot Memory >
	 Target Select > Key2

[7] Shot Memory >
	 Target Select > AUX1

[7] Shot Memory >
	 Target Select > AUX2

[7] Shot Memory >
	 Target Select > CBGD

 「登録対象と再生対象の選択」参照

2	登録されている「素材選択」項目の素材を使わずに、操
作パネルのクロスポイントボタンで素材を選択する場合
は、以下のメニューを“On”にします。

[7] Shot Memory >
	 XPT Disable

 「登録対象と再生対象の選択」参照

3	[SHOT MEM] ボタンを押します。
[SHOT MEM] ボタンがアンバー色に点灯します。

4	呼び出すメモリー番号のAUX BUS選択ボタン (1～
12) を押します。
	p AUX BUS選択ボタン1～6は [SHIFT] ボタンを押
している間7～12として動作します。
	pショットメモリーでは、映像効果が呼び出されて再生
を開始します。	
再生中は、メモリー番号の AUX BUS 選択ボタンが
アンバー色に点灯します。

ユーザーボタンからメモリー動作の呼び出しをする場合は、
「ユーザーボタンの設定」を参照してください。

メモリーの削除（Delete）

POWER

AMB:F
GRN:S

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4 USER 2 5 USER 3 SHOT MEM6

PGM PVW

SHIFT

SHIFT

MIX

WIPE

1	[SHOT MEM] ボタンを長押しします。
[SHOT MEM] ボタンがアンバー色に点滅します。
また、メモリーが登録されているAUX BUS選択ボタン
が緑色またはアンバー色に点滅します。

2	削除するメモリー番号のAUX BUS選択ボタン (1～
12) を長押し (1秒程度 )します。
押したAUX BUS選択ボタンが消灯します。
	p AUX BUS選択ボタン1～6は [SHIFT] ボタンを押
している間7～12として動作します。

登録対象と再生対象の選択

メモリーを登録するときの対象と「素材選択」項目の選
択

ショットメモリーを作成するときに、保存対象とする項目
を選択します。

以下のメニュー操作で保存したい項目を“On”に設定しま
す。

[7] Shot Memory >
	 Target Select > BKGD > Target

[7] Shot Memory >
	 Target Select > Key1 > Target

[7] Shot Memory >
	 Target Select > Key2 > Target

On 対象の設定をメモリーに登録します。
Off 対象の設定をメモリーに登録しません。

[7] Shot Memory >
	 Target Select > BKGD > XPT

[7] Shot Memory >
	 Target Select > Key1 > XPT

[7] Shot Memory >
	 Target Select > Key2 > XPT

On 「素材選択」項目をメモリーに登録します。
Off 「素材選択」項目をメモリーに登録しません。

基本操作
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[7] Shot Memory >
	 Target Select > AUX1

[7] Shot Memory >
	 Target Select > AUX2

[7] Shot Memory >
	 Target Select > CBGD

On 対象の設定をメモリーに登録します。
Off 対象の設定をメモリーに登録しません。

メモリー再生するときの対象と「素材選択」項目の選択

ショットメモリーを再生するときの対象と「素材選択」項
目を選択します。

以下のメニュー操作で再生したい項目を“On”に設定しま
す。

[7] Shot Memory >
	 Target Select > BKGD > Target

[7] Shot Memory >
	 Target Select > Key1 > Target

[7] Shot Memory >
	 Target Select > Key2 > Target

On 対象を再生します。
ただし、メモリーに登録されていない場合は、
再生しません。

Off 対象を再生しません。

[7] Shot Memory >
	 Target Select > BKGD > XPT

[7] Shot Memory >
	 Target Select > Key1 > XPT

[7] Shot Memory >
	 Target Select > Key2 > XPT

On 「素材選択」項目を再生します。
ただし、メモリーに登録されていない場合は、
再生しません。

Off 「素材選択」項目を再生しません。

[7] Shot Memory >
	 Target Select > AUX1

[7] Shot Memory >
	 Target Select > AUX2

[7] Shot Memory >
	 Target Select > CBGD

On 対象を再生します。
ただし、メモリーに登録されていない場合は、
再生しません。

Off 対象を再生しません。

[7] Shot Memory >
	 XPT Disable

On BKGD、Key1、Key2の「素材選択」項目を
再生しません。

Off BKGD、Key1、Key2の「素材選択」項目を
再生します。
ただし、メモリーに登録されていない場合は、
再生しません。

基本操作
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エフェクトディゾルブの設定（ショットメモリー）

現在の映像からショットメモリーに登録されている映像や
動作への切り替えを、スムーズに変化させることができま
す。

1	以下のメニュー操作で映像を切り替えるときの効果の設
定をします。

[7] Shot Memory >
	 Effect

Cut カット効果で映像を切り替えます。
Dissolve ディゾルブ効果で映像を切り替えます。

	pディゾルブ効果の時間は、以下のメニュー操作で設定
します。

[5] Time >
	 Effect Dissolve

2	以下のメニュー操作で色が切り替わるときの効果を選択
します。

[7] Shot Memory >
	 Hue Path

下記のHueが対象になります。
	pカラーバックグラウンドの色
	pボーダーの色
	pエッジの色
	pフィルマットの色

Short ベクトルスコープ上でHueの変化が少ない方向
に色を変化させます。

Long ベクトルスコープ上でHueの変化が多い方向に
色を変化させます。

CW ベクトルスコープ上で時計回りにHueを変化さ
せます。

CCW ベクトルスコープ上で反時計回りにHueを変化
させます。

	p動作を切り替えると、押した AUX BUS 選択ボタンがア
ンバー色に点灯します。
	p動作の切り替え中にEffect 項目を“Dissolve”から“Cut”
に変更した場合、ディゾルブ効果が解除されて、選択し
たショットメモリーの映像に瞬時に切り替わります。
	p動作の切り替え中は、フェーダーの操作が無効になりま
す。
	p動作の切り替え中に、他のメモリー動作を呼び出すこと
はできません。

基本操作
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ビデオメモリー

基本操作

本機では、静止画のメモリー（Still）を 2チャンネル保存
して使用することができます。
	pビデオメモリー（静止画）は、キー信号付きの映像を保存
することができます。
	pビデオメモリーのデータは内蔵ストレージに保存され、
本機の電源をOFFにしても保持されます。
	pビデオメモリーのデータは、USBメモリーへの保存と読
み出しが可能です。
	p本機のシステムフォーマットを1080↔720と変更し
た場合、登録されているビデオメモリーは削除されます。
システムフォーマットを変更する前に、ビデオメモリー
をUSBメモリーやプロジェクトファイルに保存してくだ
さい。

■ ビデオメモリーの入出力
映像の入力素材は、AUXバス (AUX1、AUX2) の出力信
号から選択します。

<ビデオメモリーの映像系統>

Still2

Still1 Key

Video

Key

VideoAUX1、AUX2：
メニューで選択

AUX1、AUX2：
メニューで選択

静止画（Still）を記録する
1	以下のメニュー操作で“Still1”、または“Still2”を選
択します。

[6] Still >
	 Still Select

2	以下のメニュー操作でビデオメモリーに記録する映像を
設定します。

[6] Still >
	 Capture Setting > Video

AUX1、
AUX2

AUXバス（AUX1、AUX2）の出力信号を素
材として記録します。

3	以下のメニュー操作でレビュー表示を設定します。

[6] Still >
	 Capture Setting > Review

On 映像を記録したあと、AUXバスに記録したビデ
オメモリーの映像を表示します。（約2秒間）

Off レビュー表示を行いません。

4	以下のメニューでOSD/TIMEダイヤル (Execute) を押
すと同時に、静止画を記録します。

[6] Still >
	 Capture
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USBメモリー
USBメモリーには、本機のビデオメモリーデータやセットアップデータをプロジェクトファイルとして保存することがで
きます。
逆に、USBメモリーから本機に、これらのデータを読み込むことも可能です。
また、本機のソフトウェアのアップデートを行うこともできます。
	p高画質の静止画ファイルをUSBメモリーに保存する際には、しばらく時間がかかる場合があります。

ビデオメモリー（静止画データ：Still1、Still2）：
<対応ファイル形式>

ビットマップ（bmp）、JPEG（jpg）、TARGA（tga）、TIFF（tif）、GIF（gif）、PNG（png）

	p本機は、24 bit 非圧縮、または32 bit 非圧縮の TARGAファイルに対応しています。	
他の TARGAファイルを本機で読み込んでも認識することができません。
	pビデオメモリーの静止画をGIF 形式でUSBメモリーに保存すると、画質の劣化を伴いますので注意してください。

<適正なサイズ>

HD/1080i：	 1920× 1080
HD/1080p：	 1920× 1080

HD/720p：	 1280× 720

	p“適正なサイズ”と一致しないサイズの画像は、サイズを変更しないでセンタリングしてAV-HSW10から映像を出力
します。サイズが大きい場合は、サイズからはみ出た部分をカットして表示します。サイズが小さい場合は、余白部分
を黒の画像で表示します。また、1920× 1080 ピクセルを超えるサイズのファイルは、読み込みができません。

プロジェクトファイル（Project）：
下記のデータを除いて、本機に保存されているすべてのデータを指します。
プロジェクトファイルで保存できます。

日付、時刻、ネットワーク設定

アップデート用ソフトウェア (Update)：
アップデート用ソフトウェアの読み込みを行います。
アップデート用ソフトウェアは、下記のWebサイトの「サポート＆ダウンロード」から入手することができます。
https://connect.panasonic.com/jp-ja/products-services_proav
アップデートの手順は、ダウンロードファイルに含まれている手順書に従って行ってください。

ログファイル（Log）：
本機が保持しているログファイルを保存することができます。

基本操作
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	●USBメモリーについて
本機で使用するUSBメモリーは、USB 2.0 規格に準拠したものをお使いください。
また、USBメモリーのフォーマットは、必ず本機で行ってください。
FATまたは exFATでフォーマットされたUSBメモリーをお使いください。
（NTFSフォーマットのUSBメモリーは認識できません。)

本機では、下記のUSBメモリーで動作確認を行っています。
	p KIOXIA TransMemory U301 (32GB、64GB、128GB)
	p SanDisk Cruzer Glide CZ600 (32GB、64GB、128GB)

取扱説明書に記載された情報以外の最新情報は、下記のWebサイトをご参照ください。
（日本語）	https://connect.panasonic.com/jp-ja/products-services_proav
（英語）	 https://pro-av.panasonic.net/en/

	p使用時、保管時は以下の点にお気をつけください。
	 ・	高温・多湿を避ける。
	 ・	水滴を付けない。
	 ・	帯電を避ける。

基本操作
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各データは、USBメモリーの下記のフォルダーに保存されます。
データを読み込むときは、それぞれのフォルダーに保存してからファイルの読み込みを行ってください。

<データフォルダーの構成>
データの種類 Save Type 項目 保存フォルダー 拡張子

プロジェクトファイル (project) Project (*1) “HS\COMM\PROJECT” 001、002、… (*3)
ビデオメモリー (Still ファイル ) Still1、Still2 (*2) “HS\COMM\IMAGE” bmp、tga、png、jpg(jpeg)、

tif(tiff)、gif
アップデートファイル ー “HS\HSW10\UPDATE” 10d
ログファイル Log “HS\HSW10\LOG” log
Load TEXTファイル（26ページ） “HS\HSW10\TEXT” txt (*4)
*1	 �プロジェクトファイルでは、以下のメニュー操作で選択したセットアップデータ、ショットメモリーデータ、静止画データがまとめて保

存できます。

[18] USB Memory >
	 Save > Setup

[18] USB Memory >
	 Save > Shot

[18] USB Memory >
	 Save > Still

*2	 �キー信号付きの静止画データをビデオメモリーに保存する場合は、「tga」形式、または「png」形式のデータにしてください。	
他の形式の静止画データは、キー信号を付けて保存することができません。

*3	 �プロジェクトファイルは、HS\COMM\PROJECTフォルダーの1階層下に File Nameフォルダーを作成し、作成したフォルダー内に
プロジェクトファイルを保存します。	
保存するプロジェクトファイルが大きい場合は、ファイルが分割され、各ファイルに連番の拡張子（001、002、...）が付加されます。

*4	 �本機でフォーマットしたUSBメモリーの "HS\HSW10\TEXT" に保存したテキストファイル (.txt) を読み込み、内容を文字列に設定す
ることができます。USBメモリーを接続していない場合は、[Load TEXT] は選択できません。

USBメモリー取り扱い時の注意
	p USBメモリーは“Unmount”してから取り外してください。	
“Unmount”せずにUSBメモリーを抜くと、トランジションが一時停止する場合やUSBメモリーに保存された内容
が失われる場合があります。
	p USBメモリーに保存した内容は、USBメモリーの紛失や誤操作などにより失われる可能性があります。	
大切なデータは、コンピューターなどに保存されることをおすすめします。

基本操作
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USBメモリーのフォーマット

本機でUSBメモリーを使用する前に、必ず、本機でUSB
メモリーのフォーマットを実行してください。フォーマット
を実行することにより、USBメモリーのフォーマットを行い、
専用ディレクトリーを作成します。（USBメモリーに保存さ
れているファイルは、すべて消去されます。）

1	本機のUSB端子 (Type-A コネクター )に USBメモ	
リーを挿入します。

2	以下のメニューでOSD/TIMEダイヤル (Execute) を押
して、フォーマットを実行します。

[18] USB Memory >
	 Format

USBメモリーが挿入されていない場合は、項目がグレー
アウトされます。
	p確認画面でフォーマットする場合は、“YES”を選択
します。
	p取りやめる場合は、“NO”を選択します。

本機で使用するためには、USBメモリーのフォーマットを
行ってください。

USBメモリーへの保存
1	本機でフォーマットを行ったUSBメモリーをUSB端
子 (Type-A コネクター )に挿入します。

2	以下のメニュー操作でUSBメモリーに保存するデータ
を選択します。

[18] USB Memory >
	 Save > Save Type

静止画データの場合：
以下のメニュー操作で静止画の保存ファイルフォーマ
ットを選択します。

[18] USB Memory >
	 Save > File Format

プロジェクトファイルの場合：
以下のメニュー操作でプロジェクトファイルとして保
存する項目をそれぞれ“On”にします。

[18] USB Memory >
	 Save > Setup

[18] USB Memory >
	 Save > Shot

[18] USB Memory >
	 Save > Still

3	以下のメニューでOSD/TIMEダイヤル (Execute) を押
すとファイル選択画面が表示されます。

[18] USB Memory >
	 Save > Save

データの保存先は、<データフォルダーの構成>を参照
してください。

	pビデオメモリーの静止画をGIF 形式でUSBメモリー
に保存すると、画質の劣化を伴いますので注意してく
ださい。
	pファイル名として使用できる文字は、半角英数字と半
角記号です。	
他の文字を使用しているファイルは、本機では表示さ
れません。

基本操作
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USBメモリーからの読み込み

1	データが保存されているUSBメモリーをUSB端子 
(Type-A コネクター )に挿入します。
データは、それぞれのフォルダーに保存してからファイ
ルの読み込みを行ってください。
他のフォルダーに保存したデータは、本機では認識でき
ません。
データの保存先は、<データフォルダーの構成>を参照
してください。

2	以下のメニューでOSD/TIMEダイヤル (Execute) を押
すとファイル選択画面が表示されます。

[18] USB Memory >
	 Load > Load

<ファイル選択画面表示例>

3	以下のメニュー操作で読み込むファイルの種類を選択し
ます。

[18] USB Memory >
	 Load > Load Type

4	OSD/TIMEダイヤルを回して、読み込むファイル名を
選択します。
読み込むファイル名が、11文字を超えていた場合、短
縮ファイル名で表示されることがあります。
読み込むファイル名が33文字以上の場合は、ファイル
選択画面に表示されません。
	pファイル名として使用できる文字は、半角英数字と半
角記号です。	
他の文字を使用しているファイルは、本機では表示さ
れません。

5	OSD/TIMEダイヤルを押して、ファイルを読み込みま
す。

USBメモリーの情報表示

1	データが保存されているUSBメモリーをUSB端子 
(Type-A コネクター )に挿入します。

2	以下のメニューを表示します。

[18] USB Memory >
	 Free

[18] USB Memory >
	 Total

Free USBメモリーの空き容量を表示します。
Total USBメモリーの容量を表示します。

基本操作
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内蔵ストレージ
内蔵ストレージには、本機のセットアップデータをプロジェクトファイルとして保存することができます。
また、内蔵ストレージから本機に、セットアップデータを読み込むことも可能です。
	p高画質の静止画ファイルを内蔵ストレージに保存する際には、しばらく時間がかかる場合があります。
	pプロジェクトファイルとして、以下のデータを選択して保存 /読み込みができます。
セットアップデータ、ショットメモリーデータ、Still ビデオメモリー
	p日付、時刻、ネットワーク設定は保存できません。

プロジェクトファイル管理画面

以下のメニューを表示します。

[14] Project

	pこのメニュー画面で内蔵ストレージでのプロジェクト	
ファイルの読み出し、保存、削除、名前変更ができます。	
また、最後に読み出したプロジェクトファイルの情報を
確認できます。

内蔵ストレージへのプロジェクトファイルの保
存
1	以下のメニューから保存するファイルを選択します。

[14] Project >
	 Project File > Project 1

[14] Project >
	 Project File > Project 2

[14] Project >
	 Project File > Project 3

	pすでに保存されているプロジェクトファイルに上書き
保存することができます。
	p Protect 項目が“On”のファイルに上書き保存するこ
とはできません。

2	Save項目でOSD/TIMEダイヤル (Execute)を押すと、
内蔵ストレージにプロジェクトファイルが保存されます。

内蔵ストレージからのプロジェクトファイルの
読み出し
1	以下のメニューから読み出すファイルを選択します。

[14] Project >
	 Project File > Project 1

[14] Project >
	 Project File > Project 2

[14] Project >
	 Project File > Project 3

2	Load項目でOSD/TIMEダイヤル (Execute) を押すと、
内蔵ストレージからプロジェクトファイルが読み出せま
す。

3	Protect 項目の設定で対象のファイルを保護することが
できます。
	p Protect 項目が“On”のプロジェクトファイルに対し
て上書き保存、削除、ファイル名変更はできません。

内蔵ストレージからのプロジェクトファイルの
削除
1	以下のメニューから削除するファイルを選択します。

[14] Project >
	 Project File > Project 1

[14] Project >
	 Project File > Project 2

[14] Project >
	 Project File > Project 3

2	Delete 項目でOSD/TIMEダイヤル (Execute) を押す
と、内蔵ストレージからプロジェクトファイルが削除さ
れます。
	p Protect 項目が "On" のファイルを削除することはで
きません。

3	Protect 項目の設定で対象のファイルを保護することが
できます。
	p Protect 項目が“On”のプロジェクトファイルに対し
て上書き保存、削除、ファイル名変更はできません。

基本操作
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内蔵ストレージに保存されているプロジェクト
ファイルのファイル名変更
1	以下のメニューからファイル名を変更するプロジェクト
ファイルを選択します。

[14] Project >
	 Project File > Project 1

[14] Project >
	 Project File > Project 2

[14] Project >
	 Project File > Project 3

2	Name項目で内蔵ストレージに保存されたプロジェクト
ファイル名が変更できます。
	pファイル名の最大文字数は 32文字です。

<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

3	Protect 項目の設定で対象のファイルを保護することが
できます。
	p Protect 項目が“On”のプロジェクトファイルに対し
て上書き保存、削除、ファイル名変更はできません。

基本操作
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入出力信号の設定

入力信号の設定
使用可能な入力は以下のとおりです。

論理入力名称 物理入力名称 制約
IN1 SDI IN1/HDMI IN1 SDI/HDMI 排他、簡易UC/DC、スケーラーあり
IN2 SDI IN2 簡易UC/DC
IN3 SDI IN3 UC/DCあり
IN4 SDI IN4 UC/DCあり
IN5 HDMI IN2 スケーラーあり
IN6 LAN SRT/NDI HX
IN7 LAN SRT/NDI HX
IN8 LAN NDI、α対応搭載、そのときは IN9が無効
IN9 LAN NDI

入力信号を設定するときは、最初に以下のメニューで設定したい入力信号を選択してから行います。

[10] Input >
	 IN1 > SDI/HDMI

[10] Input >
	 INx > Streaming Mode

本機では、ファームウェアを更新することにより、IP入力を拡張することができます。
パナソニックWEBサイトから使用用途に応じたファームウェアに変更してください。
IP入力モードは、以下の2種類が用意されています。
SDI IN1～ 4、HDMI IN1～ 2の制約は、各 IPモードで共通です。

IP モード名称 IP入力制約
Normal IN6：SRT / NDI HX

IN7：SRT / NDI HX
IN8：NDI、α対応搭載、その時は IN9が無効
IN9：NDI
※工場出荷時はNormal モードのファームウェアです。

NDI HB IN6：NDI、α対応搭載、その時は IN7が無効
IN7：NDI
IN8：NDI、α対応搭載、その時は IN9が無効
IN9：NDI

本機の IPモードを確認するには、以下のメニューを実行します。

[13] System >
	 IP Mode

	p現在の IPモード名称が確認できます。	
IP モードの変更は、USB Memory ＞ Load > Load Type の Update より可能です。
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<入力信号別の設定一覧>

入力端子

設定メニューと本書のページ

Status FS Freeze Limited Name
Up/Down 
Converter

C/C
HDMI 
Status

P67 P68 P68 P69 P69 P69 P70 P72
SDI IN 1 ○ ○ ○ － ○ － ○ －
SDI IN 2 ○ ○ ○ － ○ － ○ －
SDI IN 3 ○ ○ ○ － ○ ○ ○ －
SDI IN 4 ○ ○ ○ － ○ ○ ○ －
HDMI IN 1 － － ○ ○ ○ － ○ ○
HDMI IN 2 － － ○ ○ ○ － ○ ○
IP IN1 － － － － ○ － － －
IP IN2 － － － － ○ － － －
IP IN3 － － － － ○ － － －
IP IN4 － － － － ○ － － －

入力端子

設定メニューと本書のページ

HDMI Input Scale
SRT 

Status
SRT Input NDI Status NDI Input

Camera 
Setting

P71 P71 P73 P73 P75 P74 P101
SDI IN 1 － － － － － － ○
SDI IN 2 － － － － － － ○
SDI IN 3 － － － － － － ○
SDI IN 4 － － － － － － ○
HDMI IN 1 ○ ○ － － － － ○
HDMI IN 2 ○ ○ － － － － ○
IP IN1 － － ○ *1 ○ *1 ○ *2 ○ *2 ○
IP IN2 － － ○ *1 ○ *1 ○ *2 ○ *2 ○
IP IN3 － － － － ○ ○ ○
IP IN4 － － － － ○ ○ ○

○：有効
－：無効

*1	 SRT設定のときのみ
*2	 NDI/NDI HX設定のときのみ

入出力信号の設定
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排他入力端子の設定

SDI 入力端子 (SDI IN 1)、HDMI 入力端子 (HDMI IN 1)
の排他入力を設定します。

以下のメニュー操作で入力信号の種類を設定します。

[10] Input >
	 IN1 > SDI/HDMI

SDI IN IN1 としてSDI IN 1 に入力されたSDI 信号を
選択します。HDMI 信号が入力されていても本
機に入力はされません。

HDMI IN IN1 としてHDMI IN 1 に入力されたHDMI 信
号を選択します。SDI 信号が入力されていても
本機に入力はされません。

入力信号の状態確認

入力信号のステータスが確認できます。

SDI 入力信号の場合

以下のメニューを表示します。

[10] Input >
	 INx > Status Information

本機では入力信号の内容を自動判別し、以下の情報を表示
します。

Format 入力されているSDI 信号の映像フォーマット情
報を表示します。

Audio 入力されているSDI 信号の音声情報を表示しま
す。

Status Detect：
本機のシステムフォーマットに適合した入力信
号フォーマットです。
Unsupported：
本機のシステムフォーマットに適合していない
入力信号フォーマットです。
Not Detect：
本機に映像信号が入力されていません。

HDMI 入力信号の場合

以下のメニューを表示します。

[10] Input >
	 INx > Status Information

本機では入力信号の内容を自動判別し、以下の情報を表示
します。

Size 入力されているHDMI 信号の解像度情報を表示
します。

Dot Clock 入力されているHDMI 信号のドットクロック情
報を表示します。

H-Frequency 入力されているHDMI 信号の水平周波数情報を
表示します。

V-Frequency 入力されているHDMI 信号の垂直周波数情報を
表示します。

Status Detect：
本機のシステムフォーマットに適合した入力信
号フォーマットです。
Unsupported：
本機のシステムフォーマットに適合していない
入力信号フォーマットです。
Not Detect：
本機に映像信号が入力されていません。

SRT入力信号の場合

 �「SRT入力信号の情報表示」参照

NDI 入力信号の場合

 �「NDI 入力信号の情報表示」参照

入出力信号の設定
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フレームシンクロナイザーの設定

SDI の入力ごとにフレームシンクロナイザーのOn/Off を
設定することができます。
HDMI 入力のフレームシンクロナイザーは常にOnとなり、
On/Off の設定はできません。

以下のメニュー操作でフレームシンクロナイザーの設定を
します。

[10] Input >
	 INx > FS Mode

Off フレームシンクロナイザーをOffにします。こ
のとき、ラインシンクロナイザー機能が動作し
ます。
ラインシンクロナイザー機能とは、水平同期信
号の位相に合わせて、入力映像信号の位相を自
動調整する機能のことです。

Normal フレームシンクロナイザー機能を有効にします。
システムフォーマットと異なる信号が入力され
ると、黒画面になります。

Auto フレームシンクロナイザー機能を有効にします。
システムフォーマットと異なる信号が入力され
ても黒画面になりません。
このとき出力される映像は、乱れた映像になる
場合があります。

	p出力信号の位相が [0H] に設定されている場合は、FS
項目を“Off”にできません。	
FS項目を“Off”にしている場合は、Normal へ変更
されます。
	p 3G-SDI Level B Mapping の信号を入力したときは、
フレームシンクロナイザーの設定を“Auto”に設定し
てください。

遅延量の設定

入力信号を遅延させることができます。
	p SDI IN1～ 4への入力信号が対象です。
	pエンベデッドオーディオは影響を受けません。

以下のメニュー操作で遅延量を設定します。

[10] Input >
	 INx > FS Delay

入力信号のフリーズ

SDI/HDMI 入力信号をフリーズ ( 静止 ) させて使用するこ
とができます。
また、フリーズしている間はその入力のタリー信号を出力
しません。

フリーズの設定

1	以下のメニュー操作でフリーズの動作を選択します。

[10] Input >
	 INx > Freeze Select

Frame フレーム単位でフリーズさせます。
Field フィールド単位でフリーズさせます。

動いている映像をフリーズさせるときに使用し
ます。
ただし、インターレース信号では、斜め線や動
きのある部分がギザギザに見えます。

	p映像がフリーズしている状態でも、選択することがで
きます。

2	以下のメニュー操作で入力映像のフリーズおよび解除を
行います。

[10] Input >
	 INx > Freeze

	p“Disable”から“Enable”に変更すると、映像信号
がフリーズします。
	p“Enable”から“Disable”に変更すると、映像信号
のフリーズを解除します。	
マルチビューディスプレイの出力に設定されている信
号をフリーズすると、素材名の前に“F”マークが表示
されます。

	pフレームシンクロナイザー機能をOFFで使用する場合
は、フリーズ実行時に出力映像が乱れることがありま
すが、フリーズ画像への影響はありません。
	pフレームシンクロナイザー機能をOFFで使用している
ときにフリーズの設定を“Enable”に設定した場合、
自動的にフレームシンクロナイザー機能がONに切り
替わります。

入出力信号の設定
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Limited設定

本機では、カメラなど接続されている入力機器のHDMI 諧
調レベルに合わせてフルレンジ、リミテッドレンジの設定
を行うことができます。

[10] Input >
	 INx > Limited

Off HDMI 入力の諧調レベルがフルレンジのときに
選択します。

On HDMI 入力の諧調レベルがリミテッドレンジの
ときに選択します。

	pフルレンジ：HDMI 入力がRGBで 0～255に対応
しています。
	pリミテッドレンジ：HDMI 入力がRGBで 16～ 235
に対応しています。ビデオレンジと呼ぶこともありま
す。

素材名の設定

入力信号に、素材名を付けることができます。
素材名は、デフォルト設定、またはユーザー設定から選択
することができます。

以下のメニュー操作で素材名の種類を選択します。

[10] Input > 
	 INx > Name Type

Default
（デフォルト設定）

自動的に下記の素材名が選択されます。
IN1～ 9

User
（ユーザー設定）

32文字までで素材名を設定します。

<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

アップコンバーターの設定

SDI IN3、SDI IN4に内蔵されている、アップコンバーター	
の設定を行います。

1	以下のメニュー操作で映像の動き検出感度を設定します。

[10] Input > 
	 INx > Up/Down Converter > Move Detect

1 静止画寄り
～ 	 ～
3 標準
～ 	 ～
5 動画寄り

2	以下のメニュー操作で映像へのエッジ強調の強弱を設定
します。

[10] Input > 
	 INx > Up/Down Converter > Sharp

1 エッジ強調弱め
～ 	 ～
3 標準
～ 	 ～
5 エッジ強調強め

入出力信号の設定
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Color Corrector

SDI/HDMI に内蔵されているColor Corrector の設定を行
います。

カラーコレクターの設定

以下のメニュー操作でColor Corrector の有効 (On)/ 無効
(Off) を設定します。

[10] Input > 
	 INx > Color Correct > C/C

プロセスコントロール

1	以下のメニュー操作でY信号のゲイン値を設定します。

[10] Input >
	 INx > Color Correct > C/C Process > 

Y-Gain

2	以下のメニュー操作でペデスタルレベルの値を設定しま
す。

[10] Input >
	 INx > Color Correct > C/C Process > 

Pedestal

3	以下のメニュー操作で彩度 (Saturation) のゲイン値を
設定します。

[10] Input >
	 INx > Color Correct > C/C Process > 

C-Gain

4	以下のメニュー操作で色相 (Hue) の変化量を設定しま
す。

[10] Input >
	 INx > Color Correct > C/C Process > Hue

入出力信号の設定
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HDMI入力信号の設定

HDMI 入力信号の設定をします。
入力可能な解像度の信号は下記のとおりです。

<HDMI 入力信号対応表>

HDMI 入力信号
システムフォーマット

1080/.
59.94p

1080/.
50p

1080/.
29.97p

1080/.
25p

1080/.
24p

1080/.
23.98p

1080/.
59.94i

1080/.
50i

720/.
59.94p

720/.
50p

1080/59.94p.
(1920 x 1080)/.
59.94 Hz、60 Hz

○ － － － － － ○ － ○ －

1080/50p.
(1920 x 1080)/50 Hz

－ ○ － － － － － ○ － ○

1080/29.97p.
(1920 x 1080)/.
29.97 Hz

－ － ○ － － － － － － －

1080/25p.
(1920 x 1080)/25 Hz

－ － － ○ － － － － － －

1080/24p.
(1920 x 1080)/24 Hz

－ － － － ○ － － － － －

1080/23.98p.
(1920 x 1080)/.
23.98 Hz

－ － － － － ○ － － － －

1080/59.94i.
(1920 x 1080)/.
59.94 Hz、60 Hz

○ － ○ － － － ○ － ○ －

1080/50i.
(1920 x 1080)/50 Hz

－ ○ － ○ － － － ○ － ○

720/59.94p.
(1280 x 720)/59.94 Hz、
60 Hz

○ － － － － － ○ － ○ －

720/50p.
(1280 x 720)/50 Hz

－ ○ － － － － － ○ － ○

WSXGA+.
(1680 x 1200)/60 Hz

○ ○ ○ ○ ○ ○ ○ ○ ○ ○

SXGA.
(1280 x 1024)/60 Hz

○ ○ ○ ○ ○ ○ ○ ○ ○ ○

WXGA.
(1280 x 768)/60 Hz

○ ○ ○ ○ ○ ○ ○ ○ ○ ○

XGA.
(1024 x 768)/60 Hz

○ ○ ○ ○ ○ ○ ○ ○ ○ ○

○：有効
－：無効

	p他の解像度の信号や他の周波数の信号が入力された場合は、入力された信号を正しく取り込むことができません。	
このとき出力される映像は、黒の映像や乱れた映像になる場合があります。

	p HDCP（High-bandwidth Digital Content Protection）には対応していません。

以下のメニュー操作でスケーリング方法を選択します。

[10] Input >
	 INx > Scale

Fit-V 入力映像のアスペクト比を維持して、垂直解像度に合わせて拡大または縮小します。

Fit-H 入力映像のアスペクト比を維持して、水平解像度に合わせて拡大または縮小します。
Full（フル） 入力映像をシステムの解像度に合わせて、拡大または縮小します。	

（アスペクト比は維持されません。上下左右の拡大縮小率は異なります。）

入出力信号の設定
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HDMI入力信号の情報表示

HDMI 入力信号の映像に関する情報を表示します。
各情報を変更することはできません。

以下のメニューを表示します。

[10] Input >
	 INx > Status Information

Size 映像の画素数を表示します。
Dot Clock 映像のドットクロックを表示します。
H-Frequency 映像の水平周波数を表示します。
V-Frequency 映像の垂直周波数を表示します。
Status Detect：

本機のシステムフォーマットに適合した入力信号フォーマットです。
Unsupported：
本機のシステムフォーマットに適合していない入力信号フォーマットです。
Not Detect：
本機に映像信号が入力されていません。

対応フォーマットは以下のとおりです。

<HDMI 対応フォーマット>

HDMI 入力信号
ドットクロック

（MHz）
周波数

水平（kHz） 垂直（Hz）
XGA 1024× 768 デジタル 65.0 48.36 60.00
WXGA 1280× 768 デジタル 79.5 47.78 59.87
SXGA 1280× 1024 デジタル 108.0 63.98 60.02
WSXGA+ 1680× 1050 デジタル 146.2 65.29 59.95
720/59.94p 1280× 720 デジタル 74.25/1.001 44.96 60.00/1.001
720/50p 1280× 720 デジタル 74.25 37.50 50.00

1080/59.94i 1920× 1080 デジタル 74.25/1.001 33.72 60.00/1.001
1080/50i 1920× 1080 デジタル 74.25 28.13 50.00

1080/23.98p 1920× 1080 デジタル 74.2 27.0 24.00/1.001
1080/24p 1920× 1080 デジタル 74.2 27.0 24.00
1080/25p 1920× 1080 デジタル 74.2 28.1 25.00
1080/29.97p 1920× 1080 デジタル 74.2 33.7 30.00
1080/59.94p 1920× 1080 デジタル 148.5/1.001 67.50/1.001 60.00/1.001
1080/50p 1920× 1080 デジタル 148.5 56.25 50.00

	p対応フォーマットに合致しない入力信号の場合、その信号を正しく取り込むことができず、黒の映像や乱れた映像になる
場合があります。

入出力信号の設定
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SRT入力信号の設定

本機に入力できるSRT信号は、2系統です。

「入力信号の設定」でSRT 対応している入力に対しSRT
の設定ができます。
SRT入力信号を設定するときは、はじめに以下のメニュー
で設定したい入力信号を設定します。

[10] Input > 
	 INx > Streaming Mode

1	以下のメニュー操作で接続方法を設定します。

[10] Input >
	 INx > Mode

Caller 配信元のサーバーURL、ポート番号を指定し、
本機から配信開始要求出す場合に指定します。

Listener 待ち受けポートを指定し、外部から配信を開始
する場合に指定します。

2	以下のメニュー操作でサーバーURLおよび配信元の	
ポート番号を設定します。(Caller の場合のみ )

[10] Input >
	 INx > Server URL

	p 1文字以上、254文字以内で設定が可能です。

[10] Input >
	 INx > Server Port

3	以下のメニュー操作で本機の待ち受けポート番号を設定
します。(Listener の場合のみ )

[10] Input >
	 INx > Port

	p一部使用できないポート選択時は、メッセージが表示
されます。

4	以下のメニュー操作でStream ID を設定します。

[10] Input >
	 INx > Stream ID

	p 512文字以内で設定が可能です。

5	以下のメニュー操作で配信される映像の暗号化方式を設
定します。

[10] Input >
	 INx > Encryption

Disable 受信した映像を復号しません。非暗号の映像を
取り扱います。

Enable 受信した映像を復号します。

6	以下のメニュー操作で受信した映像を復号するためのフ
レーズを設定します。

[10] Input >
	 INx > Passphrase

	p 10文字以上、79文字以内で設定が可能です。

SRT入力信号の情報表示

本機に入力されたSRT信号のステータスが確認できます。
以下のメニューを表示します。

[10] Input > 
	 INx > Status Information

本機ではSRT入力信号の内容を自動判別し、以下の情報を
表示します。

Format 入力されているSRT信号の映像フォーマット
情報を表示します。

Sampling 
Rate

入力されているSRT信号のサン プルレート情
報を表示します。

Audio 
Channel

入力されているSRT信号のサラウンド情報を
表示します。

Codec 入力されているSRT信号の圧縮形式情報を表
示します。

Level H.264/H.265の解像度やフレームレートの上
限を示すレベルを表示します。

Status Detect：
本機のシステムフォーマットに適合した入力信
号フォーマットです。
Unsupported：
本機のシステムフォーマットに適合していない
入力信号フォーマットです。
Not Detect：
本機に映像信号が入力されていません。

素材名の設定（SRT入力信号）

入力信号に、素材名を付けることができます。
素材名は、デフォルト設定、またはユーザー設定から選択
することができます。

以下のメニュー操作で素材名の種類を選択します。

[10] Input >
	 INx > Name Type

Default
（デフォルト設定）

自動的に下記の素材名が選択されます。
IN1～ 9

User
（ユーザー設定）

32 文字までで素材名を設定します。

<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

入出力信号の設定
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NDI/NDI HX

本機に入力できるNDI/NDI HX 信号は、NDI 信号が 2系
統およびNDI HX信号は2系統で合計4系統です。
IPモードの変更により、NDI 信号を最大4系統入力するこ
とが可能です。(その際 NDI HX信号は入力できません。)

NDI HX

本機は、NDI HX1、NDI HX2、NDI HX3に対応してい
ます。
映像圧縮規格は、NDI HX1、NDI HX2、NDI HX3いず
れもH.264に対応しています。また、NDI HX2、NDI 
HX3は、H.265にも対応しています。

NDI入力信号の設定

「入力信号の設定」でNDI 対応している入力に対しNDI の
設定ができます。
NDI 入力信号を設定するときは、はじめに以下のメニュー
で設定したい入力信号を設定します。

[10] Input >
	 INx > Streaming Mode

1	以下のメニュー操作でネットワーク上のNDI 入力素材と
して探索するモードを選択します。

[10] Input >
	 INx > Scan Mode

HB/HX v2 NDI またはNDI HX2以降の入力素材を探索し
ます。

HX v1 NDI HX1の入力素材を探索します。

2	以下のメニューでOSD/TIMEダイヤル (Execute) を押
して、機器探索を実行します。

[10] Input >
	 INx > Scan

	p探索結果が MACHINE NAME(SOURCE NAME) の
形式で一覧表示されます。
	pネットワーク上の機器探索には時間がかかる場合があ
ります。
	p NDI 入力素材の探索モードがHB/HX v2 のときには
NDI またはNDI HX2以降の入力素材がまとめて一覧
表示されます。NDI 送出機材側の設定を確認したうえ
で本機の適切な入力端子に割り当ててください。

3	入力素材として設定したい機器とNDI 映像ソースの組み
合わせを選択し、OSD/TIMEダイヤルで確定します。
	p“None”を選択することで未選択にすることができま
す。

受信プロトコルの設定

NDI 送出機器とのプロトコルを設定します。

1	以下のメニュー操作でNDI 送出機器とのプロトコルを設
定します。

[10] Input >
	 INx > Protocol

TCP NDI 送出機器とのプロトコルをTCPに設定し
ます。(デフォルト )	
sTCPでの通信を許可します。

UDP NDI 送出機器とのプロトコルをUDPに設定し
ます。	
UDP、sTCPでの通信を許可します。

	p NDI 送出側のプロトコル設定とのネゴシエーションに
より、もっとも上位のプロトコルが選択されます。

	p sTCP( シングル TCP)：コネクション型の通信方式
で、データが正確に届けられることが保証されている
半面、通信速度はUDPに比べて低速になります。

	p UDP：コネクションレス型の通信方式で、高速に	
データ転送ができますが、そのデータの信頼性は
TCPよりも低くなります。

	pマルチキャスト通信を行う場合はプロトコルの設定に
かかわらずUDPで動作します。

NOTE

入出力信号の設定
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NDI入力信号の情報表示

本機に入力されたNDI 信号のステータスが確認できます。
以下のメニューを表示します。

[10] Input >
	 INx > Status Information

本機ではNDI 入力信号の内容を自動判別し、以下の情報を
表示します。

Format 入力されているNDI 信号の映像フォーマット情
報を表示します。

Sampling 
Rate

入力されているNDI 信号のサンプルレート情報
を表示します。

Audio 
Channel

入力されているNDI 信号のサラウンド情報を表
示します。

Frame Data 入力されているNDI 信号の色情報を表示しま
す。

Codec 入力されているNDI 信号の圧縮形式情報を表示
します。

Streaming 
Mode

入力されているNDI 信号の圧縮形式情報を表示
します。

Level H.264/H.265の解像度やフレームレートの	
上限を示すレベルを表示します。NDI High 
Bandwidth のときには表示されません。

Status Detect：
本機のシステムフォーマットに適合した入力信
号フォーマットです。
Unsupported：
本機のシステムフォーマットに適合していない
入力信号フォーマットです。
Not Detect：
本機に映像信号が入力されていません。

素材名の設定（NDI入力信号）

入力信号に、素材名を付けることができます。
素材名は、デフォルト設定、またはユーザー設定から選択
することができます。

以下のメニュー操作で素材名の種類を選択します。

[10] Input >
	 INx > Name Type

Default
（デフォルト設定）

自動的に下記の素材名が選択されます。
IN1～ 9

User
（ユーザー設定）

32文字までで素材名を設定します。

<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

αチャンネル付き素材の入力設定

本機では、通常のNDI 信号と、αチャンネル付きの信号を
切り替えて素材として入力することができます。
αチャンネル付きのNDI 信号は1系統入力することが可能
です。IP モードの変更により最大２系統入力することが可
能です。αチャンネル設定を切り替えることにより、下の
表のように設定できます。

αチャンネル設定
無効 有効

IN6 Fill Fill
IN7 Fill Key
IN8 Fill Fill
IN9 Fill Key

	p IN6、IN7は IP モードがNDI HBの時のみ設定可能
です。

以下のメニュー操作でαチャンネルの有効 /無効を選択し
ます。

[10] Input >
	 INx > Alpha Setting > Use Alpha

グループの設定

NDI の sender/receiver がそれぞれ属するグループを設定
することで、機器探索時に探索対象となるグループを指定
することができます。
グループの指定は、カンマ区切りで複数の設定をすること
も可能です。
この機能は、NDI HX1では使用することはできません。

1	以下のメニュー操作でグループ探索機能の有効、無効を
選択します。

[10] Input >
	 INx > Group > Group

Enable グループ探索機能を有効にします。
Disable グループ探索機能を無効にします。（デフォルト）

2	以下のメニュー操作でグループ名称を入力します。

[10] Input >
	 INx > Group ＞Group Name

	p 64文字以内の文字列を入力することができます。
<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

入出力信号の設定
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Discovery Serverの設定

NDI 素材の自動探索機能を、外部サーバーが一元登録でき
るように設定することができます。
大量のNDI 素材がネットワーク上に存在していて、トラ	
フィックが増大することを避けたい場合や、マルチキャス
ト通信が不可能、または望ましくない場合にこの設定を行
うと効果的です。

1	以下のメニュー操作で外部サーバーを設定するかを選択
します。

[10] Input >
	 INx > Use Discovery server > 

Use Discovery server

Enable 外部サーバー設定を有効にします。
Disable 外部サーバー設定を無効にします。（デフォルト）

2	以下のメニュー操作で外部サーバーの IPアドレスを入力
します。

[10] Input >
	 INx > Use Discovery server > 

Discovery server IP

RTSP ポートの設定

接続するカメラのRTSPポート設定に合わせて、本機のポー	
トとリクエストURLを設定することができます。
この機能は、NDI HX1のときに有効になります。

1	以下のメニュー操作でカメラ設定に合わせたRTSPポー
ト番号を入力します。

[10] Input >
	 INx > RTSP > Port

	pポート番号10668、10669、10670は、使用す
ることができません。

2	以下のメニュー操作でカメラ設定に合わせたRequest 
URL を入力します。

[10] Input >
	 INx > RTSP > Request URL

	p 255文字以内の文字列で入力してください。
<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

3	Port、Request URL の入力後、以下のメニューで
OSD/TIMEダイヤル (Execute) を押すと、変更した設
定が反映されます。

[10] Input >
	 INx > RTSP > Connect

アナログオーディオ入力信号の設定

本機に入力できるアナログオーディオは L/Rの 2チャンネ
ルです。

1	以下のメニュー操作でアナログオーディオ入力を有効に
します。

[15] Ancillary/Audio >
	 Analog IN > Audio

Off アナログオーディオ入力を無効にします。
On アナログオーディオ入力を有効にします。

2	以下のメニュー操作でアナログオーディオ入力のレベル
を設定します。

[15] Ancillary/Audio >
	 Analog IN > Input Type

LINE ライン入力レベルに設定します。
MIC マイク入力レベルに設定します。

3	以下のメニュー操作でゲインを設定します。

[15] Ancillary/Audio >
	 Analog IN > Gain

	p –36～ 12dBの範囲で入力することができます。

4	以下のメニュー操作で遅延量を設定します。

[15] Ancillary/Audio >
	 Analog IN > Delay (ms)

	p 0～ 512 msの範囲で入力することができます。

入出力信号の設定
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出力信号の設定

使用可能な出力は以下のとおりです。

<出力 (共通 )>
論理出力名称 物理出力名称 制約
OUT1 SDI OUT1
OUT2 SDI OUT2
OUT3 HDMI OUT
OUT4 LAN SRT/RTMP/RTMPS/NDI
OUT5 LAN SRT/RTMP/RTMPS/NDI
OUT6 USB STREAM OUT UVC固定割付

出力信号を設定するときは、最初に以下のメニューで設定したい出力信号を選択してから行います。

[11] Output > 
	 OUT4 > Streaming Mode

[11] Output > 
	 OUT5 > Streaming Mode

本機では、ファームウェアを更新することにより、IP入力を拡張することができます。
その際、IPモードによっては IP出力にも制約が発生します。
SDI 出力OUT1～ 2、HDMI 出力OUT3、UVC出力OUT6に変更はありません。

IP モード名称 物理出力名称
Normal OUT4：SRT / RTMP / RTMPS / NDI

OUT5：SRT / RTMP / RTMPS / NDI
※工場出荷時はNormal モードのファームウェアです。

NDI HB OUT4：NDI
OUT5：無効

本機の IPモードを確認するには、以下のメニューを実行します。

[13] System >
	 IP Mode

	p現在の IPモード名称が確認できます。	
IP モードの変更は、USB Memory ＞ Load > Load Type の Update より可能です。

<出力信号別の設定一覧>

出力端子

設定メニューと本書のページ

Assign
SDI 

Output
HDMI 
Output

Down 
Converter

Scale
SRT 

Output
NDI 

Output
RTMP 
Output

UVC 
Output

P78 － P78 － P78 P79 P80 P82 P82
SDI OUT 1 ○ ○ － － － － － － －
SDI OUT 2 ○ ○ － － － － － － －
HDMI OUT ○ － ○ － ○ － － － －
IP(OUT4) ○ － － － － ○ ○ ○ －
IP(OUT5) ○ － － － － ○ ○ ○ －
UVC OUT ○ － － － － － － － ○

○：有効
－：無効

入出力信号の設定



78

出力信号のアサイン

各出力に、出力信号をアサインします。

以下のメニュー操作で出力信号の種類を設定します。

[11] Output >
	 OUTx > Assign

PGM スイッチャーの本線出力でワイプ、ミックス、
キーなどの効果がかかった映像を出力します。

PVW 次の操作を事前に確認できるプレビュー出力で
す。

CLN クリーン信号 (PGM信号からキーなどの効果を
除いた映像 )を出力します。

AUX1、
AUX2

2系統あるAUXバス (AUX1、AUX2) で選択
された信号を出力します。

MV マルチビューディスプレイ出力です。
複数の入力信号や出力信号を縮小して、1画面
に出力します。

KeyOut キー信号を出力します。
Still1、.
Still2

Still1、Still2 で選択された静止画の映像を出
力します。OUT4、5 (IP OUT1、2) のみ設定
できます。(NDI、SRT、 RTMP/RTMPS出力時)

HDMI出力の設定

HDMI 出力信号の設定をします。

1	以下のメニュー操作で出力信号の種類を設定します。

[11] Output >
	 OUT3 > Assign

 「出力信号のアサイン」参照

2	以下のメニュー操作で出力する映像の解像度を選択しま
す。

[11] Output >
	 OUT3 > Size

Auto HDMI 信号により出力先の機器情報を取得し、
最適な解像度で出力します。

XGA (1024 × 768) / 60 Hz
WXGA (1280 × 768) / 60 Hz
SXGA (1280 × 1024) / 60 Hz
WXGA+ (1680 × 1050) / 60 Hz
Native システムフォーマットと同一で出力します。

3	以下のメニュー操作で出力する色空間を設定します。

[11] Output >
	 OUT3 > Color

Auto HDMI 信号により出力先の機器情報を取得し、
最適な色空間で出力します。

RGB 色空間をRGB形式で設定します。
YUV444 色空間をY, Cb, Cr を 4:4:4で設定します。（水

平4ピクセルにつき、輝度成分と２つの色差成
分を各4ピクセルずつサンプルする方式）

YUV422 色空間をY, Cb, Cr を 4:2:2 で設定します。
（水平2ピクセルから色差信号を1ピクセル分
だけとる形式。輝度信号は1ピクセルごとにと
る。）

4	以下のメニュー操作でスケーリング方法を選択します。

[11] Output >
	 OUT3 > Scale

Fit-V 出力映像のアスペクト比を維持して、垂直解像
度に合わせて拡大または縮小します。
（映像のない部分には黒の映像を挿入します。は
み出した部分の映像は切り取ります。）

Fit-H 出力映像のアスペクト比を維持して、水平解像
度に合わせて拡大または縮小します。
（映像のない部分には黒の映像を挿入します。は
み出した部分の映像は切り取ります。）

Full（フル） 出力映像をシステムの解像度に合わせて拡大ま
たは縮小します。

Full80% システムの解像度の80%の大きさに合わせて、
出力映像を拡大または縮小します。

Full90% システムの解像度の90%の大きさに合わせて、
出力映像を拡大または縮小します。

	p Full、Full80%、Full90%では、アスペクト比は維持
されません。	
上下左右の拡大縮小率が異なります。

5	以下のメニュー操作で映像の動きを検出する感度を設定
します。

[11] Output >
	 OUT3 > Move Detect

1 静止画寄り
～ 	 ～
3 標準
～ 	 ～
5 動画寄り

入出力信号の設定
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SRT出力の設定

本機から出力できるSRT信号は最大2系統です。

SRT出力信号をアサインします。

1	以下のメニュー操作で出力信号の種類を設定します。

[11] Output >
	 OUTx > Assign

 「出力信号のアサイン」参照

2	以下のメニュー操作で接続方法を設定します。

[11] Output >
	 OUTx > Mode

Caller 配信先のサーバーURL、ポート番号を指定し、
本機から配信開始要求出す場合に指定します。

Listener 待ち受けポートを指定し、外部から配信を開始
する場合に指定します。

3	以下のメニュー操作でサーバーのURL、ポート、
Stream ID を設定します。(Caller の場合のみ )

[11] Output >
	 OUTx > Destination URL

[11] Output >
	 OUTx > Destination Port

[11] Output >
	 OUTx > Stream ID

Destination URL 接続先サーバーのURL
Destination Port 接続先サーバーのポート
Stream ID 接続先サーバーのStream ID

	p接続先サーバーのドメイン名解決には、DNSの設定が
必要です。

	p Destination URL は 1文字以上、254文字以内で設
定が可能です。

<Destination URL で使用可能な文字>
A～ Z、a～ z、0～ 9、-、 .

	p Stream ID は 512文字以内で設定が可能です。
<Stream ID で使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

4	以下のメニュー操作で待ち受けポートを設定します。
(Listener の場合のみ )

[11] Output >
	 OUTx > Port

	p一部使用できないポート選択時は、メッセージが表示
されます。

5	以下のメニュー操作でTTL/HOP Limit を設定します。

[11] Output >
	 OUTx > TTL/HOP Limit

6	以下のメニュー操作で映像が送信されてから受信側で再
生されるまでの時間を設定します。

[11] Output >
	 OUTx > Latency(ms)

	pネットワーク帯域によっては設定された時間が保証さ
れない場合もあります。

7	以下のメニュー操作で配信する映像の暗号化方式を設定
します。

[11] Output >
	 OUTx > Encryption

Disable 映像を暗号化せず配信します。
AES128 映像をAES-128方式で暗号化して配信します。
AES256 映像をAES-256方式で暗号化して配信します。

8	以下のメニュー操作で暗号化された映像を復号するため
のフレーズを設定します。

[11] Output >
	 OUTx > Passphrase

	p 10文字以上、79文字以内で設定が可能です。

9	下のメニュー操作で映像形式をH.264, H.265から選
択します。

[11] Output >
	 OUTx > Codec

:	�以下のメニュー操作で映像形式のビットレート制御方式
を設定します。

[11] Output >
	 OUTx > Rate Control Mode

CBR Target bit rate に設定したビットレートで配
信します。

VBR Max bit rate に設定したビットレートを上限
に、Target bit rate に設定したビットレート
に近づくよう配信します。
配信する映像によって実際のビットレートは変
化します。

;	�以下のメニュー操作で配信の目標ビットレートを設定し
ます。

[11] Output >
	 OUTx > Target bit rate

<	�以下のメニュー操作で配信の最大ビットレートを設定し
ます。(VBRの場合のみ )

[11] Output >
	 OUTx > Max bit rate

入出力信号の設定
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NDI出力信号の設定

本機から出力できるNDI 信号は、最大2系統です。
NDI HX信号の出力はできません。

NDI 信号は、1 系統につき High Bandwidth 1 系統と
Low Bandwidth 1 系統を常時出力します。

NDI HX

本機は NDI High Bandwidth 信号のみを出力し、NDI 
HX1/NDI HX2/NDI HX3の信号は出力できません。

NDI出力信号のアサイン

NDI 出力信号をアサインします。

以下のメニュー操作で出力信号の種類を設定します。

[11] Output >  
	 OUTx > Assign

 「出力信号のアサイン」参照

NDI出力信号の共通設定

本機では、NDI 受信機器から探索されるときに表示される
Machine Nameと Source Nameを文字列で設定できま
す。

1	以下のメニュー操作でNDI 受信機器側に表示される名称
を設定します。

[11] Output > 
	 OUTx > Machine Name

	p 20文字以内の文字列を入力することができます。

2	以下のメニュー操作でNDI 受信機器側に表示される名称
を設定します。

[11] Output > 
	 OUTx > Source Name

	p 32文字以内の文字列を入力することができます。
<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、-、 _

NDI送出プロトコルの設定

NDI 受信機器とのプロトコルを設定します。

1	以下のメニュー操作でNDI 受信機器とのプロトコルを設
定します。

[11] Output > 
	 OUTx > Protocol

TCP NDI 受信機器とのプロトコルをTCPに設定し
ます。（デフォルト）
sTCPでの通信を許可します。

UDP NDI 受信機器とのプロトコルをUDPに設定し
ます。
UDP、sTCPでの通信を許可します。

	p NDI 送出側のプロトコル設定とのネゴシエーションに
より、もっとも上位のプロトコルが選択されます。

	p sTCP( シングル TCP)：コネクション型の通信方式
で、データが正確に届けられることが保証されている
半面、通信速度はUDPに比べて低速になります。

	p UDP：コネクションレス型の通信方式で、高速に	
データ転送ができますが、そのデータの信頼性は
TCPよりも低くなります。

	pマルチキャスト通信を行う場合はプロトコルをUDP
に固定する必要があります。

NOTE

入出力信号の設定
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NDIマルチキャスト設定

NDI 受信機器に対してマルチキャスト配信を有効 /無効に
する設定を行います。
マルチキャスト配信を有効にした場合は、IP アドレス、サ
ブネットマスク、TTL/HOP Limit の設定に従い配信され
ます。
本機では、同一サブネット内でのマルチキャスト配信が可
能です。

1	以下のメニュー操作でマルチキャスト配信の有効、無効
を設定します。

[11] Output >  
	 OUTx > Multicast > Multicast

Enable NDI 受信機器へのマルチキャスト配信を有効に
します。

Disable NDI 受信機器へのマルチキャスト配信を無効に
します。（デフォルト）

2	以下のメニュー操作で IPアドレス、サブネットマスク、
TTLの設定をします。

[11] Output > 
	 OUTx > Multicast > IP Address

[11] Output > 
	 OUTx > Multicast > Subnet Mask

[11] Output > 
	 OUTx > Multicast > TTL/HOP Limit

NDIグループ設定

NDI の sender/receiver がそれぞれ属するグループを設定
することで、機器探索時に探索対象となるグループを指定
することができます。
グループの指定は、カンマ区切りで複数の設定をすること
も可能です。

1	以下のメニュー操作でグループ探索機能の有効、無効を
設定します。

[11] Output > 
	 OUTx > Group > Group

Enable グループ探索機能を有効にします。
Disable グループ探索機能を無効にします。（デフォルト）

2	以下のメニュー操作でグループ名称を入力します。

[11] Output > 
	 OUTx > Group > Group Name

	p 64文字以内の文字列を入力することができます。
<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

NDI Discovery Serverの設定

NDI 素材の自動探索機能を、外部サーバーが一元登録でき
るように設定することができます。
大量のNDI 素材がネットワーク上に存在していて、トラ	
フィックが増大することを避けたい場合や、マルチキャス
ト通信が不可能、または望ましくない場合にこの設定を行
うと効果的です。

1	以下のメニュー操作で外部サーバーの設定の有効、無効
を設定します。

[11] Output > 
	 OUTx > Use Discovery server > 

Use Discovery server

Enable 外部サーバー設定を有効にします。
Disable 外部サーバー設定を無効にします。（デフォルト）

2	以下のメニュー操作で外部サーバーの設定の IPアドレス
を入力します。

[11] Output > 
	 OUTx > Use Discovery server > 

Discovery server IP

入出力信号の設定
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RTMP/RTMPS出力の設定

本機から出力できるRTMP/RTMPS信号は最大2系統で
す。

RTMP/RTMPS出力信号をアサインします。

1	以下のメニュー操作で出力信号の種類を設定します。

[11] Output > 
	 OUTx > Assign

 「出力信号のアサイン」参照

2	以下のメニュー操作でサーバーのURL、Stream Key
を設定します。

[11] Output > 
	 OUTx > Server URL

[11] Output > 
	 OUTx > Stream Key

Server URL 接続先サーバーのURL
Stream Key 接続先サーバーのStream Key

	p接続先サーバーのドメイン名解決には、DNSの設定が
必要です。
	p Server URL は 1文字以上、254文字以内で設定が
可能です。
	p Stream Key は 512文字以内で設定が可能です。

<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

3	以下のメニュー操作で映像形式のビットレート制御方式
を設定します。

[11] Output > 
	 OUTx > Rate Control Mode

CBR Target bit rate に設定したビットレートで配
信します。

VBR Max bit rate に設定したビットレートを上限
に、Target bit rate に設定したビットレート
に近づくよう配信します。
配信する映像によって実際のビットレートは変
化します。

4	以下のメニュー操作で配信の目標ビットレートを設定し
ます。

[11] Output > 
	 OUTx > Target bit rate

5	以下のメニュー操作で配信の最大ビットレートを設定し
ます。(VBRの場合のみ )

[11] Output > 
	 OUTx > Max bit rate

UVC出力の設定

本機はUVC(USB Video Class)およびUAC(USB Audio 
Class) の出力に対応しています。
本機のUSB端子 (Type-C コネクター ) とコンピューター
を接続することにより、本機をWebカメラのように取り扱
うことができます。
本機とコンピューターとの接続には、USB3.0 に対応した
USBケーブルを使用してください。

UVC出力信号をアサインします。

1	以下のメニュー操作で出力信号の種類を設定します。

[11] Output > 
	 OUTx > Assign

 「出力信号のアサイン」参照

2	以下のメニュー操作で出力信号の解像度を設定します。

[11] Output > 
	 Mode

Normal 1080で出力します。
720p 720で出力します。

	pシステムフォーマットが720/59.94p、50pのとき
はこの項目はグレーアウトされ、720で出力します。

システムフォーマット設定変更で出力フォーマットを変
更した場合は、コンピューターのUVC映像を受信して
いるアプリの再立ち上げが必要です。

NOTE

入出力信号の設定
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入出力信号の設定

アナログオーディオ出力の設定

本機はヘッドホン端子 [ ] ( Φ 3.5 mm、ステレオミニジャック )を 1つ保有します。

アナログオーディオ出力信号をアサインします。

1	以下のメニュー操作で出力信号の種類を設定します。

[15] Ancillary/Audio >
	 Analog OUT > Assign

PGM 選択した素材のオーディオデータを出力します。
PVW
AUX1、2
CLN

2	モニター音量調整つまみで音量を調整します。	
以下のメニューで値が確認できます。

[15] Ancillary/Audio >
	 Analog OUT > Volume

3	モニター音量調整にかかわらず、アナログオーディオ出
力をミュートすることができます。	
以下のメニューで設定します。

[15] Ancillary/Audio >
	 Analog OUT > Mute

Off オーディオ出力をミュートしません。
On オーディオ出力をミュートします。

②で設定した音量値は変更されません。

SRT/RTMP/RTMPS信号の送信操作

SRT/RTMP/RTMPS信号は [STREAM] ボタンを使用して、開始および停止の操作を行います。

OFF

長押し (1秒 )
長押し (1秒 ) 長押し (1秒 )

単押し
単押し

単押し
On Air Stand by

OFF 電源ON時の初期状態です。信号の送信を行いま
せん。[STREAM] ボタンが消灯します。

Stand by 本モード用に設定した映像を送信します。
[STREAM] ボタンが緑色に点灯します。

On Air 本モード用に設定した映像を送信します。
[STREAM] ボタンが赤色に点灯します。

[SHIFT] ボタンを押すことにより操作対象が変更されます。

[SHIFT] を押さない IP OUT1
[SHIFT] を押す IP OUT2

以下のメニュー操作で IP OUT1/2 の状態を連動させるこ
とができます。

[11] Output >  
	 OUTx > Streaming Link

また、以下のメニュー操作でSRT/RTMP/RTMPS出力の
Stand by時の映像信号をアサインできます。

[11] Output >  
	 OUTx > Assign STDBY

 「出力信号のアサイン」参照
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以下のメニュー操作でSRT/RTMP/RTMPS出力を
Stand byからOn Airに切り替えるときのトランジション
効果を設定できます。

[5] Time >  
	 OUTx Trans > Transition

Off Stand by、On Air 切替時にカットトランジショ
ンを行います。

On Stand by、On Air 切替時にミックストランジ
ションを行います。

以下のメニュー操作でミックストランジション時の時間を
設定します。

[5] Time >  
	 OUTx Trans > Trans Time

 「オートトランジション」参照

入出力信号の設定
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同期信号の設定

入出力信号の設定

システムで使用する同期信号を選択します。
外部同期：
外部同期信号に同期します（ゲンロック）。
リファレンス入力信号は、ループスルー出力します。

BB ブラックバースト信号（垂直位相0H）
Tri-level 
sync

3値シンク信号（垂直位相0H）

Internal 内部基準信号（INT）に同期します。
2つのリファレンス端子からREFOUT信号 (ブ
ラックバースト信号 )は出力しません。

	p本機は、システムフォーマットと同じフィールド周波
数の同期信号に対応します。

1	以下のメニュー操作で同期信号を選択し、OSD/TIME
ダイヤルを押して、選択内容を確定します。

[13] System > 
	 Reference > Sync Select

2	以下のメニューには、ゲンロックの状態を表示します。

[13] System > 
	 Reference > Status

Locked 外部同期信号または内部基準信号に同期してい
ます。

UnLock 外部同期信号または内部基準信号に同期してい
ません。

出力信号の位相調整
出力ビデオ信号の位相を調整します。

1	以下のメニュー操作で“0H”または“1H”を選択します。

[13] System > 
	 Output Phase > System

0H システムのReference 信号に対して同相で出
力ビデオ信号を出力します。
すべての入力信号に対してフレームシンクロナ
イザー機能がON状態になります。

1H システムのReference 信号に対して1H遅れ
で出力ビデオ信号を出力します。
フレームシンクロナイザー機能がONのときは、
1フレーム+1H遅延したビデオ信号出力にな
ります。

2	以下のメニュー操作でH位相の調整をします。

[13] System > 
	 Output Phase > H-Phase

H-Phase は、-0.50H～ +0.49Hの範囲で調整するこ
とができます。
	pシステムフォーマットにより、メニューに表示される
設定値が異なります。

3	以下のメニュー操作でV位相の調整をします。

[13] System > 
	 Output Phase > V-Phase

V-Phase は、–100H ～ +100Hの範囲で調整するこ
とができます。
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AUXバス、PGM、PVWのアンシラリー設定
SDI/HDMI 入力信号のVアンシラリーデータ、およびエン
ベデッドオーディオデータを通過させる機能を設定します。

AUXバス（AUX1、AUX2）の出力信号に対する設定

1	以下のメニュー操作でOn/Off を選択します。

[15] Ancillary/Audio > 
	 Ancillary > AUX

Off AUX バス（AUX1、AUX2）出力のアンシラリー
データ、およびエンベデッドオーディオを通過
させません。

On AUXバス（AUX1、AUX2）出力のアンシラリー
データ、およびエンベデッドオーディオを通過
させます。

プログラム出力信号に対する設定

2	以下のメニュー操作でOn/Off を選択します。

[15] Ancillary/Audio > 
	 Ancillary > PGM

Off PGM出力のアンシラリデータ、およびエンベ
デッドオーディオを通過させません。

On PGM出力のアンシラリデータ、およびエンベ
デッドオーディオを通過させます。

プレビュー出力信号に対する設定

3	以下のメニュー操作でOn/Off を選択します。

[15] Ancillary/Audio > 
	 Ancillary > PVW

Off PVW出力のアンシラリーデータ、およびエン
ベデッドオーディオを通過させません。

On PVW出力のアンシラリーデータ、およびエン
ベデッドオーディオを通過させます。

クリーン出力信号に対する設定

4	以下のメニュー操作でOn/Off を選択します。

[15] Ancillary/Audio > 
	 Ancillary > CLN

Off CLN出力のアンシラリデータ、およびエンベ
デッドオーディオを通過させません。

On CLN出力のアンシラリデータ、およびエンベ
デッドオーディオを通過させます。

マルチビューディスプレイの出力信号に対する設定

5	以下のメニュー操作でPGM/PVW/Off を選択します。

[15] Ancillary/Audio > 
	 Ancillary > MV

PGM すべてのMV出力にPGMのアンシラリーデー
タ、およびエンベデッドオーディオを通過させ
ます。

PVW すべてのMV出力にPVWのアンシラリーデー
タ、およびエンベデッドオーディオを通過させ
ます。

Off すべてのMV出力でアンシラリーデータ、およ
びエンベデッドオーディオを通過させません。

	p KEYを合成した場合は、その音声も重畳されます。
	p VANCデータは、システムフォーマットと異なる	
フォーマットの入力信号の場合、通りません。

NOTE

入出力信号の設定
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エンベデッドオーディオ設定

入出力信号の設定

各入力信号のオーディオデータの付け替え機能、各出力信
号に対して通過させる機能、キー素材へのオーディオデー
タ付加機能を設定します。
本機能を有効にするには、各バスのアンシラリー設定を
ONにしてください。

各入力信号のオーディオデータの付け替え設定

1	以下のメニュー操作で各入力信号に対するオーディオデ
ータの付け替え、削除を設定します。

[15] Ancillary/Audio >
	 Audio Assign > Input Assign > INx

IN1 ～ 9の入力信号に対して、それぞれSDI IN1～ 4、
HDMI IN1～ 2、IP IN1～ 4、Analog IN、Off を選択
できます。

AUXバス (AUX1、AUX2) の出力信号に対するオーデ
ィオ設定

1	以下のメニュー操作でオーディオデータを通過させる入
力信号を設定します。

[15] Ancillary/Audio >
	 Audio Assign > Output Bus Assign > AUX1

[15] Ancillary/Audio >
	 Audio Assign > Output Bus Assign > AUX2

プログラム出力信号に対するオーディオ設定

2	以下のメニュー操作でオーディオデータを通過させる入
力信号を設定します。

[15] Ancillary/Audio >
	 Audio Assign > Output Bus Assign > PGM

プレビュー出力信号に対するオーディオ設定

3	以下のメニュー操作でオーディオデータを通過させる入
力信号を設定します。

[15] Ancillary/Audio >
	 Audio Assign > Output Bus Assign > PVW

クリーン出力信号に対するオーディオ設定

4	以下のメニュー操作でオーディオデータを通過させる入
力信号を設定します。

[15] Ancillary/Audio >
	 Audio Assign > Output Bus Assign > CLN

各出力信号に対して、入力信号は以下から一つだけ選択
できます。

IN1 ～ 9 各入力信号のエンベデッドオーディオを通過させ
ます。

Analog IN 音声入力端子のオーディオデータを通過させます。
Follow Video バスで選択された入力信号のエンベデッドオー

ディオを通過させます。
Off エンベデッドオーディオを通過させません。

各キー素材へのオーディオデータ付加設定

1	下のメニュー操作で各キー素材に対するオーディオデー
タの付加、削除を設定します。

[15] Ancillary/Audio >
	 Key1 Audio

[15] Ancillary/Audio >
	 Key2 Audio

On バックグラウンドに合成するキー素材のエンベ
デッドオーディオデータをミックスします。

Off バックグラウンドに合成するキー素材のエンベ
デッドオーディオデータをミックスしません。

アサイン状態の情報表示

各出力のオーディオデータのアサイン状態を確認できます。
以下のメニューを表示します。

[15] Ancillary/Audio >
	 Audio Output Status

Assign OUT 本機のアウトプット端子(OUT1～ 6, Analog 
OUT)にアサインされているバスを表示します。
[11] Output設定が一覧表示されます。

Output Bus 
Assign

本機の各バス(AUX1/2, PGM, PVW, CLN, 
MV)にアサインされているオーディオ入力を表
示します。
[15] Ancillary/Audio > Audio Assign > 
Output Bus Assign設定が一覧表示されます。
IN1～ 9が選択されている場合、Input Assign
で設定された情報も表示されます。
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画面レイアウトの設定

画面レイアウトは以下の10とおりの中から選択します。
本機のマルチビューディスプレイは、MVに対応しています。

4Split 5-aSplit 5-bSplit 6-aSplit 6-bSplit
9Split 10-aSplit 10-bSplit 12Split 16Split

子画面の1～16には、下記の信号の表示をアサインすることが可能です。

アサイン可能な信号
IN1 ～９、Black、CBGD1、CBGD2、CBAR、Still1V、Still1K、Still2V、Still2K、PGM、PVW、CLN、Key Out、AUX1、
AUX2、Clock、Analog IN、IP OUT1、IP OUT2*1

*1  IP OUT1(OUT4)、IP OUT2(OUT5) が SRTまたはRTMP/RTMPS設定時にステータスを表示します。
表示するビットレートは、映像のエンコードと異なり表示間隔を優先した算出を行っています。そのため出力設定と
差異のある値となることがあります。

1	以下のメニュー操作で分割の表示モードを設定します。

[9] MultiView >
	 Split

2	以下のメニュー操作で分割画面の大きさモードを設定します。

[9] MultiView >
	 Size

Fit 分割枠と分割画面の大きさは同じになります。
SQ 分割枠と分割画面の大きさは小さくなり、分割画面外側に素材名、レベルメーターなどを表示します。

3	以下のメニュー操作で子画面 (1～ 16) に表示する信号名を設定します。

[9] MultiView >
	 Source Select

	p入力信号 (IN1～ 9) を選択した場合は、以下のメニューで設定した素材名の表示は、文字や記号により異なります。

[10] Input >
	 INx > Name Type

[10] Input >
	 INx > Name

	p AUXバス (AUX1、AUX2) で入力信号を選択した場合は、[　　] 内の素材名の表示は、文字や記号により異なります。
	p“MV”を選択しているAUXバスをマルチビューディスプレイの子画面に選択すると、2枚の鏡を向かい合わせにした
ときのように映像がループします。
	p 720pでは、12分割が選択できません。

マルチビューディスプレイの設定
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<表示モード>

43

21
21

53 4 21

53 4
21

64 53 21

64 53

4Split 5-aSplit 5-bSplit 6-aSplit 6-bSplit

7 8 9

4 5 6

1 2 3
1

3 4 5 6

7 8 9 10

2

1

3 4 5 6

7 8 9 10

2

21

653 4 7

11108 9 12

1 2 3 4

5 6 7 8

9 10 11 12

13 14 15 16

9Split 10-aSplit 10-bSplit 12Split 16Split

マルチビューディスプレイの設定
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分割枠と文字の設定

マルチビューディスプレイに表示される分割画面の枠、文
字の輝度と背景の設定を行います。

1	以下のメニュー操作で分割枠の輝度および分割枠の表示
を設定します。

[9] MultiView > 
	 MV Frame

LUM0%、
LUM25%、
LUM50%、
LUM75%、
LUM100%

分割枠（グレースケール）の輝度を設定します。

Off 分割枠を表示しません。

2	以下のメニュー操作で文字の輝度および文字の表示を設
定します。

[9] MultiView > 
	 MV Character

LUM0%、
LUM25%、
LUM50%、
LUM75%、
LUM100%

文字（グレースケール）の輝度を設定します。

Off 文字を表示しません。
また、文字背景も表示しません。

3	以下のメニュー操作で文字背景 (ハーフトーン )の表示
を設定します。

[9] MultiView > 
	 MV Label

On 文字背景を表示します。
Off 文字背景を表示しません。

	p Fit のときに有効です。

タリー表示の設定

マルチビューディスプレイの分割枠に重ねるタリー表示の
設定を行います。
本機ではタリーグループを3つ設定でき、それぞれのグルー	
プに対して素材を設定できます。
マルチビューディスプレイではレッドタリー、グリーンタ
リー、イエロータリーの表示ができます。

1	以下のメニュー操作でレッドタリー、グリーンタリー、
イエロータリーに割り当てる素材を選択します。

[13] System > 
	 Tally Settings > Tally Target > Red Tally

[13] System > 
	 Tally Settings > Tally Target > Green Tally

[13] System > 
	 Tally Settings > Tally Target > Yellow Tally

Off 信号なし
PGM プログラム映像信号
PVW プレビュー映像信号
CLN クリーン信号
KeyOut キー出力信号
AUX1 AUX1バス出力信号
AUX2 AUX2バス出力信号
IP OUT1 IP OUT1出力信号
IP OUT2 IP OUT2出力信号、IPモードがNormal 以外

では非表示になります。

2	以下のメニューを表示します。

[9] MultiView > 
	 Red Tally

[9] MultiView > 
	 Green Tally

[9] MultiView > 
	 Yellow Tally

	p上記①で設定したレッドタリー、グリーンタリー、イ
エロータリーについてマルチビューディスプレイへの
表示設定ができます。

3	マルチビューディスプレイの分割枠に重ねるタリー表示
の設定を行います。

IN1

Box

Label Left Label Right

On タリー表示をします。
Off タリー表示をしません。

マルチビューディスプレイの設定
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素材名の変更（入力信号）

マルチビューディスプレイに設定する、入力信号 (IN1 ～
9) の素材名を変更します。
素材名は、デフォルト設定、またはユーザー設定から選択
することができます。

1	以下のメニュー操作で素材名の種類を選択します。

[10] Input > 
	 INx > Name Type

Default
（デフォルト設定）

自動的に下記の素材名が選択されます。
IN1～ 9

User
（ユーザー設定）

32文字までで素材名を設定します。

User タイプの設定方法

1	以下のメニュー操作で素材名の種類を“User”に設定し
ます。

[10] Input > 
	 INx > Name Type

2	以下のメニュー操作で素材名を入力します。

[10] Input > 
	 INx > Name

<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

素材名の変更（出力信号）

マルチビューディスプレイに設定する、出力信号（AUX1、
AUX2）の素材名を変更します。
素材名は、デフォルト設定、またはユーザー設定から選択
することができます。

以下のメニュー操作でAUX1、AUX2の素材名の種類を選
択します。

[12] Config > 
	 AUX Name > AUX1 Type

[12] Config > 
	 AUX Name > AUX2 Type

Default
（デフォルト設定）

自動的に下記の素材名が選択されます。
AUX1、AUX2

User
（ユーザー設定）

32文字までで素材名を設定します。

User タイプの設定方法

1	以下のメニュー操作で素材名の種類を“User”に設定し
ます。

[12] Config > 
	 AUX Name > AUX1 Type

[12] Config > 
	 AUX Name > AUX2 Type

2	以下のメニュー操作で素材名を入力します。

[12] Config > 
	 AUX Name > AUX1 Name

[12] Config > 
	 AUX Name > AUX2 Name

<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

レベルメーターの設 定

各分割画面上に、各入出力で伝送されるオーディオ信号の
レベルメーターを表示することができます。
左側の表示：	 グループ1の1 ch
右側の表示：	 グループ1の2 ch

以下のメニュー操作でレベルメーターの表示を設定します。

[9] MultiView > 
	 Display > Level Meter

OFF レベルメーターの表示をしません。
IN ON 入力信号 (音声入力端子含む )とカラーバーの

レベルメーターを表示します。
OUT ON PGM/PVW/CLN/AUXのレベルメーターを表

示します。
IN/OUT ON 入力信号 (音声入力端子含む )とカラーバー、

PGM/PVW/CLN/AUXのレベルメーターを表
示します。

マルチビューディスプレイの設定
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入力信号マークの設定

各分割画面に表示される素材名の先頭に、入力信号の状態
を表示することができます。
“F”マーク：
入力信号がフリーズ状態のとき。

“!”マーク：
入力信号がないときやフォーマットの異なる信号が入
力されているとき。
 �“F”マークが表示されているときは、“！”マークは
表示されません。

以下のメニュー操作で入力信号状態表示の設定を行います。

[9] MultiView > 
	 Display > Input Status

On 入力信号状態を表示します。
Off 入力信号状態を表示しません。

マーカーの設定

マルチビューの素材にセーフティマーカーを表示すること
ができます。

1	以下のメニュー操作でマーカー表示の設定を行います。

[9] MultiView > 
	 Display > Marker

4:3 4：3のアスペクト比でマーカーを表示します。
16:9 16：9のアスペクト比でマーカーを表示します。
Off マーカーを表示しません。

2	以下のメニュー操作でマーカーの大きさの設定を行いま
す。

[9] MultiView > 
	 Display > Marker Size

マルチビューディスプレイの設定
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システムの設定

システムフォーマットの設定
システムのフォーマット（入出力信号）を1つ選択します。

次の動作中には、フォーマットを変更しないでください。
	p USBメモリーからの読み込み中、またはUSBメモ	
リーへの保存中
	pビデオメモリーの復帰中、または内蔵ストレージへの
保存中
	p静止画の記録中

以下のメニュー操作でフォーマットを選択し、OSD/TIME
ダイヤルを押して選択内容を確定します。

[13] System > 
	 System Format

クロスポイントの設定

クロスポイントのアサイン

クロスポイントボタン1～ 12には、外部映像入力信号お
よび、内部発生信号をアサインすることができます。
クロスポイントボタン1～ 12を長押しすると、押してい
る間、アサイン状態がOSDメニュー出力先に表示されます。

現在クロスポイントボタンで選択されている信号のアサイ
ンを変更すると、変更に合わせてクロスポイントボタンの
点灯位置が変わります。このとき出力されている映像は変
わりません。

アサインされる素材は下記のようになります。

信号名
ディスプレイ

の表示
説明

IN1 ～ 9 IN1～ 9 入力1～9、
詳細な信号割り当ては「入力信号の
設定」参照

Black Black 内部発生信号（黒信号）

CBGD1、
CBGD2

CBGD1、
CBGD2

内部発生信号（カラーバックグラウ
ンド）

CBAR CBAR 内部発生信号（カラーバー）

Still1V、
Still1K、
Still2V、
Still2K

Still1V、
Still1K、
Still2V、
Still2K

静止画ビデオメモリー

CLN CLN CLN（AUXバスと内蔵ディスプレ
イの映像のみ）

KeyOut KeyOut KeyOut（AUX バスと内蔵ディス
プレイの映像のみ）

None None アサインなし

	p“None”がアサインされているボタンを押しても、映像
は切り替わりません。

デフォルトは下記の設定になります。

ボタン
ディスプレイ

の表示
ボタン

ディスプレイ
の表示

XPT1 IN1 XPT7 IN7

XPT2 IN2 XPT8 IN8

XPT3 IN3 XPT9 IN9

XPT4 IN4 XPT10 CBAR

XPT5 IN5 XPT11 CBGD1

XPT6 IN6 XPT12 CBGD2

クロスポイント切り替えの設定

クロスポイント切り替えのタイミングを設定します。
クロスポイントボタンと [Cut] ボタンの操作が対象になり
ます。

以下のメニュー操作で切り替えのタイミングを選択します。

[8] XPT Assign > 
	 Switch Timing

Any 最寄りのフィールドで切り替えます。ライブ用
途向きです。

Field1 フィールド1で切り替えます。編集用途向きで
す。

Field2 フィールド2で切り替えます。編集用途向きで
す。
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ボタンアサイン

ユーザーボタンの設定

メニュー項目で設定可能ないくつかの機能を、6つのユー
ザーボタン（U1～U6）にアサインすることができます。
各ユーザーボタンは、アサインされた機能がONの状態の
ときはアンバー色に点灯し、OFFの状態のときは消灯しま
す。ユーザーボタンを押すごとに機能のON/OFF が切り替
わります。

ユーザーボタン（U1～U6）にアサインされる機能は下記
のとおりです。

機能名称 機　能
Key1 PVW KEY1をプレビューに出力します。
Key2 PVW KEY2をプレビューに出力します。
GPII-EN GPI-In の有効 /無効を切り替えます。
GPIO-EN GPI-Out の有効 /無効を切り替えます。
AUX Trans AUXバストランジションの有効 /無効を切

り替えます。
AUX1 Trans AUX1 バストランジションの有効 / 無効を

切り替えます。
AUX2 Trans AUX2 バストランジションの有効 / 無効を

切り替えます。
Effect Dissolve エフェクトディゾルブのON/OFF を切り替

えます。

Capture Still1 AUX バス (AUX1、AUX2) の出力信号を
Still1 に素材として記録します。

Capture Still2 AUX バス (AUX1、AUX2) の出力信号を
Still2 に素材として記録します。

None 何も割り当てません。
Shot 	
Memory1 ～ 12

ショットメモリー1～12を呼び出します。

XPT Disable ショットメモリーXPT Disable の有効 /無
効を切り替えます。

■ デフォルト設定
ボタン 機能名称 ボタン 機能名称
U1 Key1 PVW U4 Shot Memory2
U2 Key2 PVW U5 Shot Memory3
U3 Shot Memory1 U6 Shot Memory4

<設定方法>
以下のメニュー操作でU1～U6ボタンにアサインする機
能を選択します。

[12] Config >
	 User Button > User 1

[12] Config >
	 User Button > User 2

[12] Config >
	 User Button > User 3

[12] Config >
	 User Button > User 4

[12] Config >
	 User Button > User 5

[12] Config >
	 User Button > User 6

システムの設定
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日付と時刻の設定
USBメモリーのタイムスタンプ、RTMPS出力時のサー	
バー認証に使用する日付と時刻を設定します。
USBメモリーを使用する場合、RTMPS出力機能を使用す
る場合は、必ず設定をしてください。

日付・時刻設定の方法を選択する

1	以下のメニュー操作で設定方法を選択します。

[13] System > 
	 Date/Time > Setting

Manual マニュアルで日付、時刻を入力します。
Auto NTPサーバーを使用して日付・時刻情報を取得

します。

2	以下のメニュー操作で本機を使用する地域に応じたタイ
ムゾーンを選択します。

[13] System > 
	 Date/Time > Time Zone

OSD/TIME ダイヤルを操作して、一覧から適切な地域
を選択します。

	pマニュアルで時刻情報を入力する場合、以下のメニュー
で日付と時刻を設定します。

日付を設定する

1	Date/Time ＞ Date Setting メニューでOSD/TIME
ダイヤルを押すごとに年・月・日を順に設定します。

[13] System > 
	 Date/Time > Date Setting

2	日を設定できる状態でOSD/TIMEダイヤルを押して、
年・月・日を確定します。

時刻を設定する

1	Date/Time ＞ Time Setting メニューでOSD/TIME
ダイヤルを押すごとに時・分・秒を順に設定します。

[13] System > 
	 Date/Time > Time Setting

2	秒を設定できる状態でOSD/TIMEダイヤルを押して、
時・分・秒を確定します。

	p NTPサーバーを使用して自動で時刻情報を取得する場合
は以下の設定を実行します。

1	以下のメニューでNTPサーバーの IPアドレスまたはホ
スト名を入力します。

[13] System > 
	 Date/Time > NTP Server Address

入力可能な文字数は、1～128文字です。
<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

2	以下のメニュー操作でNTPサーバーのポート番号を入
力します。

[13] System > 
	 Date/Time > NTP Port

設定可能範囲 0～ 65535
初期値 123

3	以下のメニュー操作でNTPサーバーから時刻を取得す
る間隔を選択します。
1～24時間で一時間単位で選択することができます。

[13] System > 
	 Date/Time > Adjust Interval

内蔵日付用電池について
時刻表示が「2020/01/01 00:00:00」の時は、内蔵日
付用電池が消耗しています。
内蔵日付用電池充電後、日付と時刻の設定を行ってくださ
い。

内蔵日付用電池を充電するには
本機の電源をONにして約3時間そのままの状態にしてく
ださい。
約6か月間時計設定を記憶します。

システムの設定
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ネットワークの設定
LAN経由で通信を行うためのネットワークの設定を行いま
す。
初期設定は、IP アドレス：192.168.0.8、サブネットマ
スク：255.255.255.0 です。
ホストコンピューター側の設定を初期設定に合わせてご使
用になる場合は、メニューでの設定は必要ありません。

IP アドレスの入力

以下のメニュー操作で IPアドレスを設定します。

[16] Network >
	 LAN > IP Address

サブネットマスクの入力

以下のメニュー操作でサブネットマスクを設定します。

[16] Network >
	 LAN > Subnet Mask

デフォルトゲートウェイの設定

以下のメニュー操作でデフォルトゲートウェイを設定しま
す。

[16] Network >
	 LAN > Default Gateway

MACアドレスを表示する

以下のメニューでMACアドレスが表示されます。

[16] Network >
	 LAN > MAC Address

DNSサーバーの設定

以下のメニュー操作で優先DNSサーバーおよび代替DNS
サーバーを設定します。

[16] Network >
	 Primary DNS > IP Address

[16] Network >
	 Secondary DNS > IP Address

	p SRTやRTMP/RTMPSでのドメイン名解決に必要です。
	p設定しない場合は、空白になります。

システムの設定



97

ボタンイルミネーションの設定

ボタンのイルミネーション

ボタン照明を常に点灯させることができます。
暗い場所で操作するときでも、ボタン周辺に印刷されてい
る文字が見やすくなります。

1	以下のメニュー操作で選択しているボタンの設定を行い
ます。

[12] Config > 
	 Button Illumination > Button Illumination > 

Lighting

80%～
150%

ボタンのイルミネーションを点灯させます。明
るさは80%～150%まで調整できます。

2	以下のメニュー操作でオフ時のボタンの設定を行います。

[12] Config > 
	 Button Illumination > Button Illumination > 

XPT Color

Input Color Group IN、Color Group Internal、
Color Group Still、Color Group Other の素
材ごとに [Color Group1] ～ [Color Group8]
を設定します。

Color 
Group1～ 8

8種類の任意の色を設定します。

3	以下のメニュー操作でボタンのイルミネーション [R]、
[G]、[B] の設定を行います。

[12] Config > 
	 Button Illumination > Button Color Group1

[12] Config > 
	 Button Illumination > Button Color Group2

[12] Config > 
	 Button Illumination > Button Color Group3

[12] Config > 
	 Button Illumination > Button Color Group4

[12] Config > 
	 Button Illumination > Button Color Group5

[12] Config > 
	 Button Illumination > Button Color Group6

[12] Config > 
	 Button Illumination > Button Color Group7

[12] Config > 
	 Button Illumination > Button Color Group8

4	以下のメニュー操作で、①で設定できない以下のボタン
照明を設定することができます。

[12] Config > 
	 Button Illumination > Button Illumination > 

Dimmer

USER1、USER2、USER3、ショットメモリーボタン、
SHIFT ボタン、MENUボタン

On ボタン照明を点灯します。
Off ボタン照明を消灯します。

システムの設定
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システムの設定

ステータス表示

アラーム状態の表示

本機の電源および、冷却ファンの異常状態（アラーム）を
OSDメニュー出力先に表示します。

以下のメニューを表示します。

[13] System >
	 Alarm > Power

[13] System >
	 Alarm > Fan

[13] System >
	 Alarm > Temperature

Power 項目には、電源の異常状態を表示します。
Fan項目には、冷却ファンの異常状態を表示します。
Temperature項目には、内部温度の異常状態を表示します。

No Alarm 異常なし
Alarm 異常あり

アラームメッセージ

アラームが発生した場合、OSDメニュー出力先にメッセー
ジを表示します。
このメッセージはOSDメニューを表示しているときのみ
表示します。

アラームメッセージ 異常の内容 動作

ALARM ! Fan 
Stop.

冷却ファンの停止
[OK] を押すと、アラー
ムメッセージが消えま
す。
�直ちに販売店に連絡
してください。

ALARM ! Power 
Stop.

電源電圧の低下

ALARM ! High 
temperature.

機器内部の温度が
上昇

バージョン情報の表示

本機のソフトウェアおよびハードウェアのバージョン情報
を表示します。

以下のメニューを表示します。

[13] System >
	 System Information

	p System Version 項目には、本機のシステムバージョン
が表示されます。
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初期化

設定データの初期化

設定データを初期状態に戻します。
設定データを初期化した場合、Still は消去されますが、内
蔵ストレージに保存されたプロジェクトファイルは消去さ
れません。

<初期化の対象から除外される内容>
	pメニューの下記項目

[13] System > 
	 Date/Time

[16] Network

1	以下のメニューでOSD/TIMEダイヤル (Execute) を押
して、初期化を行います。

[13] System > 
	 Initial > Initial Settings

2	初期化する場合は、OSD/TIMEダイヤルを操作して
“YES”を押します。
	p初期化しない場合は、OSD/TIME ダイヤルを操作し
て“NO”を押します。

工場出荷状態への初期化

本機の設定データ、ユーザーデータを工場出荷状態に戻し
ます。
工場出荷状態への初期化をした場合、ネットワーク設定、
Still、内蔵ストレージに保存されたプロジェクトファイル、
Still も消去されます。

<工場出荷状態への初期化の対象から除外される内容>
	pメニューの下記項目

[13] System > 
	 Date/Time > Date Setting

[13] System > 
	 Date/Time > Time Setting

[13] System > 
	 Date/Time > Time Zone

1	以下のメニューでOSD/TIMEダイヤル (Execute) を押
して、工場出荷状態への初期化を行います。

[13] System > 
	 Initial > Factory Default

2	初期化する場合は、OSD/TIMEダイヤルを操作して
"YES" を押します。
	p初期化しない場合は、OSD/TIMEダイヤルを操作し
て "NO" を押します。

フェーダーの初期化

フェーダーレバーを操作してトランジションを行う範囲を
初期化します。
フェーダーレバーを最後まで倒しているのに、トランジショ	
ンが最後まで完了しない場合に初期化を行ってください。

1	以下のメニューでOSD/TIMEダイヤル (Execute) を押
して、初期化を行います。

[13] System > 
	 Initial > Initial Fader

2	初期化する場合は、OSD/TIMEダイヤルを操作して
“YES”を押します。
	p初期化しない場合は、OSD/TIME ダイヤルを操作し
て“NO”を押します。

システムの設定
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本機は最大9台までのリモートカメラを LAN接続し、リモートコントロールすることが可能です。
接続できるリモートカメラ製品への対応については、下記WebサイトのAV-HSW10商品ページをご参照ください。
https://connect.panasonic.com/jp-ja/products-services_proav

■ 接続例

SDI/HDMI 映像信号

スイッチングハブ

LANケーブル

コンパクトライブスイッチャー
AV-HSW10

モニター1

モニター2

モニター モニター

LANケーブル

リモートカメラコントローラー

外部DC電源

外部DC電源

LAN端子

リモートカメラ（最大9台）

	p本機とリモートカメラの接続には、GbE対応のスイッチングハブとカテゴリー 5e以上のSTP LANケーブルを使用し
てください。
	pまた、本機とリモートカメラの IPアドレスは、同一サブネットになるようネットワーク設計してください。

リモートカメラ連携機能
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本機と接続したリモートカメラに対する制御機能は以下のとおりです。
	p IP アドレスの自動検出
	p本機のタリー状態に連動して接続されたリモートカメラのタリー制御が可能

リモートカメラとの接続設定

リモートカメラ接続端子の選択

以下のメニューからリモートカメラが接続されている入力
信号を選択します。

[10] Input

	p IN1 ～ 9の入力に対して以下のリモートカメラ設定が可
能です。

IPアドレスの設定

自動で設定する場合

接続されたリモートカメラに設定されている IPアドレスを
スキャンし、本機に設定することができます。

以下のメニュー操作で、接続されたリモートカメラの IPア
ドレスをスキャンします。

[10] Input >
	 INx > Camera Setting > Scan IP Address

	pスキャン結果が以下のメニューのリストに表示されます。

[10] Input > 
	 INx > Camera Setting > IP Address

	p“Select From List”と表示されたらOSD/TIMEダ
イヤルを操作し、IPアドレス項目で接続されているリ
モートカメラの IPアドレスを選択します。
	pリモートカメラの IPアドレスが検出できなかった場合
は、“Not Detected”と表示されます。
	p本機またはリモートカメラの IPアドレス設定を修正
し、重複しないように設定してください。
	pリモートカメラの IPアドレスが重複している場合
は、“Duplicate IP Address Detected. (ErrNo = 
–650)”のエラーメッセージが表示されます。

手動で設定する場合

接続されたリモートカメラに設定されている IPアドレスを
直接、本機に設定することができます。

以下のメニュー操作で、接続されたリモートカメラの IPア
ドレスを入力します。

[10] Input > 
	 INx > Camera Setting > Edit IP Address

リモートカメラのポート設定

以下のメニュー操作で接続されているリモートカメラの	
ポートを設定します。

[10] Input > 
	 INx > Camera Setting > Port

リモートカメラとの認証設定
1	以下のメニュー操作でリモートカメラとの認証に用いる
ユーザー名を設定します。

[10] Input > 
	 INx > Camera Setting > Edit User Name

2	以下のメニュー操作でリモートカメラとの認証に用いる
パスワードを設定します。

[10] Input > 
	 INx > Camera Setting > Edit Password

<使用可能な文字>
A～ Z、a～ z、0～ 9、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

リモートカメラ接続状況の確認
1	以下のメニューにはリモートカメラに設定されたカメラ
名称が表示されます。

[10] Input > 
	 INx > Camera Setting > Name

2	以下のメニューには、本機とリモートカメラの IP接続状
態が表示されます。

[10] Input > 
	 INx > Camera Setting > Network Status

No IP 
Address

Input メニューでカメラの IPアドレスが入力
されていません。

Now 
Checking…

本機とリモートカメラが通信中です。

Connected 本機とリモートカメラが接続されています。
Unauthorized 認証情報が未入力、または誤っています。
Not 
Connected

通信エラーが発生しています。

リモートカメラ連携機能
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リモートカメラのタリー制御設定

本機に接続されたリモートカメラの赤、緑、黄タリー制御を、
本機の赤、緑、黄タリー制御に連動させることができます。

1	以下のメニュー操作で本機の赤タリー制御とリモートカ
メラの赤タリー制御の連動を設定します。

[10] Input > 
	 INx > Camera Setting > Red Tally

Enable 連動します。
Disable 連動しません。

2	以下のメニュー操作で本機の緑タリー制御とリモートカ
メラの緑タリー制御の連動を設定します。

[10] Input > 
	 INx > Camera Setting > Green Tally

Enable 連動します。
Disable 連動しません。

3	以下のメニュー操作で本機の黄タリー制御とリモートカ
メラの黄タリー制御の連動を設定します。

[10] Input > 
	 INx > Camera Setting > Yellow Tally

Enable 連動します。
Disable 連動しません。

リモートカメラ連携機能
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GPI I/Oの設定
GPI ポートから制御を行う機能と、制御を有効にするかど
うかの設定をします。

1	以下のメニュー操作で各ポートから行う制御の有効 (On)
と無効 (Off) を設定します。

[12] Config > 
	 GPI > GPI-In Setting > GPI-In Enable

[12] Config > 
	 GPI > GPI-Out Setting > GPI-Out Enable

2	以下のメニュー操作でタリー通知するAUXバスを設定
します。

[12] Config > 
	 GPI > GPI-In Setting > AUX Sel

[12] Config > 
	 GPI > GPI-Out Setting > AUX Tly Sel

3	以下のメニュー操作でそれぞれのピン番号にアサインす
る機能を割り当てます。

[12] Config > 
	 GPI > GPI-In Port > Port1 Assign

[12] Config > 
	 GPI > GPI-In Port > Port2 Assign

[12] Config > 
	 GPI > GPI-In Port > Port3 Assign

[12] Config > 
	 GPI > GPI-In Port > Port4 Assign

[12] Config > 
	 GPI > GPI-In Port > Port5 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 1 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 2 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 3 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 4 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 5 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 6 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 7 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 8 Assign

 �「GPI Input ポートでの制御」と「GPI Output ポー
トからの出力」を参照

	p GPI-In Enable 項目（またはGPI-Out Enable 項目）
の設定は、ユーザーボタンにアサインすることができ
ます。
 「ユーザーボタンの設定」を参照

外部インターフェース
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	w GPI Input ポートでの制御

Assign 項目 アサインする機能 制御方法
KEY 1/2 ON トランジション部のKEY1、KEY2ボタン

接点入力で動作します。
（30 ms以上）

FTB ON トランジション部の FTBボタン
BKGD AUTO バックグラウンドが選択されているときのAUTOボタン
BKGD CUT バックグラウンドが選択されているときのCUTボタン
KEY1 AUTO キーが選択されているときのAUTOボタン
KEY1 CUT キーが選択されているときのCUTボタン
REC Still1 Still1 の記録
REC Still2 Still2 の記録

AUX XPT1～ 12 AUXバスを切り替えるクロスポイントボタン（1～12）
	�制御するAUXバス（AUX1、AUX2）をメニューで選択します。

RTly DSBL レッドタリー信号を出力しない

接点入力で有効になります。
（オープン状態で無効）

GTly DSBL グリーンタリー信号を出力しない
YTly DSBL イエロータリー信号を出力しない
AUXTly DSBL AUXのタリー信号を出力しない
No Assign アサインなし

	w GPI Output ポートからの出力

Assign 項目 アサインする機能 出力
KEY1 ON、KEY2 ON キー1、2のトランジションを開始

Low パルスを出力します。
（約50 ～ 60 ms）

FTB ON FTBのトランジションを開始
BKGD CUT バックグラウンドのカットトランジションを行ったとき
KEY1 CUT キー1のカットトランジションを行ったとき
BKGD AUTO バックグラウンドのオートトランジションが実行中

Low レベルを出力します。
KEY1 AUTO キー1のオートトランジションが実行中
RTly SDI IN1～ 4 SDI IN1～ 4のレッドタリー

タリー出力時に Lowレベルを出力し
ます。

RTly HDMI IN1、2 HDMI IN1、2のレッドタリー
RTly IP IN1～ 4 IP IN1～ 4のレッドタリー
GTly SDI IN1～ 4 SDI IN1～ 4のグリーンタリー
GTly HDMI IN1、2 HDMI IN1、2のグリーンタリー
GTly IP IN1～ 4 IP IN1～ 4のグリーンタリー
YTly SDI IN1～ 4 SDI IN1～ 4のイエロータリー
YTly HDMI IN1、2 HDMI IN1、2のイエロータリー
YTly IP IN1～ 4 IP IN1～ 4のイエロータリー
AUXTly SDI IN1～ 4 AUXバスで SDI IN1～ 4を選択しているとき *

選択中に Lowレベルを出力します。AUXTly HDMI IN1、2 AUXバスで HDMI IN1、2を選択しているとき *
AUXTly IP IN1～ 4 AUXバスで IP IN1～ 4を選択しているとき *
No Assign アサインなし

*：	 出力するAUXバス（AUX1、AUX2）をメニューで選択します。

外部インターフェース
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Com

GPI Out
ALARM Out

GPI Out、ALARM接続例
次の条件を守ってください。
耐圧：最大 DC 24 V
電流：最大 50 mA

AV-HSW10 （最大電圧 24 V）

タリーLED
（最大電流 50 mA）

Com

GPI In

+3.3 V

GPI In 接続例
接点入力を行ってください。

AV-HSW10

TALLY/GPI

12345

12 11 10

678

15 14 13 9

ピン番号 信号名
1 GPI-Out1

9 GPI-Out8
2 GPI-Out2

10 GPI-In1
3 GPI-Out3

11 GPI-In2
4 GPI-Out4

12 GPI-In3
5 GPI-Out5

13 GPI-In4
6 ALARM Out

14 GPI-In5
7 GPI-Out6

15 GPI-Com
8 GPI-Out7

LAN

本機とコンピューター、または本機と外部機器 *を接続します。
*：本機から外部機器を制御することができます。

	p LANケーブルは、カテゴリー 5e以上のストレートまたはクロスケーブル、STP(Shielded Twisted Pair)、最大
100 mを使用してください。

外部インターフェース
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外部パネルの制御

本機は、IPネットワークを介して接続した外部パネル (*) から以下の操作を行うことができます。
	p各バスの素材選択
	pビデオトランジションの実行
	pショットメモリーの再生
	p各バスのクロスポイント選択

*：�LAWO製 LBPシリーズに対応しています。LBPシリーズの設定や操作について、詳しくは LAWO社へお問い合わせ
ください。

準備

外部パネルを、LANケーブルで本機背面の LAN端子に接
続します。
最大20台の外部パネルを接続可能です。複数の外部パネ
ルを接続する場合はHUBを経由して接続します。

外部パネルと本機の電源ON/OFF について
各装置の電源ON/OFF、再起動をする場合は、以下の
点にご注意ください。

	p本機の再起動後、3分以上経過しても外部パネルと接
続できない場合は、外部パネルを再起動してください。

	p 本機の起動中に外部パネルの電源を切る場合は、以下の
項目を“Disable”に設定してから外部パネル電源を切
ってください。

[17] External Interfaces >
	 External Panel Information > Active

NOTE

外部パネルの設定

本機の下記設定を確認し、接続する外部パネルに設定を行
ってください。

	p以下の項目に設定されたアドレス値を、外部パネルが制
御対象とする機器の IPアドレスとして設定します。

[16] Network >
	 LAN > IP Address

	p以下の項目に設定されたポート番号を、外部パネルが制
御対象とする機器のポート番号として設定します。

[17] External Interfaces >
	 External Panel Information > Port No

その他、接続しているネットワーク環境に応じて、以下の
メニューからサブネットマスクやデフォルトゲートウェイ
の設定を行ってください。

[16] Network >
	 LAN > Subnet Mask

[16] Network >
	 LAN > Default Gateway

外部パネル接続時の本機の設定

受信ポート番号の設定

1	以下のメニュー操作で外部パネル機能の有効 /無効を設
定します。

[17] External Interfaces >
	 External Panel Information > Active

2	以下のメニュー操作で本機が使用する受信ポート番号を
設定します。

[17] External Interfaces >
	 External Panel Information > Port No

設定可能範囲 62000～ 65535
初期値 62010

外部インターフェース
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ショットメモリー再生対象設定

外部パネルからの操作により、本機のショットメモリー再
生を行うときの再生対象を設定します。

以下のメニュー操作でショットメモリーの再生対象を設定
します。

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

BKGD

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

Key1

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

Key2

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

AUX1

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

AUX2

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

CBGD

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

XPT

	p BKGD、Key、AUX、カラーバックグラウンド、クロス
ポイントを個別にOn/Off できます。

外部インターフェース
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バスID、ソースID一覧

外部パネルで操作を行うと、バス (Destination) に対して素材 (Source) を指定するクロスポイント設定コマンドが発行さ
れます。
本機は、外部パネルからクロスポイント設定コマンドを受信すると、コマンド内で指定されたバスと素材の組み合わせに応
じて、素材の選択やビデオトランジションの実行を行います。
本章では、本機が、各バス、各素材を特定するために使用する ID（番号）について記載します。

IDは、大きく分けて以下の２種類が存在します。

１）通常のバス ID、素材 ID
スイッチャーの内部バス（PGM、AUX1など）と、スイッチャーの素材（IN1、CBGD1、STILL1-V など）を指定
する IDです。
1～512の範囲の番号を使用します。

２）拡張バス ID、拡張素材 ID
ビデオトランジションやショットメモリーの再生に用いる IDです。
本機は、バスと素材に対して同じ拡張 IDが指定されたクロスポイント設定コマンドを受信すると、対応する機能を実行
します。
例えば、BKGD AUTOバス（ID:522）に対して、BKGD AUTO素材（ID:522）を指定するコマンドを受信すると、
AUTOトランジションが実行されます。
513～ 1024の範囲の番号を使用します。

実行可能な動作 指定するバス、素材
MEのキートランジション KEY1 AUTO、KEY2 AUTO
MEのキートランジション（CUT） KEY1 CUT、KEY2 CUT
MEの AUTOトランジション BKGD AUTO
MEの CUTトランジション BKGD CUT
ショットメモリーレジスタメモリーの再生 SHOTPLAY1～ SHOTPLAY12
各バスのクロスポイント選択 XPT1～ XPT12

	p LBPシリーズの各ボタン操作に IDを割り付ける方法について、詳しくは LAWO社にお問い合わせください。

外部インターフェース (ExtPanel) で用いる外部パネル (LAWO製 LBPシリーズ )の設定について
複数（2台以上）の外部パネルを接続する場合は、以下の点にご注意ください。

	p複数の外部パネルのコンフィギュレーションデータを作成するときは、同一の .snap ファイル内でデータを作成して
ください。

	p使用する外部パネルごとに、パラメーター設定は同一で名称のみ異なるルーターを設定してください。

上記の対応を取らずに複数の外部パネルで制御 IDの拡張バス ID/ 拡張ソース ID810～821(XPT1～ XPT12) の設定
を行うと、外部パネルが正常に動作しない場合があります。

NOTE

外部インターフェース
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バス ID
ID バス ID バス ID バス ID バス ID バス
1 PGM 112 - 152 - 160 MV-8 168 MV-16
2 PVW 113 AUX1 153 MV-1 161 MV-9 169 -
3 KEY1-F 114 AUX2 154 MV-2 162 MV-10 ⋮
4 KEY1-S 115 - 155 MV-3 163 MV-11 512 -
5 KEY2-F ⋮ 156 MV-4 164 MV-12
6 KEY2-S 149 - 157 MV-5 165 MV-13
7 - 150 VMEM-V 158 MV-6 166 MV-14
⋮ 151 VMEM-K 159 MV-7 167 MV-15

-: 未使用の ID

ソース ID
ID ソース ID ソース ID ソース ID ソース ID ソース
1 IN1 ⋮ ⋮ 201 PGM 232 IP OUT2
2 IN2 144 - 164 - 202 - 233 ―
3 IN3 145 CBGD1 165 MV 203 PVW ：
4 IN4 146 CBGD2 166 - 204 - 250 ―
5 IN5 147 CBAR ⋮ ⋮ 251 CLOCK
6 IN6 148 Black 170 - 226 ― 252 ―
7 IN7 149 STILL1V 171 Key Out 227 AUX1 ：
8 IN8 150 STILL1K 172 CLN 228 AUX2 512 ―
9 IN9 151 STILL2V 173 - 229 ―
10 Analog IN 152 STILL2K ⋮ 230 ―
11 - 153 - 200 - 231 IP OUT1

-: 未使用の ID

拡張バス ID
ID バス ID バス ID バス ID バス ID バス
513 - 522 BKGD AUTO 714 SHOTPLAY5 ⋮ 817 XPT8
514 KEY1 AUTO 523 BKGD CUT 715 SHOTPLAY6 809 - 818 XPT9
515 KEY2 AUTO 524 - 716 SHOTPLAY7 810 XPT1 819 XPT10
516 - ⋮ 717 SHOTPLAY8 811 XPT2 820 XPT11
517 - 709 - 718 SHOTPLAY9 812 XPT3 821 XPT12
518 KEY1 CUT 710 SHOTPLAY1 719 SHOTPLAY10 813 XPT4 822 -
519 KEY2 CUT 711 SHOTPLAY2 720 SHOTPLAY11 814 XPT5 ⋮
520 - 712 SHOTPLAY3 721 SHOTPLAY12 815 XPT6 1024 -
521 - 713 SHOTPLAY4 722 - 816 XPT7

-: 無効 ID(-1) を送信

拡張ソースID	
ID ソース ID ソース ID ソース ID ソース ID ソース
513 - 522 BKGD AUTO 714 SHOTPLAY5 ⋮ 817 XPT8
514 KEY1 AUTO 523 BKGD CUT 715 SHOTPLAY6 809 - 818 XPT9
515 KEY2 AUTO 524 - 716 SHOTPLAY7 810 XPT1 819 XPT10
516 - ⋮ 717 SHOTPLAY8 811 XPT2 820 XPT11

517 - 709 - 718 SHOTPLAY9 812 XPT3 821 XPT12
518 KEY1 CUT 710 SHOTPLAY1 719 SHOTPLAY10 813 XPT4 822 -
519 KEY2 CUT 711 SHOTPLAY2 720 SHOTPLAY11 814 XPT5 ⋮
520 - 712 SHOTPLAY3 721 SHOTPLAY12 815 XPT6 1024 -
521 - 713 SHOTPLAY4 722 - 816 XPT7

-: 未使用の ID

外部インターフェース
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External Control

＜概要＞
ネットワークに接続したシステムコントローラーやタリー
インターフェースなどの外部機器との間で、本機すべての
バスの素材切り替えや素材名情報の送受信ができます。
また、外部機器からのKey Signal Coupling 設定の切り替
えが可能です。
TSL UMD Protocol V5.0に対応した通信フォーマットで
タリー情報とSource ID 情報の送受信が可能です。
当社製品のリモートカメラコントローラーAW-RPシリー
ズと IP 接続することにより、AW-RPシリーズのカメラセ
レクトによる本機バスの素材切り替えや Tally 情報送信、
フォーカスアシストや素材名の取得が可能です。

	p制御バスの設定などは、AW-RPシリーズの取扱説明書を
参照してください。

＜準備＞
外部機器を LANケーブルで本機背面の LAN端子に接続し
ます。
本機は、20系統の接続 IP に対応しています。複数の外部
機器と接続する場合はHUBで分配して接続します。IP は
重複しないように設定してください。
本機のネットワーク設定は以下のメニューで確認します。

[16] Network >
	 LAN > IP Address

[16] Network >
	 LAN >  Subnet Mask

初期値は、IP Address："192.168.0.50"、
Subnet Mask："255.255.255.0" です。

＜設定＞
1	以下のメニュー操作でExternal Control 機能の有効 /
無効を設定します。

[17] External Interfaces >
	 External Control Switcher > Active

2	以下のメニュー操作でネットワークの設定をします。

[17] External Interfaces >
	 External Control Switcher > Port No

3	以下のメニュー操作でコマンド送信間隔の設定を行いま
す。

[17] External Interfaces >
	 External Control Switcher > Interval Time

4	以下のメニュー操作で送信元に対する変更通知送信の設
定を行います。

[17] External Interfaces >
	 External Control Switcher > Response

On 送信元に対して変更通知を送信する。
Off 送信元に対して変更通知を送信しない。

5	以下のメニュー操作で接続される外部機器の IPアドレス
を設定します。

[17] External Interfaces >
	 External Control AUX Panel > 

IP AddressXX

6	以下のメニュー操作で外部接続機器の受信ポート番号を
設定します。

[17] External Interfaces >
	 External Control AUX Panel > Port No

	pリモートカメラコントローラーAW-RPシリーズと接
続する場合は、60031に設定します。

7	TSL UMD Protocol V5.0 コマンドの	
DMSG-CONTROLパラメーターについて。
RHタリー出力時は、Red Tally の設定が出力されま
す。
TXTタリー出力時は、Green Tally の設定が出力さ
れます。
LHタリー出力時は、Yellow Tally の設定が出力され
ます。

8	素材名を変更させる場合は以下の項目を“User”に設定
しておく必要があります。

[10] Input >
	 INx > Name Type

＜コマンド仕様＞
AV-HSW10外部インターフェース通信プロトコル仕様書
を参照してください。

外部インターフェース
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ソフトパネル接続設定

本機では、ソフトウェアパネルAV-SF10をインストール
したPCを LAN接続することにより、本機の操作、設定を
リモート制御することができます。
ソフトウェアパネルとの認証を行うため、本機で認証情報
の設定を行います。

	pローカルPCにソフトウェアパネルをインストールする
には、AV-SF10の導入手順書を参照してください。

	pソフトウェアパネルの操作に関しては、AV-SF10の取
扱説明書を参照してください。

1	以下のメニューを実行し、ソフトウェアパネルとの認証
に用いるユーザー名を設定します。

[13] System >
	 User Auth > User Name

	pユーザー名は1文字以上、32 文字以内で設定が可能
です。

<ユーザー名で使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < >  /

2	以下のメニューを実行し、ソフトウェアパネルとの認証
に用いるパスワードを設定します。
	p認証パスワードは2回の入力が必要です。

[13] System >
	 User Auth > Password

	pパスワード は 1文字以上、32 文字以内で設定が可能
です。

<パスワードで使用可能な文字>
A～ Z、a～ z、0～ 9

EasyIP Setup Tool Plus接続設定

本機のネットワークに関する設定をMedia Production 
Suite や EasyIP Setup Tool Plus を使って行うことがで
きます。
Media Production Suite や EasyIP Setup Tool Plus
は以下のWebサイトからダウンロードして入手することが
できます。

日本語：https://panasonic.biz/cns/sav/
英語　：https://pro-av.panasonic.net/

詳細はMedia Production Suite や EasyIP Setup Tool 
Plus の Help ページで確認することができます。

	pソフトパネル接続時に設定する認証ユーザー名とパスワ
ードを設定してください。

1	以下のメニューを実行し、Media Production Suite や
EasyIP Setup Tool Plus からネットワーク設定の操作
を有効にする時間を設定します。

[13] System >
	 User Auth > EasyIP Setup Limit

20min Media Production Suite や EasyIP Setup 
Tool Plus でのネットワーク設定操作を、本機
起動後20分間のみ有効にします。

Unlimited Media Production Suite や EasyIP Setup 
Tool Plus でのネットワーク設定操作を、常時
有効にします。

EasyIP機器名称設定

Media Production Suite や EasyIP Setup Tool Plus
では本機の固有名称が表示されます。

1	以下のメニューを実行し、本機の名称を設定します。
初期値はAV-HSW10と設定されています。

[13] System >
	 Switcher Title

	p入力可能な文字数は1～20文字です。
<使用可能な文字>
A～ Z、a～ z、0～ 9、半角スペース、
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < >  /

外部インターフェース
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＜概要＞
本機には複数のカメラを接続し、切り替えて使用しますが、各カメラの色特性が異なると切り替え時に違和感があります。
そのため、各カメラ単体での調整を終えたあとに1台のマスターカメラの色特性にその他のカメラの合わせこみを行います。
本機能はこの色特性合わせを簡易化するため、本機で調整を行う手段を提供します。

自動色調整

＜設定＞
1	各カメラの機能を使用し、カメラ単体の調整を実施しま
す。本機の機能ではありません。ご使用の機器の取扱説
明書等をご確認ください。

2	マスターカメラを決め、マクベスチャートの24点を	
マーカーに合わせる、またはマーカーを合わせて記録し
ます。

	p本機能はマクベスチャートの利用を想定していますが、
その他のカラーチャートを使用することも可能です。

3	その他のカメラを順にマスターカメラと同様にマクベス
チャートの24点を合わせ、マスターカメラの記録を使
用し補正します。
	p抽出した24点同士の比較を行いパラメータの決定を
行いますが、補正処理の特性上完全に合致するもので
はありません。補正後の全体の誤差を最小にするよう
動作を行います。
	p撮影条件の変化などカメラの設定を再調整した場合は、
本機能を再度実施する必要があります。そのためカメ
ラの自動調整機能はOFFに設定することを推奨しま
す。
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マスターカメラの記録

1	以下のメニュー操作で対象の入力を選択します。

[19] Color Adjust > 
	 Target

2	以下のメニュー操作で対象の入力にマーカーを表示しま
す。

[19] Color Adjust > 
	 Marker

3	以下のメニュー操作でマーカーの位置を設定します。

[19] Color Adjust > 
	 Left

[19] Color Adjust > 
	 Top

[19] Color Adjust > 
	 Bottom

[19] Color Adjust > 
	 Right

[19] Color Adjust > 
	 Set capture points

Left 点を生成したい領域の左端を指定します。
Top 点を生成したい領域の上部を指定します。
Bottom 点を生成したい領域の下部を指定します。
Right 点を生成したい領域の右端を指定します。
Set capture 
points

指定した領域で横6×縦4の24点を生成しま
す。

 

Left, Top 

Bottom, Right 

4	以下のメニュー操作で各マーカーの位置を調整します。

[19] Color Adjust > 
	 Points > Point x

5	以下のメニュー操作でマーカー位置の色を記録する場所
を選択します。

[19] Color Adjust > 
	 Parameter No

6	以下のメニューでOSD/TIMEダイヤル (Execute) を押
すと、選択した場所に記録します。

[19] Color Adjust > 
	 Capture for Master

	pすでに記録がある場合は上書きします。

7	以下のメニュー操作で記録に名称を設定します。

[19] Color Adjust > 
	 Parameters > Parameter x > Name

	p 16文字以内の文字列を入力することができます。

その他のカメラの補正
1	以下のメニュー操作で対象の入力を選択します。

[19] Color Adjust > 
	 Adjust Target

2	マーカーを合わせます。
 「マスターカメラの記録」②～④を参照

3	以下のメニュー操作で補正の基準となるマスターカメラ
の記録を選択します。

[19] Color Adjust > 
	 Parameter No

4	以下のメニューでOSD/TIMEダイヤル (Execute) を押
すと、色調整を行います。

[19] Color Adjust > 
	 Adjust Target

	pこのとき [19] Color Corrector > Enable Color 
Adjust が自動的に“Enable”に変更されます。補正
を無効にしたい場合は、“Disable”に変更してくださ
い。

自動色調整
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保証とアフターサービス（よくお読みください）

故障・修理・お取扱い・メンテナンス
などのご相談は、まず、

お買い上げの販売店
へ、お申し付けください。

お買い上げの販売店がご不明の場合は、当社（裏表紙）までご連絡ください。
※ 内容により、お近くの窓口をご紹介させていただく場合がございますので、ご了承ください。

■	保証書
お買い上げ日・販売店名などの記入を必ずお確かめの上、お買い上げ
の販売店からお受け取りください。
内容をよくお読みいただいた上、大切に保管してください。
万一、保証期間内に故障が生じた場合には、保証書記載内容に基づき、
「無料修理」させていただきます。

保証期間：お買い上げ日から本体1年間

■	補修用性能部品 8年
当社では、ライブスイッチャーの補修用性能部品を、製造打ち切り後、
8年間保有しています。
※	�補修用性能部品とは、その製品の機能を維持するために必要な部品
です。

■	定期メンテナンス（保守・点検）
定期メンテナンス（保守・点検）は、お客様が安心して機器をご使用い
ただくために、定期的に必要なメンテナンスを行い、機器の機能を常
に良好な状態に維持するためのものです。
部品の摩耗、劣化、ゴミ、ほこりの付着などによる突発的な故障、ト
ラブルを未然に防ぐとともに、安定した機能、性能を維持するために、
定期メンテナンスのご契約を推奨いたします。

なお、メンテナンス実施の周期、費用につきましては、機器のご使用
状況、時間、環境などにより変化します。
定期メンテナンス（有料）についての詳しい内容は、お買い上げの販売
店にご相談ください。

修理を依頼されるとき

この取扱説明書を再度ご確認の上、お買い上げの販売店までご連絡くだ
さい。

■	保証期間中の修理は．．．
保証書の記載内容に従って、修理させていただきます。保証書をご覧
ください。

■	保証期間経過後の修理は．．．
修理により、機能、性能の回復が可能な場合は、ご希望により有料で
修理させていただきます。

ご連絡いただきたい内容

品　名 コンパクトライブスイッチャー

品　番 AV-HSW10

製造番号

お買い上げ日

故障の状況
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外形寸法図
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SHIFT
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SHIFT

SHIFT

B
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U
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B

LEVEL
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電源	 ：	DC ( ) 16 V 専用ACアダプター

消費電力	：	3.0 A (48 W)

 は安全項目です。

総合
動作周囲温度 0 ℃～ 40 ℃
動作周囲湿度 10 %～ 90 %（結露なきこと）
保存温度 0 ℃～ 40 ℃
保存湿度 10 %～ 90 %（結露なきこと）
質量 約1.8 kg
外形寸法
（幅×高さ×奥行き）

254 mm×67 mm×175 mm（突起部含まず）

映像系端子
〈SDI IN 1〉～	
〈SDI IN 4〉端子

4系統
	pコネクター：BNC× 4
	pフレームシンクロナイザー、簡易カラーコレクターを搭載しています。
	p〈SDI IN 1〉、〈SDI IN 2〉端子は、簡易フォーマットコンバーター、〈SDI IN 3〉、〈SDI IN 4〉
端子は、高性能フォーマットコンバーターを搭載しています。
※SDI IN 1 は HDMI IN 1 と排他です。

3G-SDI 3G-SDI、SMPTE424M準拠 （Level-A/Level-Bに対応）
	p 0.8 V [p-p] ± 10 %（75 Ω）
	p自動イコライザー100 m（ケーブル使用時）

HD-SDI HD-SDI、SMPTE292M準拠
	p 0.8 V [p-p] ± 10 %（75 Ω）
	p自動イコライザー100 m（ケーブル使用時）

〈HDMI IN 1〉、	
〈HDMI IN 2〉端子

2系統、HDMI1.4b対応
映像フォーマット入力：
720p/59.94 Hz、720p/50 Hz、1080i/59.94 Hz、1080i/50 Hz、
1080p/59.94 Hz、1080p/50 Hz、1080p/29.97 Hz、1080p/25 Hz、
1080p/24 Hz、1080p/23.98 Hz
PCフォーマット入力(解像度、垂直周波数60Hz）：
WSXGA+ (1680×1050、60 Hz)、SXGA (1280×1024、60 Hz)、
WXGA (1280×768、60 Hz)、XGA (1024×768、60 Hz)
モード：Full/Fit-H/Fit-V

	pコネクター：HDMI × 2
	pフレームシンクロナイザー、簡易カラーコレクターを搭載しています。
	p HDMI IN 端子は、スケーラー機能を搭載しています。
	p HDCPには対応していません。
※ HDMI IN 1はSDI IN 1と排他です。

〈SDI OUT 1〉、	
〈SDI OUT 2〉端子

2系統
	pコネクター：BNC× 2
	p PGM、PVW、CLN、MV、AUX1/2、Key Out を割り当てできます。

3G-SDI 3G-SDI、SMPTE424M準拠 （Level-A に対応）
	p 0.8 V [p-p] ± 10 %（75 Ω）

HD-SDI HD-SDI、SMPTE292M準拠
	p 0.8 V [p-p] ± 10 %（75 Ω）

定格
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〈HDMI OUT〉端子 1系統、HDMI1.4b 対応
	pコネクター：HDMI × 1
	pスケーラー機能を搭載しています。
モード：Fit-V、Fit-H、Full、Full-90%、Full-80%

	p PGM、PVW、CLN、MV、AUX1/2、Key Out を割り当てできます。

〈LAN〉端子 1000Base-T、AUTO-MDIX 対応（IP 信号伝送 /制御用）
	p接続ケーブル：LANケーブル (カテゴリー 5e以上 )、最大100 m、STP(Shielded 
Twisted Pair) ケーブルを推奨

	pコネクター：RJ-45

■ IP 入力信号
IN 6 ～ 9に割り当てられます。

	p IN 6、IN 7：NDI High Bandwidth/HX1/HX2/HX3、SRTから選択できます。*
	p IN 8、IN 9：NDI High Bandwidth	
NDI αチャンネル入力に対応しています。
* ファームウェアを更新し、IPモードを変更することで変更可能

■ IP出力信号
OUT 4、OUT 5 に割り当てられます。

	p OUT 4、OUT 5：NDI High Bandwidth、SRT、RTMP/RTMPSから選択できます。
	p PGM、PVW、CLN、MV、AUX1/2、Key Out、Still1、Still2 を割り当てできます。
	p NDI 出力は、i/p 変換機能を搭載しています。
	p出力可能フォーマット：	
1920× 1080/60fps、50fps、30fps、25fps、24fps	
1280× 720/60fps、50fps

〈USB〉端子 UVC/UAC出力用端子
OUT 6 に割り当てられます。

	pコネクター：USB3.2 Gen1 Type-C、USBバスパワー機能なし
	p PGM、PVW、CLN、MV、AUX1/2、Key Out を割り当てできます。
	pスケーリング機能、i/p 変換機能を搭載しています。
	p出力可能フォーマット：	
1920× 1080/60fps、50fps、30fps、25fps、24fps	
1280× 720/60fps、50fps、30fps、25fps、24fps

システムフォーマット 1080/59.94p、50p、29.97p、25p、24p、23.98p、59.94i、50i
720/59.94p、50p

信号処理 R:G:B 4:4:4 8bit / 4:2:2 10bit (HDMI のとき )

Y:Cb:Cr 4:2:2 8bit (NDI High Bandwidth、UVCのとき )

Y:Cb:Cr 4:2:0 8bit (NDI HX1/HX2/HX3、SRT、RTMP/RTMPSのとき )

Y:Cb:Cr 4:2:2 10bit

ME数 1ME

音声系端子
〈AUDIO IN〉端子 L/1、R/2の２系統

	pコネクター：ピンジャック
	p各出力へのエンベデッド機能を搭載しています。
	pディレイ /レベル調整機能を搭載しています。

〈AUDIO OUT〉端子 ヘッドホンモニター用端子
	pコネクター：Φ3.5 mm TRS
	p出力音量調整機能を搭載しています。

定格
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同期系端子
〈REF〉端子	
リファレンス入力

Genlock モード：BB( ブラックバースト )、Tri-level Sync、内部同期から選択
	p BBモード、Tri-level Sync モード時は、ループスルー出力します。
	pループスルー出力を使用しない場合は、75 Ωで終端してください。
	pコネクター：BNC× 2
	pシステムフォーマットと同じフィールド周波数に対応
	p 23.98 Hz および24 Hz 時は、Tri-level 入力または内部同期のみに対応

映像遅延時間 1ライン（H） フレームシンクロナイザーの設定が［Off］で、アップ /ダウンコンバーター
が動作していないとき

1フレーム（F） フレームシンクロナイザーの設定がオン、またはアップ /ダウンコンバーター
が動作しているとき

	p PinP、マルチビュー、ダウンコンバーター、HDMI IN/OUTを経由した場合、それぞれ最
大1フレームの遅延が加わります。

制御系端子
〈LAN〉端子 1000Base-T、AUTO-MDIX 対応（IP 制御用）

	p接続ケーブル：LANケーブル（カテゴリー5e）、最大100 m、STP(Shielded Twisted 
Pair) ケーブルを推奨

	pコネクター：RJ-45

〈TALLY GPI〉端子 INPUT：5 入力 汎用、フォトカプラー受け
OUTPUT：8 出力、Ｒ・Ｇ・Yタリー、汎用から選択
ALARM：1 出力、オープンコレクター出力（負論理）

	pコネクター：D-Sub 15pin

〈USB〉端子 	pコネクター：USB2.0、Type-A、USBバスパワー機能あり
USBメモリーを使用して、設定ファイル /Still データの保存 / 読み込み、ファームウェア	
アップデートを行います。

AC アダプター

定格入力	：	�AC ( ) 100 V – 240 V、	
50 Hz/60 Hz、1.6 A – 0.9 A

定格出力	：	DC ( ) 16 V、4.06 A

 は安全項目です。

定格
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セッティングメニュー一覧

No. サブメニュー 設定項目 設定値
1 WIPE 1 BKGD Pattern 設定範囲 各パターン選択（31ページ）

初期値 5

2 BKGD 
Transition

Direction 設定範囲 Normal, Reverse, N/R

初期値 Normal

Border 設定範囲
Border

On, Off
Width

0.1 ~ 100.0

初期値 Off 5.0

設定範囲
Soft

0.0 ~ 100.0

初期値 0.0

Border Color
設定範囲

Load

White, Yellow, Cyan, 
Green, Magenta, Red, 
Blue, Black Hue

0.0 ~ 359.9

初期値 White 0.0

設定範囲
Sat

0.0 ~ 100.0
Lum

0.0 ~ 108.0

初期値 0.0 100.0

Position 設定範囲
X-Position

–100.00 ~ 100.00
Y-Position

–100.00 ~ 100.00

初期値 0.00 0.00

3 Key1 Pattern 設定範囲 各パターン選択（36ページ）
初期値 5

4 Key1 
Transition

Type 設定範囲 MIX, WIPE

初期値 MIX

Keyout Pattern 設定範囲 Normal, Reverse

初期値 Normal

Position 設定範囲
X-Position

–100.00 ~ 100.00
Y-Position

–100.00 ~ 100.00

初期値 0.00 0.00

2 CBGD 1 CBGD Select 設定範囲 CBGD1, CBGD2

初期値 CBGD1

2 CBGD Main Load 設定範囲 White, Yellow, Cyan, Green, Magenta, Red, Blue, Black

初期値 Blue, Red

Hue 設定範囲 0.0 ~ 359.9

初期値 120.0, 0.0

Sat 設定範囲 0.0 ~ 100.0

初期値 100.0

Lum 設定範囲 0.0 ~ 108.0

初期値 100.0

3 CBGD Sub Load 設定範囲 White, Yellow, Cyan, Green, Magenta, Red, Blue, Black

初期値 White

Hue 設定範囲 0.0 ~ 359.9

初期値 0.0

Sat 設定範囲 0.0 ~ 100.0

初期値 0.0

Lum 設定範囲 0.0 ~ 108.0

初期値 100.0

4 CBGD Wash Wash 設定範囲 On, Off

初期値 Off

Color 設定範囲 Dual, Rainbow

初期値 Dual

Rainbow Sat 設定範囲 0.0 ~ 100.0

初期値 100.0

Rainbow Lum 設定範囲 0.0 ~ 108.0

初期値 100.0
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No. サブメニュー 設定項目 設定値
2 CBGD 5 CBGD Wave Pattern 設定範囲 Sine, Saw

初期値 Sine

Cycle 設定範囲 0.0 ~ 100.0

初期値 0.0

Phase 設定範囲 –180.0 ~ 180.0

初期値 0.0

Angle 設定範囲 0.0 ~ 360.0

初期値 0.0

6 CBGD Move Move 設定範囲 Off, Roll, Rotation

初期値 Off

Speed 設定範囲 –50.0 ~ 50.0

初期値 1.0

3 Key 1 Key Select 設定範囲 Key1, Key2

初期値 Key1

2 Key Type 設定範囲 Lum (ChromaOff), Lum (ChromaOn), Linear, Chroma, Full

初期値 Linear

3 Fill 設定範囲 Bus, Matte

初期値 Bus

4 PVW 設定範囲 Off, On

初期値 Off

5 Key Adjust Clip 設定範囲 0.0 ～ 108.0

初期値 0.0

Gain 設定範囲 0.0 ～ 200.0

初期値 100.0

Density 設定範囲 0.0 ～ 100.0

初期値 100.0

Invert 設定範囲 On, Off

初期値 Off

6 Fill Matte Load 設定範囲 White, Yellow, Cyan, Green, Magenta, Red, Blue, Black

初期値 White

Hue 設定範囲 0.0 ~ 359.9

初期値 0.0

Sat 設定範囲 0.0 ~ 100.0

初期値 0.0

Lum 設定範囲 0.0 ~ 108.0

初期値 100.0

7 Edge Type 設定範囲 Off, Border, Drop, Shadow, Outline

初期値 Off

Width 設定範囲 0 ~ 4

初期値 2

Direction 設定範囲 0, 45, 90, 135, 180, 225, 270, 315

初期値 0

Density 設定範囲 25%, 50%, 75%, 100%

初期値 100%

Fill 設定範囲 Color, CBGD1, CBGD2, Still1, Still2

初期値 Color

Color
設定範囲

Load

White, Yellow, Cyan, 
Green, Magenta, Red, 
Blue, Black Hue

0.0 ~ 359.9

初期値 Black 0.0

設定範囲
Sat

0.0 ~ 100.0
Lum

0.0 ~ 108.0

初期値 0.0 0.0

セッティングメニュー一覧
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No. サブメニュー 設定項目 設定値
3 Key 8 Mask Size 設定範囲 Off, Manual, 4:3

初期値 Off

Invert 設定範囲 On, Off

初期値 Off

Position 設定範囲
Left

–50.00 ~ 50.00
Top

–50.00 ~ 50.00

初期値 –25.00 25.00

設定範囲
Bottom

–50.00 ~ 50.00
Right

–50.00 ~ 50.00

初期値 –25.00 25.00

9 PinP PinP 設定範囲 On, Off

初期値 Off

Shape 設定範囲 Square, Circle, Heart, Flower, Star

初期値 Square

Density 設定範囲 0.0~100.0

初期値 100.0

Full Key 設定範囲 On, Off

初期値 On

Border 設定範囲
Border

Off, On
Width

0.1~100.0

初期値 Off 5.0

設定範囲
Soft

0.0~100.0
Mode

Fix, Variable

初期値 0.0 Fix

設定範囲

Color

Load
White, Yellow, Cyan, Green, Magenta, Red, 
Blue, Black

初期値 Black

設定範囲
Hue

0.0 ~ 359.9

初期値 0.0

設定範囲
Sat

0.0 ~ 100.0

初期値 0.0

設定範囲
Lum

0.0 ~ 108.0

初期値 0.0

Position 設定範囲 X- 
Position

–100.00 ~ 100.00 Y- 
Position

–100.00 ~ 100.00

初期値 0.00 0.00

設定範囲
Size

0.00 ~ 100.00

初期値 25.00

Trim 設定範囲
Trim

Off, On
Pair

Off, On

初期値 Off Off

設定範囲
Preset

16:9, 12:9, 9:9, 7:9, 6:9, Manual

初期値 16:9

設定範囲

Adjust

Left
–50.00 ~ 50.00

初期値 –50.00

設定範囲
Top

–50.00 ~ 50.00

初期値 50.00

設定範囲
Bottom

–50.00 ~ 50.00

初期値 –50.00

設定範囲
Right

–50.00 ~ 50.00

初期値 50.00

Sync
設定範囲

Symmetry
Off, X, Y, Center, 
Same Copy to 

KEY

Execute

初期値 Off

10 Key Signal 
Coupling

設定範囲 Coupling, Independent

初期値 Coupling

11 Key Priority Key 設定範囲 1st, 2nd

初期値 2nd

セッティングメニュー一覧
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No. サブメニュー 設定項目 設定値
4 ChromaKey 1 Marker 設定範囲 On, Off

初期値 Off

2 Sample 設定範囲 Execute

初期値 Execute

3 Marker 
Position

X-Position 設定範囲 –50.00 ~ 50.00

初期値 0.00

Y-Position 設定範囲 –50.00 ~ 50.00

初期値 0.00

Size 設定範囲 1.00 ~ 80.00

初期値 10.00

4 Marker Aspect 設定範囲 –50.00 ~ 50.00

初期値 0.00

5 Ref Adjust Hue 設定範囲 0.0 ~ 359.9

初期値 354.0

Sat 設定範囲 0.0 ~ 100.0

初期値 100.0

Lum 設定範囲 0.0 ~ 108.0

初期値 7.00

6 Y-Influence 設定範囲 0.0 ~ 100.0

初期値 0.0

7 Radius Hue 設定範囲 0.0 ~ 100.0

初期値 100.0

Sat 設定範囲 0.0 ~ 100.0

初期値 50.0

8 Soft 設定範囲 0.0 ~ 100.0

初期値 0.0

9 Cancel 設定範囲 0.0 ~ 100.0

初期値 0.0

セッティングメニュー一覧
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No. サブメニュー 設定項目 設定値
5 Time 1 BKGD 設定範囲 0 ~ 999 (Frame)

初期値 1s00f

2 Key1 設定範囲 0 ~ 999 (Frame)

初期値 1s00f

3 Key2 設定範囲 0 ~ 999 (Frame)

初期値 1s00f

4 FTB Trans Time 設定範囲 0 ~ 999 (Frame)

初期値 1s00f

Source 設定範囲 Still1, Still2, CBGD1, CBGD2, White, Black

初期値 Black

Mute 設定範囲 Off, On

初期値 Off

5 Effect Dissolve 設定範囲 0 ~ 999 (Frame)

初期値 1s00f

6 AUX1 Bus 
Trans

Transition 設定範囲 Off, On

初期値 Off

Trans Time 設定範囲 0 ~ 999 (Frame)

初期値 1s00f

7 AUX2 Bus 
Trans

Transition 設定範囲 Off, On

初期値 Off

Trans Time 設定範囲 0 ~ 999 (Frame)

初期値 1s00f

8 OUT4(IP 
OUT1) Trans

Transition 設定範囲 Off, On

初期値 Off

Trans Time 設定範囲 0 ~ 999 (Frame)

初期値 1s00f

9 OUT5(IP 
OUT2) Trans

Transition 設定範囲 Off, On

初期値 Off

Trans Time 設定範囲 0 ~ 999 (Frame)

初期値 1s00f

6 Still 1 Still Select 設定範囲 Still1, Still2

初期値 Still1

2 Key Status 設定範囲 On, Off

初期値 –

3 Capture 設定範囲 Execute

初期値
4 Capture 

Setting
Video 設定範囲 AUX1, AUX2

初期値 AUX1

Key Enable 設定範囲 On, Off

初期値 On

Key 設定範囲 AUX1, AUX2

初期値 AUX1

Review 設定範囲 On, Off

初期値 On

5 Test Pattern Load 設定範囲 Execute

初期値

セッティングメニュー一覧
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No. サブメニュー 設定項目 設定値
7 Shot Memory 1 Target Select BKGD 設定範囲

Target
On, Off

XPT
On, Off

初期値 On On

Key1 設定範囲
Target

On, Off
XPT

On, Off

初期値 On On

Key2 設定範囲
Target

On, Off
XPT

On, Off

初期値 On On

AUX1 設定範囲 On, Off

初期値 On

AUX2 設定範囲 On, Off

初期値 On

CBGD 設定範囲 On, Off

初期値 On

2 Effect 設定範囲 Cut, Dissolve

初期値 Dissolve

3 Hue Path 設定範囲 Short, Long, CW, CCW

初期値 Short

4 XPT Disable 設定範囲 Off, On

初期値 Off

セッティングメニュー一覧
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セッティングメニュー一覧

No. サブメニュー 設定項目 設定値
8 XPT Assign 1 XPT1

設定範囲
IN1 ~ 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

初期値 IN1

2 XPT2
設定範囲

IN1 ~ 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

初期値 IN2

3 XPT3
設定範囲

IN1 ~ 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

初期値 IN3

4 XPT4
設定範囲

IN1 ~ 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

初期値 IN4

5 XPT5
設定範囲

IN1 ~ 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

初期値 IN5

6 XPT6
設定範囲

IN1 ~ 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

初期値 IN6

7 XPT7
設定範囲

IN1 ~ 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

初期値 IN7

8 XPT8
設定範囲

IN1 ~ 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

初期値 IN8

9 XPT9
設定範囲

IN1 ~ 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

初期値 IN9

10 XPT10
設定範囲

IN1 ~ 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

初期値 CBAR

11 XPT11
設定範囲

IN1 ~ 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

初期値 CBGD1

12 XPT12
設定範囲

IN1 ~ 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

初期値 CBGD2

13 Switch Timing 設定範囲 Any, Field1, Field2

初期値 Any
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セッティングメニュー一覧

No. サブメニュー 設定項目 設定値
9 MultiView

**********: 
現在設定されてい
る素材名

1 Split
設定範囲

4Split, 5-aSplit, 5-bSplit, 6-aSplit, 6-bSplit, 9Split, 10-aSplit, 
10-bSplit, 12Split, 16Split

初期値 10-aSplit

2 Size 設定範囲 Fit, SQ

初期値 SQ

3 Source Select Pos1 Source

設定範囲

IN1 ～ 9 (**********),
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 PGM

Pos2 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 PVW

Pos3 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 IN1

Pos4 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 IN2

Pos5 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 IN3

Pos6 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 IN4

Pos7 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 IN5

Pos8 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 IN6

Pos9 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 IN7

Pos10 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 IN8

※ IPモードがNormal 以外の場合、IP OUT2は非表示です。
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No. サブメニュー 設定項目 設定値
9 MultiView

**********: 
現在設定されてい
る素材名

3 Source Select Pos11 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 IN9

Pos12 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 Still1V

Pos13 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 Still2V

Pos14 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 CBAR

Pos15 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 CBGD1

Pos16 Source

設定範囲

IN1 ～ 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog IN, 
IP OUT1, IP OUT2※

初期値 CBGD2

4 MV Frame 設定範囲 LUM0%, LUM25%, LUM50%, LUM75%, LUM100%, Off

初期値 LUM75%

5 MV Character 設定範囲 LUM0%, LUM25%, LUM50%, LUM75%, LUM100%, Off

初期値 LUM75%

6 MV Label 設定範囲 On, Off

初期値 On

7 Red Tally Box 設定範囲 On, Off

初期値 Off

Label Left 設定範囲 On, Off

初期値 Off

Label Right 設定範囲 On, Off

初期値 Off

8 Green Tally Box 設定範囲 On, Off

初期値 Off

Label Left 設定範囲 On, Off

初期値 Off

Label Right 設定範囲 On, Off

初期値 Off

※ IPモードがNormal 以外の場合、IP OUT2は非表示です。

セッティングメニュー一覧
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セッティングメニュー一覧

No. サブメニュー 設定項目 設定値
9 MultiView 9 Yellow Tally Box 設定範囲 On, Off

初期値 Off

Label Left 設定範囲 On, Off

初期値 Off

Label Right 設定範囲 On, Off

初期値 Off

10 Display Level Meter 設定範囲 OFF, IN ON, OUT ON, IN/OUT ON

初期値 OFF

Input Status 設定範囲 On, Off

初期値 On

Marker 設定範囲 4:3, 16:9, Off

初期値 Off

Marker Size 設定範囲 80 ～ 100%

初期値 95%
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セッティングメニュー一覧

上位階層
No. サブメニュー 設定項目 設定値

10 Input 1 IN1(SDI1/
HDMI1)

表示のみ
次の階層のた
めのメニュー

下位階層A に移行

2 IN2(SDI IN2)

3 IN3(SDI IN3)

4 IN4(SDI IN4)

5 IN5(HDMI IN2)

6 IN6(IP IN1) 下位階層B に移行
7 IN7(IP IN2)

8 IN8(IP IN3)

9 IN9(IP IN4)

下位階層 A
No. サブメニュー 設定項目 設定値

SDI1/HDMI1 1 SDI/HDMI 設定範囲 SDI, HDMI

初期値 SDI

SDI IN XX 2 Status 
Information

Format

表示のみAudio

Status

3 FS Mode 設定範囲 Off, Normal, Auto

初期値 Auto

4 FS Delay
設定範囲

0F ~ 6F
・SDI IN1は 0F～ 2F

初期値 0F

5 Freeze 設定範囲 Disable, Enable

初期値 Disable

6 Freeze Select 設定範囲 Frame, Field

初期値 Frame

7 Name Type 設定範囲 Default, User

初期値 Default

8 Name 設定範囲 32文字まで設定可能
初期値

9 Up/Down 
Converter

Move Detect 設定範囲 1 ~ 5

初期値 5

Sharp 設定範囲 1 ~ 5

初期値 3

10 Color Correct C/C 設定範囲 On, Off

初期値 Off

C/C Process 設定範囲
Y-Gain

0.0 ~ 200.0
Pedestal

–20.0 ~ 20.0

初期値 100.0 0.0

設定範囲
C-Gain

0.0 ~ 200.0
Hue

0.0 ~ 359.9

初期値 100.0 0.0
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セッティングメニュー一覧

No. サブメニュー 設定項目 設定値
SDI IN XX 11 Camera 

Setting
IP Address 設定範囲 IP Address選択

初期値
Port 設定範囲 1 ~ 65535

初期値 80

Edit IP Address 設定範囲 Execute

初期値
Scan IP Address 設定範囲 Execute

初期値
Edit User Name 設定範囲

初期値
Edit Password 設定範囲 ********

初期値
Name 設定範囲 カメラに登録された名前

初期値
Network Status

設定範囲
No IP Address, Now Checking…, Connected, Unauthorized, Not 
Connected

初期値 No IP Address

Red Tally 設定範囲 Disable, Enable

初期値 Enable

Green Tally 設定範囲 Disable, Enable

初期値 Enable

Yellow Tally 設定範囲 Disable, Enable

初期値 Enable

HDMI IN XX 2 Status 
Information

Size

表示のみ

Dot Clock

H-Frequency

V-Frequency

Status

3 Freeze 設定範囲 Disable, Enable

初期値 Disable

4 Freeze Select 設定範囲 Frame, Field

初期値 Frame

5 Limited 設定範囲 On, Off

初期値 Off

6 Name Type 設定範囲 Default, User

初期値 Default

7 Name 設定範囲 32文字まで設定可能
初期値

8 Scale 設定範囲 Fit-V,Fit-H,Full

初期値 Full

9 Color Correct C/C 設定範囲 On, Off

初期値 Off

C/C Process 設定範囲
Y-Gain

0.0 ~ 200.0
Pedestal

–20.0 ~ 20.0

初期値 100.0 0.0

設定範囲
C-Gain

0.0 ~ 200.0
Hue

0.0 ~ 359.9

初期値 100.0 0.0
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セッティングメニュー一覧

No. サブメニュー 設定項目 設定値
HDMI IN XX 10 Camera 

Setting
IP Address 設定範囲 IP Address選択

初期値
Port 設定範囲 1 ~ 65535

初期値 80

Edit IP Address 設定範囲 Execute

初期値
Scan IP Address 設定範囲 Execute

初期値
Edit User Name 設定範囲

初期値
Edit Password 設定範囲 ********

初期値
Name 設定範囲 カメラに登録された名前

初期値
Network Status

設定範囲
No IP Address, Now Checking…, Connected, Unauthorized,  
Not Connected

初期値 No IP Address

Red Tally 設定範囲 Disable, Enable

初期値 Enable

Green Tally 設定範囲 Disable, Enable

初期値 Enable

Yellow Tally 設定範囲 Disable, Enable

初期値 Enable
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下位階層 B
No. サブメニュー 設定項目 設定値

IP IN1,2 1 Streaming 
Mode

設定範囲 NDI|HX, SRT（以下選んだソース表示）
初期値 NDI|HX

IP IN3,4 1 Streaming 
Mode

設定範囲 NDI

初期値 NDI

NDI IN XX 2 Status 
Information

Format

表示のみ

Sampling Rate

Audio Channel

Frame Data

Codec

Streaming Mode

Status

3 Alpha Settings Use Alpha 設定範囲 Disable, Enable

初期値 Disable

Type
表示のみ

Alpha Signal

Key Source 
BKGD

設定範囲 White, Black

初期値 White

4 Machine Name
表示のみ

5 Source Name 

6 Scan Mode 設定範囲 HB/HX v2, HX v1

初期値 HB/HX v2

7 Scan 設定範囲 別メニュー移行（スキャン結果一覧）
初期値

8 Protocol 設定範囲 TCP, UDP

初期値 TCP

9 Group Group 設定範囲 Disable, Enable

初期値 Disable

Group Name 設定範囲 64文字まで設定可能
初期値

セッティングメニュー一覧



133

セッティングメニュー一覧

No. サブメニュー 設定項目 設定値
NDI IN XX 10 Use Discovery 

server
Use Discovery
server

設定範囲 Disable, Enable

初期値 Disable

Discovery
server IP

設定範囲 IP Address入力
初期値

11 RTSP Port 設定範囲 1 ~ 65535

初期値 554

Request URL 設定範囲 255文字まで設定可能
初期値 MediaInput/h264/stream_1

Connect 設定範囲 Execute

初期値
12 Name Type 設定範囲 Default, User

初期値 Default

13 Name 設定範囲 32文字まで設定可能
初期値

14 Camera 
Setting

Control 設定範囲 Panasonic, NDI

初期値 Panasonic

IP Address 設定範囲 IP Address選択
初期値

Port 設定範囲 1 ~ 65535

初期値 80

Edit IP Address 設定範囲 Execute

初期値
Scan IP Address 設定範囲 Execute

初期値
Edit User Name 設定範囲

初期値
Edit Password 設定範囲 ********

初期値
Name 設定範囲 カメラに登録された名前

初期値
Network Status

設定範囲
No IP Address, Now Checking…, Connected, Unauthorized,  
Not Connected

初期値 No IP Address

Red Tally 設定範囲 Disable, Enable

初期値 Enable

Green Tally 設定範囲 Disable, Enable

初期値 Enable

Yellow Tally 設定範囲 Disable, Enable

初期値 Enable
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No. サブメニュー 設定項目 設定値
SRT IN XX 2 Status 

Information
Format

表示のみ

映像フォーマット (1080/59.94pなど )
Sampling Rate

Audio Channel

Codec H.264/H.265

Status

3 Name Type 設定範囲 Default, User

初期値 Default

4 Name 設定範囲 32文字まで設定可能
初期値

5 Mode 設定範囲 Caller, Listener

初期値 Caller

6 Server URL 設定範囲 URLを入力。1 ~ 254文字
初期値

7 Server Port 設定範囲 0 ~ 65535

初期値 30000

セッティングメニュー一覧
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No. サブメニュー 設定項目 設定値
SRT IN XX 8 Stream ID 設定範囲 512文字まで設定可能

初期値
9 Port 設定範囲 1024 ~ 65535

初期値 2020

10 Encryption 設定範囲 Disable, Enable

初期値 Disable

11 Passphrase 設定範囲 10 ~ 79文字まで設定可能
初期値

12 Camera 
Setting

IP Address 設定範囲 IP Address選択
初期値

Port 設定範囲 1 ~ 65535

初期値 80

Edit IP Address 設定範囲 Execute

初期値
Scan IP Address 設定範囲 Execute

初期値
Edit User Name 設定範囲

初期値
Edit Password 設定範囲 ********

初期値
Name 設定範囲 カメラに登録された名前

初期値
Network Status

設定範囲
No IP Address, Now Checking…, Connected, Unauthorized,  
Not Connected

初期値 No IP Address

Red Tally 設定範囲 Disable, Enable

初期値 Enable

Green Tally 設定範囲 Disable, Enable

初期値 Enable

Yellow  Tally 設定範囲 Disable, Enable

初期値 Enable

上位階層
No. サブメニュー 設定項目 設定値

11 Output 1 OUT1(SDI 
OUT1)

表示のみ
次の階層のた
めのメニュー

下位階層 Aに移行

2 OUT2(SDI 
OUT2)

下位階層 Aに移行

3 OUT3(HDMI 
OUT)

下位階層 Bに移行

4 OUT4(IP 
OUT1)

下位階層 Cに移行

5 OUT5(IP 
OUT2)

下位階層 Cに移行

6 OUT6(UVC 
OUT)

下位階層 Dに移行

下位階層 A
No. サブメニュー 設定項目 設定値

SDI OUT XX 1 Assign 設定範囲 PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

初期値 PGM
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下位階層B
No. サブメニュー 設定項目 設定値

HDMI OUT 1 Assign 設定範囲 PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

初期値 MV

2 Size 設定範囲 Auto, XGA, WXGA, SXGA, WSXGA+, Native

初期値 Auto

3 Color 設定範囲 Auto, RGB, YUV444, YUV422

初期値 Auto

4 Scale 設定範囲 Fit-V, Fit-H, Full, Full90%, Full80%

初期値 Full

5 Move Detect 設定範囲 1 ~ 5

初期値 5

下位階層 C
No. サブメニュー 設定項目 設定値

IP OUT XX 1 Streaming 
Mode

設定範囲 NDI, SRT, RTMP（以下選んだソース表示）
初期値 NDI

2 Streaming Link 設定範囲 On, Off

初期値 Off

NDI OUT XX 3 Assign 設定範囲 PGM, PVW, CLN, AUX1, AUX2, MV, Key Out, Still1, Still2

初期値 PGM

4 Machine Name 設定範囲 20文字まで
初期値 AV-HSW10

5 Source Name 表示のみ 設定範囲 32文字まで
初期値 NDI Device xx

6 Protocol 設定範囲 TCP, UDP

初期値 TCP

7 Multicast Multicast 設定範囲 Disable, Enable

初期値 Disable

IP Address 設定範囲 IP Address入力
初期値 239.192.0.30

Subnet Mask 設定範囲 IP Address入力
初期値 255.0.0.0

TTL/HOP Limit 設定範囲 1 ~ 254

初期値 16

8 Group Group 設定範囲 Disable, Enable

初期値 Disable

Group Name 設定範囲 64文字まで設定可能
初期値

9 Use Discovery 
server

Use Discovery 
server

設定範囲 Disable, Enable

初期値 Disable

Discovery server 
IP

設定範囲 IP Address入力
初期値
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No. サブメニュー 設定項目 設定値
SRT OUT XX 3 Assign 設定範囲 PGM, PVW, CLN, AUX1, AUX2, MV, Key Out, Still1, Still2

初期値 PGM

4 Assign STDBY 設定範囲 PGM, PVW, CLN, AUX1, AUX2, MV, Key Out, Still1, Still2

初期値 PGM

5 Mode 設定範囲 Caller, Listener

初期値 Caller

6 Destination 
URL

設定範囲 URLを入力。1 ~ 254文字
初期値

7 Destination 
Port

設定範囲 0 ~ 65535

初期値 30000

8 Stream ID 設定範囲 512文字まで設定可能
初期値

9 Port 設定範囲 1024 ~ 65535

初期値 2020

10 TTL/HOP Limit 設定範囲 1 ~ 254

初期値 64

11 Latency(ms) 設定範囲 0 ~ 9999

初期値 20

12 Encryption 設定範囲 Disable, AES128, AES256

初期値 Disable

13 Passphrase 設定範囲 10 ~ 79文字まで設定可能
初期値

14 Codec 設定範囲 H.264, H.265

初期値 H.264

15 Rate Control 
Mode

設定範囲 CBR, VBR

初期値 CBR

16 Target bit rate 設定範囲 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

初期値 14Mbps

17 Max bit rate 設定範囲 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

初期値 14Mbps

セッティングメニュー一覧
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No. サブメニュー 設定項目 設定値
RTMP OUT XX 3 Assign 設定範囲 PGM, PVW, CLN, AUX1, AUX2, MV, Key Out, Still1, Still2

初期値 PGM

4 Assign STDBY 設定範囲 PGM, PVW, CLN, AUX1, AUX2, MV, Key Out, Still1, Still2

初期値 PGM

5 Server 設定範囲 1 ~ 3

初期値 1

6 Server URL 設定範囲 URLを入力。1 ~ 254文字
初期値

7 Stream Key 設定範囲 512文字まで設定可能
初期値

8 Timeout (sec) 設定範囲 1 ~ 30

初期値 10

9 Codec 設定範囲 H.264

初期値 H.264

10 Rate Control 
Mode

設定範囲 CBR, VBR

初期値 CBR

11 Target bit rate 設定範囲 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

初期値 14Mbps

12 Max bit rate 設定範囲 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

初期値 14Mbps

下位階層 D
No. サブメニュー 設定項目 設定値

UVC OUT 1 Assign 設定範囲 PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

初期値 PGM

2 Menu Out 設定範囲 Off, On

初期値 Off

3 Mode 設定範囲 Normal, 720p

初期値 Normal

セッティングメニュー一覧
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No. サブメニュー 設定項目 設定値
12 Config 1 Operate Menu Out 設定範囲 SDI OUT2, HDMI OUT, SDI2+HDMI

初期値 SDI2+HDMI

Menu Size 設定範囲 FULL, Upper-Left, Upper-Right, Lower-Right, Lower-Left

初期値 FULL

Menu Back 設定範囲 70%, 80%, 90%, 100%

初期値 100%

Bus Mode 設定範囲 A/B, PGM-A/PST-B, PGM-B/PST-A

初期値 PGM-A/PST-B

Time Unit 設定範囲 Sec, Frame

初期値 Sec

Delegation 設定範囲 On, Off

初期値 On

Fader 設定範囲 BKGD, KEY1, BKGD+KEY1, No Assign

初期値 BKGD

2 Key1/2 Link 設定範囲 Off, On

初期値 Off

3 CBAR Type 設定範囲 Type1, Type2, Type3

初期値 Type1

Move 設定範囲 Normal, Low, Off

初期値 Off

Test Tone 設定範囲 Normal, Low, Off

初期値 Off

4 Button 
Illumination

Button 
Illumination

設定範囲
Dimmer

Off, On

初期値 Off

設定範囲
Lighting

80%, 90%, 100%, 110%, 120%, 130%, 140%, 150%

初期値 150%

設定範囲 XPT 
Color

Input, Color Group1, Color Group2, Color Group3, 
Color Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

初期値 Input

Color Group IN
設定範囲

IN1(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
IN2(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
IN3(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
IN4(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
IN5(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
IN6(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1
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12 Config 4 Button 

Illumination
Color Group IN

設定範囲
IN7(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
IN8(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
IN9(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

Color Group 
Internal 設定範囲

Black

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
CBGD1

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
CBGD2

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
CBAR

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

Color Group Still
設定範囲

Still 1V

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
Still 1K

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
Still 2V

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
Still 2K

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

Color Group Other
設定範囲

CLN

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
Key Out

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲
STREAM

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1
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12 Config 4 Button 

Illumination
Color Group Other

設定範囲 AUX 
BUS 
DELEG

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

設定範囲 AUX 
SOURCE

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

初期値 Color Group1

Button Color 
Group1

設定範囲
R

0.0 ~ 1.5
G

0.0 ~ 1.5

初期値 0.1 0.1

設定範囲
B

0.0 ~ 1.5

初期値 0.1

Button Color 
Group2

設定範囲
R

0.0 ~ 1.5
G

0.0 ~ 1.5

初期値 0.1 0.1

設定範囲
B

0.0 ~ 1.5

初期値 0.0

Button Color 
Group3

設定範囲
R

0.0 ~ 1.5
G

0.0 ~ 1.5

初期値 0.0 0.1

設定範囲
B

0.0 ~ 1.5

初期値 0.1

Button Color 
Group4

設定範囲
R

0.0 ~ 1.5
G

0.0 ~ 1.5

初期値 0.0 0.1

設定範囲
B

0.0 ~ 1.5

初期値 0.0

Button Color 
Group5

設定範囲
R

0.0 ~ 1.5
G

0.0 ~ 1.5

初期値 0.1 0.0

設定範囲
B

0.0 ~ 1.5

初期値 0.1

Button Color 
Group6

設定範囲
R

0.0 ~ 1.5
G

0.0 ~ 1.5

初期値 0.1 0.0

設定範囲
B

0.0 ~ 1.5

初期値 0.0

Button Color 
Group7

設定範囲
R

0.0 ~ 1.5
G

0.0 ~ 1.5

初期値 0.0 0.0

設定範囲
B

0.0 ~ 1.5

初期値 0.1

Button Color 
Group8

設定範囲
R

0.0 ~ 1.5
G

0.0 ~ 1.5

初期値 0.0 0.0

設定範囲
B

0.0 ~ 1.5

初期値 0.0
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12 Config 5 User Button User 1

設定範囲
Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, Capture Still1, Capture 
Still2, None, Shot Memory1 ~ 12, XPT Disable

初期値 Key1 PVW

User 2
設定範囲

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, Capture Still1, Capture 
Still2, None, Shot Memory1 ~ 12, XPT Disable

初期値 Key2 PVW

User 3
設定範囲

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, Capture Still1, Capture 
Still2, None, Shot Memory1 ~ 12, XPT Disable

初期値 Shot Memory1

User 4
設定範囲

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, Capture Still1, Capture 
Still2, None, Shot Memory1 ~ 12, XPT Disable

初期値 Shot Memory2

User 5
設定範囲

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, Capture Still1, Capture 
Still2, None, Shot Memory1 ~ 12, XPT Disable

初期値 Shot Memory3

User 6
設定範囲

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, Capture Still1, Capture 
Still2, None, Shot Memory1 ~ 12, XPT Disable

初期値 Shot Memory4

6 AUX Name AUX1 Type 設定範囲 Default, User

初期値 Default

AUX1 Name 設定範囲 32文字まで設定可能
初期値

AUX2 Type 設定範囲 Default, User

初期値 Default

AUX2 Name 設定範囲 32文字まで設定可能

初期値
7 GPI GPI-In Setting 設定範囲 GPI-In 

Enable
On, Off

AUX Sel
AUX1, AUX2

初期値 On AUX1

GPI-In Port

設定範囲 Port1 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 ~ 12, RTly DSBL, GTly 
DSBL, YTly DSBL, AUX Tly DSBL

初期値 GTly DSBL

設定範囲 Port2 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 ~ 12, RTly DSBL, GTly 
DSBL, YTly DSBL, AUX Tly DSBL

初期値 BKGD AUTO

設定範囲 Port3 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 ~ 12, RTly DSBL, GTly 
DSBL, YTly DSBL, AUX Tly DSBL

初期値 BKGD CUT

設定範囲 Port4 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 ~ 12, RTly DSBL, GTly 
DSBL, YTly DSBL, AUX Tly DSBL

初期値 KEY1 ON
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12 Config 7 GPI GPI-In Port

設定範囲 Port5 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 ~ 12, RTly DSBL, GTly 
DSBL, YTly DSBL, AUX Tly DSBL

初期値 KEY2 ON

GPI-Out Setting 設定範囲 GPI-Out 
Enable

On, Off AUX Tly 
Sel

AUX1, AUX2

初期値 On AUX1

GPI-Out Port

設定範囲 Port 1 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly SDI 
IN1 ~ 4, RTly HDMI IN1, 2, RTly IP IN1 ~ 4, GTly SDI 
IN1 ~ 4, GTly HDMI IN1, 2, GTly IP IN1 ~ 4, YTly SDI 
IN1 ~ 4, YTly HDMI IN1, 2, YTly IP1 ~ 4, AUXTly SDI 
IN1 ~ 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 ~ 4

初期値 RTly SDI IN1

設定範囲 Port 2 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly SDI 
IN1 ~ 4, RTly HDMI IN1, 2, RTly IP IN1 ~ 4, GTly SDI 
IN1 ~ 4, GTly HDMI IN1, 2, GTly IP IN1 ~ 4, YTly SDI 
IN1 ~ 4, YTly HDMI IN1, 2, YTly IP1 ~ 4, AUXTly SDI 
IN1 ~ 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 ~ 4

初期値 RTly SDI IN2

設定範囲 Port 3 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly SDI 
IN1 ~ 4, RTly HDMI IN1, 2, RTly IP IN1 ~ 4, GTly SDI 
IN1 ~ 4, GTly HDMI IN1, 2, GTly IP IN1 ~ 4, YTly SDI 
IN1 ~ 4, YTly HDMI IN1, 2, YTly IP1 ~ 4, AUXTly SDI 
IN1 ~ 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 ~ 4

初期値 RTly SDI IN3

設定範囲 Port 4 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly SDI 
IN1 ~ 4, RTly HDMI IN1, 2, RTly IP IN1 ~ 4, GTly SDI 
IN1 ~ 4, GTly HDMI IN1, 2, GTly IP IN1 ~ 4, YTly SDI 
IN1 ~ 4, YTly HDMI IN1, 2, YTly IP1 ~ 4, AUXTly SDI 
IN1 ~ 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 ~ 4

初期値 RTly SDI IN4

設定範囲 Port 5 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly SDI 
IN1 ~ 4, RTly HDMI IN1, 2, RTly IP IN1 ~ 4, GTly SDI 
IN1 ~ 4, GTly HDMI IN1, 2, GTly IP IN1 ~ 4, YTly SDI 
IN1 ~ 4, YTly HDMI IN1, 2, YTly IP1 ~ 4, AUXTly SDI 
IN1 ~ 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 ~ 4

初期値 RTly HDMI IN2

設定範囲 Port 6 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly SDI 
IN1 ~ 4, RTly HDMI IN1, 2, RTly IP IN1 ~ 4, GTly SDI 
IN1 ~ 4, GTly HDMI IN1, 2, GTly IP IN1 ~ 4, YTly SDI 
IN1 ~ 4, YTly HDMI IN1, 2, YTly IP1 ~ 4, AUXTly SDI 
IN1 ~ 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 ~ 4

初期値 KEY1 ON

設定範囲 Port 7 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly SDI 
IN1 ~ 4, RTly HDMI IN1, 2, RTly IP IN1 ~ 4, GTly SDI 
IN1 ~ 4, GTly HDMI IN1, 2, GTly IP IN1 ~ 4, YTly SDI 
IN1 ~ 4, YTly HDMI IN1, 2, YTly IP1 ~ 4, AUXTly SDI 
IN1 ~ 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 ~ 4

初期値 No Assign
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12 Config 7 GPI GPI-Out Port

設定範囲 Port 8 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, RTly SDI 
IN1 ~ 4, RTly HDMI IN1, 2, RTly IP IN1 ~ 4, GTly SDI 
IN1 ~ 4, GTly HDMI IN1, 2, GTly IP IN1 ~ 4, YTly SDI 
IN1 ~ 4, YTly HDMI IN1, 2, YTly IP1 ~ 4, AUXTly SDI 
IN1 ~ 4, AUXTly HDMI IN1, 2, AUXTly IP IN1 ~ 4

初期値 No Assign

8 Key Source 
Signal 
Coupling

Fill/Source 設定範囲 Fill To Source, Source To Fill

初期値 Fill To Source

IN1(***)
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 IN1

IN2(***)
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 IN2

IN3(***)
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 IN3

IN4(***)
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 IN4

IN5(***)
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 IN5

IN6(***)
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 IN6

IN7(***)
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 IN7

IN8(***)
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 IN8

IN9(***)
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 IN9

Black
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 Black

CBGD 1
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 CBGD 1

CBGD 2
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 CBGD 2

CBAR
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 CBAR
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12 Config 8 Key Source 

Signal 
Coupling

Still 1V
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 Still 1V

Still 1K
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 Still 1K

Still 2V
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 Still 2V

Still 2K
設定範囲

IN1(***) ~ IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, Still 
1K, Still 2V, Still 2K

初期値 Still 2K

9 System Menu 
Lock

設定範囲 On, Off

初期値 Off

セッティングメニュー一覧



146

No. サブメニュー 設定項目 設定値
13 System 1 IP Mode 表示のみ

2 System Format
設定範囲

1080/59.94p, 50p, 59.94i, 50i, 29.97p, 25p, 24p, 23.98p, 
720/59.94p, 50p

初期値 1080/59.94p

3 Reference Reference Select 設定範囲 BB, Tri-level Sync, Internal

初期値 BB

Status 設定範囲
初期値

4 Output Phase System 設定範囲 0H, 1H

初期値 0H

H-Phase 設定範囲 – 0.50 ~ 0.49

初期値 0.00

V-Phase 設定範囲 –100 ~ 100

初期値 0

5 Switcher Title 設定範囲 1文字以上、32文字以内で設定可能
初期値 AV-HSW10

6 User Auth User Name 設定範囲 1文字以上、32文字以内で設定可能
初期値

Password 設定範囲 ********（1文字以上、32文字以内で設定可能）
初期値

EasyIP Setup 
Limit

設定範囲 20min, Unlimited

初期値 20min

7 Alarm Power 設定範囲 Alarm, No Alarm

初期値
Fan 設定範囲 Alarm, No Alarm

初期値
Temperature 設定範囲 Alarm, No Alarm

初期値
8 Tally Settings Tally Mode 設定範囲 Off, On

初期値 On

Tally Target

設定範囲 Red 
Tally

Off, PGM, CLN, Key 
Out, AUX1, AUX2, IP 
OUT1, IP OUT2※ Green 

Tally

Off, PGM, PVW, 
CLN, Key Out, AUX1, 
AUX2, IP OUT1, IP 
OUT2※

初期値 PGM PVW

設定範囲 Yellow 
Tally

Off, PGM, PVW, 
CLN, Key Out, AUX1, 
AUX2, IP OUT1, IP 
OUT2※

初期値 AUX1

※ IPモードがNormal 以外の場合、IP OUT2は非表示です。
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13 System 9 Date/Time Setting 設定範囲 Auto, Manual

初期値 Manual

NTP Server 
Address

設定範囲 アドレスを入力、1～128文字
初期値

NTP Port 設定範囲 0 ~ 65535

初期値 123

Adjust Interval 設定範囲 1h ~ 24h (1h単位 )
初期値 1h

Time Zone 設定範囲 (GMT-12:00) ~ (GMT+13:00)

初期値 (GMT)Greenwich Mean Time

Date Setting 設定範囲 yyyy / mm / dd

初期値
Time Setting 設定範囲 hh : mm : ss

初期値
10 Initial Initial Settings 設定範囲 Execute

初期値
Initial Fader 設定範囲 Execute

初期値
Factory Default 設定範囲 Execute

初期値
11 System 

Information
System Version 設定範囲 表示のみ

初期値
System Core1 
Version

設定範囲 表示のみ
初期値

System Core2 
Version

設定範囲 表示のみ
初期値

System Core 
Update

設定範囲 Execute

初期値
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14 Project 1 Project File Project 1 設定範囲

Protect
Off, On

Load
Execute

初期値 Off

設定範囲
Save

Execute
Delete

Execute

初期値
設定範囲

Name
32文字

Date
表示のみ

初期値

Project 2 設定範囲
Protect

Off, On
Load

Execute

初期値 Off

設定範囲
Save

Execute
Delete

Execute

初期値
設定範囲

Name
32文字

Date
表示のみ

初期値
Project 3 設定範囲

Protect
Off, On

Load
Execute

初期値 Off

設定範囲
Save

Execute
Delete

Execute

初期値
設定範囲

Name
32文字

Date
表示のみ

初期値
2 Last Load File 

Name
設定範囲 I: *****, U: *****, L: *****

初期値
3 Last Load Date 設定範囲 yyyy/mm/dd hh:mm

初期値
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No. サブメニュー 設定項目 設定値
15 Ancillary/Audio 1 Ancillary AUX 設定範囲 Off, On

初期値 On

PGM 設定範囲 Off, On

初期値 On

PVW 設定範囲 Off, On

初期値 On

CLN 設定範囲 Off, On

初期値 On

MV 設定範囲 Off, On

初期値 On

2 Audio Output 
Status

Assign OUT

表示のみ

OUT1(SDI OUT1)

OUT2(SDI OUT2)

OUT3(HDMI 
OUT)

OUT4(IP OUT1)

OUT5(IP OUT2)

OUT6(UVC)

Analog OUT

Output Bus Assign

AUX1

AUX2

PGM

PVW

CLN

MV

3 Audio Assign Input Assign 次の階層のた
めのメニュー

下位階層Aに移行
Output Bus Assign 下位階層Bに移行

4 Key1 Audio 設定範囲 Off, On

初期値 On

5 Key2 Audio 設定範囲 Off, On

初期値 On

6 Analog IN Audio 設定範囲 Off, On

初期値 Off

Input Type 設定範囲 LINE, MIC

初期値 LINE

Gain 設定範囲 –36dB, –33dB, –30dB, –27dB, –24dB, –21dB, –18dB, –15dB,
–12dB, –9dB, –6dB, –3dB, 0dB, 3dB, 6dB, 9dB, 12dB

初期値 0dB

Delay(ms) 設定範囲 0 ~ 512

初期値 0

7 Analog OUT Assign 設定範囲 PGM, PVW, AUX1, AUX2, CLN

初期値 PGM

Mute 設定範囲 Off, On

初期値 Off

Volume 設定範囲 本機前面部のモニター音量調整つまみの値が表示されます。
範囲は0 ～ 100 です。

初期値

セッティングメニュー一覧
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No. サブメニュー 設定項目 設定値
16 Network 1 LAN IP Address 設定範囲 0 ~ 255.255.255.255

初期値 192.168.0.8

Subnet Mask 設定範囲 0 ~ 255.255.255.255

初期値 255.255.255.0

Default Gateway 設定範囲 0 ~ 255.255.255.255

初期値 192.168.0.1

MAC Address 設定範囲 –

初期値 –

2 Primary DNS IP Address 設定範囲 0 ~ 255.255.255.255

初期値 –

3 Secondary 
DNS

IP Address 設定範囲 0 ~ 255.255.255.255

初期値 –

下位階層A
No. サブメニュー 設定項目 設定値

Input Assign 1 IN1(SDI1/
HDMI1)

設定範囲 SDI1/HDMI1, SDI IN2 ~ 4, HDMI IN2, IP IN1 ~ 4, Analog IN, Off

初期値 SDI1/HDMI1

2 IN2(SDI IN2) 設定範囲 SDI1/HDMI1, SDI IN2 ~ 4, HDMI IN2, IP IN1 ~ 4, Analog IN, Off

初期値 SDI IN2

3 IN3(SDI IN3) 設定範囲 SDI1/HDMI1, SDI IN2 ~ 4, HDMI IN2, IP IN1 ~ 4, Analog IN, Off

初期値 SDI IN3

4 IN4(SDI IN4) 設定範囲 SDI1/HDMI1, SDI IN2 ~ 4, HDMI IN2, IP IN1 ~ 4, Analog IN, Off

初期値 SDI IN4

5 IN5(HDMI IN2) 設定範囲 SDI1/HDMI1, SDI IN2 ~ 4, HDMI IN2, IP IN1 ~ 4, Analog IN, Off

初期値 HDMI IN2

6 IN6(IP IN1) 設定範囲 SDI1/HDMI1, SDI IN2 ~ 4, HDMI IN2, IP IN1 ~ 4, Analog IN, Off

初期値 IP IN1

7 IN7(IP IN2) 設定範囲 SDI1/HDMI1, SDI IN2 ~ 4, HDMI IN2, IP IN1 ~ 4, Analog IN, Off

初期値 IP IN2

8 IN8(IP IN3) 設定範囲 SDI1/HDMI1, SDI IN2 ~ 4, HDMI IN2, IP IN1 ~ 4, Analog IN, Off

初期値 IP IN3

9 IN9(IP IN4) 設定範囲 SDI1/HDMI1, SDI IN2 ~ 4, HDMI IN2, IP IN1 ~ 4, Analog IN, Off

初期値 IP IN4

下位階層 B
No. サブメニュー 設定項目 設定値

Output Bus Assign 1 AUX1 設定範囲 IN1 ~ 9, Analog IN, Follow Video, Off

初期値 Follow Video

2 AUX2 設定範囲 IN1 ~ 9, Analog IN, Follow Video, Off

初期値 Follow Video

3 PGM 設定範囲 IN1 ~ 9, Analog IN, Follow Video, Off

初期値 Follow Video

4 PVW 設定範囲 IN1 ~ 9, Analog IN, Follow Video, Off

初期値 Follow Video

5 CLN 設定範囲 IN1 ~ 9, Analog IN, Follow Video, Off

初期値 Follow Video

セッティングメニュー一覧
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No. サブメニュー 設定項目 設定値
17 External 

Interfaces
1 External Panel 

Information
Active

設定範囲
Disable, Enable

初期値 Disable

Port No 設定範囲 62000 ~ 65535

初期値 62010

2 External Panel 
IP

Shot Memory 
Recall

BKGD
設定範囲

Target 
Off, On

XPT
Off, On

初期値 Off Off

Key1
設定範囲

Target 
Off, On

XPT
Off, On

初期値 Off Off

Key2
設定範囲

Target 
Off, On

XPT
Off, On

初期値 Off Off

AUX1
設定範囲 Off, On

初期値 Off

AUX2
設定範囲 Off, On

初期値 Off

CBGD
設定範囲 Off, On

初期値 Off

XPT
設定範囲 Off, On

初期値 Off

3 External 
Control 
Switcher

Active 設定範囲 Disable, Enable

初期値 Disable

Port No 設定範囲 62000 ~ 65535

初期値 62000

Interval Time 設定範囲 0ms, 16ms, 32ms, 48ms, 64ms, 80ms

初期値 16ms

Response 設定範囲 On, Off

初期値 On

4 External 
Control AUX 
Panel

Port No 設定範囲 60000 ~ 65535

初期値 65000

IP Address1 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address2 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address3 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address4 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address5 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address6 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address7 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address8 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address9 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address10 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address11 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

セッティングメニュー一覧
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No. サブメニュー 設定項目 設定値
17 External 

Interfaces
4 External 

Control AUX 
Panel

IP Address12 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address13 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address14 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address15 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address16 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address17 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address18 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address19 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

IP Address20 設定範囲 0 ~ 255.255.255.255

初期値 0.0.0.0

18 USB Memory 1 Load Load Type 設定範囲 Still1, Still2, Project, Update

初期値 Still1

Load 設定範囲 Execute

初期値
2 Save Save Type 設定範囲 Still1, Still2, Project, Log

初期値 Project

Setup 設定範囲 On, Off

初期値 On

Shot 設定範囲 On, Off

初期値 On

Still 設定範囲 On, Off

初期値 Off

File Format 設定範囲 bmp, tga, png, jpg, tif, gif

初期値 png

Save 設定範囲 Execute

初期値
3 Free 設定範囲 空き容量 [KB/MB/GB]

初期値
4 Total 設定範囲 トータル容量 [KB/MB/GB]

初期値
5 Unmount 設定範囲 Execute

初期値
6 Format 設定範囲 Execute

初期値

セッティングメニュー一覧
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No. サブメニュー 設定項目 設定値
19 Color Adjust 1 Target 設定範囲 IN1(***) ~ IN5(***)

初期値 IN1(***)

2 Parameter No 設定範囲 1 ~ 10

初期値 1

3 Marker 設定範囲 Off, On

初期値 Off

4 Capture for 
Master

設定範囲 Execute

初期値
5 Adjust Target 設定範囲 Execute

初期値
6 Enable Color 

Adjust
設定範囲 Disable, Enable

初期値 Disable

7 Left 設定範囲 –50.00 ~ 50.00 (Left<Right)

初期値 –42.50

8 Top 設定範囲 –50.00 ~ 50.00 (Top>Bottom)

初期値 50.00

9 Bottom 設定範囲 –50.00 ~ 50.00 (Top>Bottom)

初期値 –50.00

10 Right 設定範囲 –50.00 ~ 50.00 (Left<Right)

初期値 42.50

11 Set Capture 
Points

設定範囲 Execute

初期値
12 Points Point 1 ~ 24 設定範囲

X-Position
–50.00 ~ 50.00

初期値
Left = –50.00, Top = 50.00, Bottom = –50.00, 
Right = 50.00で生成した値 (全画面用 )

設定範囲
Y-Position

–50.00 ~ 50.00

初期値
Left = –50.00, Top = 50.00, Bottom = –50.00, 
Right = 50.00で生成した値 (全画面用 )

13 Parameters Parameter 1 ~ 10 設定範囲
Master

IN1 ~ 5

初期値
設定範囲

Name
16文字以内で設定可能

初期値

セッティングメニュー一覧
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本書で使用している用語について説明します。

用　　語 解　　説

AB Bus
AB バス方式

バス制御モードの1つです。トランジションの実行により、Aバス、Bバスの信号が
交互にプログラム映像に出力されます。

Ancillary Data
アンシラリーデータ

映像シリアルインターフェースのデータストリームの内部で伝送される、映像信号以
外の補助データのことです。垂直ブランキング期間に重畳されるデータをVアンシラ
リーデータ（VANC）と呼びます。

Aspect
アスペクト比

画面の縦と横の比率のことです。
HDフォーマットは16：9、SDフォーマットは4：3です。

AUX [Auxiliary Bus]
オグジュアリバス

本線出力以外でスイッチング可能な予備バスのことです。

BB
ブラックバースト

BlackBurst（ブラックバースト）信号の略です。全画面黒レベルのコンポジット信号
のことで、Genlock（ゲンロック）用途の基準信号として利用されます。

Border
ボーダー

ワイプやキーの縁に付加する縁取りのことで、幅や色を調整することができます。ボ
ーダーの周りをぼかすことをソフト効果と呼びます。

Chroma Key
クロマキー

映像信号の色情報を基にキー信号を作成し、キー合成を行う機能のことです。

Clip
クリップ

キーソースからキー信号を作成するときの、輝度のしきい値のことです。

Color Background
カラーバックグラウンド

バックグラウンド画像として使用する、内蔵のカラージェネレーターから出力される
信号のことです。

Cut
カット

次の映像へ瞬時に切り替える効果のことです。

Density
デンシティ

キー信号の濃さを調整するパラメーターのことです。

Down Converter
ダウンコンバーター

4Kフォーマットの素材を、2K/HDフォーマットへ変換する機能のことです。

Embedded Audio
エンベデッドオーディオ

映像シリアルインターフェースのデータストリームの内部で伝送される、オーディオ
データパケットのことです。

Flip Flop
フリップフロップ方式
（PGM/PST 方式）

バス制御モードの1つです。プログラムバスで選択されている信号は常にプログラム
映像として出力されます。トランジションの実行により、プログラムバスとプリセッ
トバスの信号が入れ替わります。

Frame Synchronizer
フレームシンクロナイザー

非同期の映像信号入力の同期を合わせる機能のことです。

Freeze
フリーズ

映像信号を静止させる機能のことです。

FTB [Fade to Black]
フェードトゥブラック

バックグラウンド映像が黒画面へフェードアウトする効果のことです。

Genlock
ゲンロック

外部同期信号を基準に映像信号を同期させる機能のことです。

GPI
[General Purpose Interface]
ジー・ピー・アイ

外部からオートトランジションを制御するインターフェース信号のことです。

Hue
ヒュー

映像信号の色相（色合い）のことです。

Key Edge
キーエッジ

キーの縁に付加する縁取り（ボーダー）や影（シャドウ）のことです。

Key Fill
キーフィル

キー合成処理で、キー信号で抜いた部分を埋め合わせる信号のことです。

付　録【用語解説】



155

用　　語 解　　説

Key Gain
キーゲイン

キー信号の増幅度を調整するパラメーターのことです。

Key Invert
キーインバート

キー信号を反転させる機能のことです。

Key Mask
キーマスク

ボックスパターンなどでキー合成する領域を指定する機能のことです。
キー信号の一部の領域だけを使用する場合に、不要な領域をマスクして合成します。

Key Source
キーソース

キー信号を作成するための映像信号のことです。

Line Synchronizer
ラインシンクロナイザー

入力映像信号の位相を水平同期基準信号の位相に合わせて自動的に調整する機能です。

Linear Key
リニアキー

輪郭に階調を持っているモノクロのキー信号を基準にキー合成する機能のことです。

Lum [Luminance]
ルミナンス

映像信号の輝度（明るさ）のことです。

Luminance Key
ルミナンスキー

映像信号の輝度（明るさ）情報を基にキー信号を作成し、キー合成を行う機能のこと
です。

ME [Mix Effect]
ミックスエフェクト

いくつかの映像信号を合成し、ミックス、ワイプ、キーなどの映像信号を作り出す映
像効果装置のことです。

Mix
ミックス

次の画像とオーバーラップさせながら画面を切り替える効果のことです。
ディゾルブとも呼びます。

Multi View Display
マルチビューディスプレイ

複数の素材を合成して、1つの画面に表示する機能のことです。
PGM、PVWと入力素材を、1つの画面で同時にプレビューすることができます。

PinP [Picture in Picture]
ピクチャー・イン・ピクチャー

バックグラウンド映像に、子画面映像を合成する機能のことです。

PVW [Preview]
プレビュー

次のトランジションのあとに出力される映像を事前に確認するための機能です。PVW
系統より出力されます。

PGM [Program Bus]
プログラムバス

常にプログラム出力されるバスのことです。

PST [Preset Bus]
プリセットバス

次のバックグラウンドトランジションのあとにプログラム出力されるバスのことです。

Sat [Saturation]
サチュレーション

映像信号の彩度（色の濃さ）のことです。

SDI
[Serial Digital Interface]

SD、HDの各フォーマットの映像信号を1本の同軸ケーブルで伝送する規格のことで
す。

Self Key
セルフキー

キーフィル信号からキー信号を作成して、キー合成する機能のことです。

Setup Data
セットアップデータ

パネルの状態を保存し、呼び出すことができるメモリーのことです。
ボタンの選択状態やボーダー、色などの設定情報を保存します。

Tally
タリー

各入力信号のプログラム出力の状態を外部機器へ出力する信号のことです。
パネル上でプログラム出力の状態を示す LEDもタリーと呼びます。

Transition
トランジション

画像を切り替える機能のことです。切り替え時の効果は、ワイプ、ミックスなどがあ
ります。

Tri-level Sync
トライレベルシンク
（3 値シンク）

HDフォーマット用の同期信号のことです。

Trimming
トリミング

PinP で合成する映像の上下左右の不要な部分をカットする機能のことです。

Up Converter
アップコンバーター

2K/HDフォーマットの素材を、解像度の高い4Kフォーマットへ変換する機能のこ
とです。

付　録【用語解説】
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用　　語 解　　説

Video Memory
ビデオメモリー

キー信号付きの映像（静止画）を保持することができるメモリーのことです。

Wipe
ワイプ

特定のパターンに従って、現在の画面と次の画面の境界を移動させながら、画面を切
り替える効果のことです。

付　録【用語解説】
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A
ALARMランプ ............................................................ 15

Ancillary/Audio ..................................................... 149
Analog IN ............................................................. 149
Analog OUT ........................................................ 149
Ancillary ............................................................... 149
Audio Assign ..................................................... 149
Audio Output Status ....................................... 149
Key1 Audio ......................................................... 149
Key2 Audio ......................................................... 149

AUTOボタン ................................................................ 16

AUXバスクロスポイントボタン ................................ 17

AUXバス選択ボタン ................................................... 17

AUXバス専用クロスポイントボタン ........................ 17

C
CBGD ...........................................................  119、120
CBGD Main ......................................................... 119
CBGD Move ........................................................ 120
CBGD Select ..................................................... 119
CBGD Sub ........................................................... 119
CBGD Wash ....................................................... 119
CBGD Wave ........................................................ 120

ChromaKey ............................................................. 122
Cancel .................................................................. 122
Marker .................................................................. 122
Marker Aspect ................................................... 122
Marker Position ................................................. 122
Radius .................................................................. 122
Ref Adjust ........................................................... 122
Sample ................................................................. 122
Soft ....................................................................... 122
Y-Influence .......................................................... 122

Color Adjust ........................................................... 153
Adjust Target .................................................... 153
Bottom ................................................................. 153
Capture for Master .......................................... 153
Enable Color Adjust ......................................... 153
Left ........................................................................ 153
Marker .................................................................. 153
Parameter No .................................................... 153
Parameters ......................................................... 153
Points ................................................................... 153
Right ..................................................................... 153
Set Capture Points ......................................... 153
Target ................................................................... 153
Top ........................................................................ 153

Config ..................  139、140、141、142、143、.
144、145

AUX Name .......................................................... 142
Button Illumination ................  139、140、141
CBAR .................................................................... 139
GPI ...............................................  142、143、144
Key1/2 Link ....................................................... 139
Key Source Signal Coupling ............  144、145
Operate ................................................................ 139
User Button ....................................................... 142

CUTボタン ................................................................... 16

D
DC IN端子 .................................................................... 20

E
EXITボタン .................................................................. 16

External Interfaces ................................  151、152
External Control AUX Panel ............  151、152
External Control Switcher ............................. 151
External Panel Information ........................... 151
External Panel IP .............................................. 151

F
FTB ONボタン ............................................................ 16

H
HDMI IN端子 ............................................................... 18

HDMI OUT端子 .......................................................... 18

I
Input .......................................................................... 129
IN1(SDI1/HDMI1) ............................................ 129
IN2(SDI IN2) ...................................................... 129
IN3(SDI IN3) ...................................................... 129
IN4(SDI IN4) ...................................................... 129
IN5(HDMI IN2) ................................................... 129
IN6(IP IN1) .......................................................... 129
IN7(IP IN2) .......................................................... 129
IN8(IP IN3) .......................................................... 129
IN9(IP IN4) .......................................................... 129

K
Key ...............................................................  120、121
Edge ...................................................................... 120
Fill .......................................................................... 120
Fill Matte ............................................................. 120
Key Adjust .......................................................... 120
Key Priority ......................................................... 121
Key Select .......................................................... 120
Key Signal Coupling ........................................ 121
Key Type ............................................................. 120
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Mask ..................................................................... 121
PinP ....................................................................... 121
PVW ...................................................................... 120

L
LANケーブル ............................................................ 100

LAN端子 ....................................................................... 19

M
MENUボタン ............................................................... 16

MIX/WIPE切り替えボタン ........................................ 17

MultiView .......................................  126、127、128
Display ................................................................. 128
Green Tally ......................................................... 127
MV Character .................................................... 127
MV Frame ............................................................ 127
MV Label ............................................................. 127
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